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METERING, BILLING & COLLECTIONS SYSTEM IMPROVEMENT
REpORT

EXECUTIVE SUMMARY

ThIS report IS part ofDehvery Order 12, contract CCN-0002-Q-12-3152-03 It exammes the
system Improvements (mformatIOn technologIes) reqUIred to support Improved metermg, bIllmg
and collectIOn processes WIthm the Armeman electnclty and natural gas dlstnbutIOn sectors The
report descnbes the problems uncovered at the dlstnbutIOn companIes and a software/hardware
solutIOn deSIgned Jomtly by Hagler BaIlly and CMP InternatIOnal to support busmess process
redesIgn m the dlstnbutIOn sector The mam ObjectIve of the program IS to Improve revenue
collectIOns and revenue trackmg for electncity and natural gas The software program that has
been developed for thIS purpose IS called Abacus (whIch loosely stands for Automated Blllmg
and CollectIOns Utlhty System), It was created to help Improve collectIOns by mitIgatmg or
compensatmg for the weaknesses found m the dlstnbutIOn sector I

The Abacus system was tested on sIte at the Klevyan local office of the Komltas dlstnbutIOn
network, and at the Komltas central office Dunng the on-SIte testmg, procedural and other
dIscrepancIes were Identified and resolved Changes to the Abacus structure were also mitIated
as reqUIred by these newly dIscovered dIscrepancIes To help ensure Abacus' efficIency and
effectIveness, a techmcal expert m PowerBmlder (the software language used to create Abacus)
mspected the Abacus program and database (PowerBUIlder IS a fourth-generatIOn programmmg
language used to Implement Abacus) A copy of the technIcal review report IS attached ThiS
report WIll be of great use should the deCISIon be made to further replIcate Abacus at other
utlhtIes

It must be understood that mfrastructure Improvement IS essentIal to Improvmg collectIOns
WhIle good software can augment changes m structure and control and make a sIgmficant
contrIbutIOn to resolvmg the Issues, software cannot do the Job alone InformatIOn technologIes
are a cntlcal underpmnmg of the effort to Improve busmess processes but they are of course,
SImply a tool Such tools should not be overemphaSized at the expense of other reform efforts
(e g, management tralmng, accountmg reform, human resource development)

1 Of course, there are a number of weaknesses mcludmg lack of a management mformatlOn
system/management accountmg, finanCial accountmg and reportmg, finanCial plarmmg, and human resources
to name a few ThiS effort focused only on the metermg, billIng and collectIOns area

Hagler BaIlly ---------------
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METERING, BILLING, & COLLECTIONS SYSTEM IMPROVEMENT r1jI] 2

ThIS document 1) descnbes the bUSIness enVIronment as It relates to the Abacus system, 2) lIsts
problems IdentIfied dunng the analySIS, 3) descnbes features of the Abacus program that remedy
the IdentIfied problems, and, 4) recommends follow-up actIOns should Abacus be developed
further

I. INTRODUCTION

In accordance WIth DelIvery Order 12 of Contract CCN-0002-Q-12-3152-03, thIS report has been
prepared to descnbe the system Improvements reqUIred to support Improved metenng, blllmg
and collectIOns In the Armeman electnclty and natural gas dlstnbutIOn sectors

CollectIOns In Armema, SImIlar to other emergIng markets, are far below the levels reqUIred for
successful commerCIalIzatIOn ofthe energy sector ThIs collectIOn defiCIt IS the result of
numerous problems IncludIng the poor economIC state of the country, the lack of effectIve
dIsconnectIOn polICIes, Internal finanCIal control weaknesses and technologIcal factors (e g ,
metermg problems, exceSSIve techmcallosses)

ThIS report descnbes the weaknesses IdentIfied m the bUSIness processes WIthIn the RepublIc's
energy dlstnbutIOn sector that affect the abIlIty of the utIlItIes to properly handle meterIng,
bIllIng and collectIOns The ways In WhICh system Improvements (1 e , software and hardware
mformatIOn based technologIes) can support the redeSIgn of busIness processes and prOVIde the
tools necessary for a sustaIned Increase In the sector's finanCIal performance are also descnbed
In partIcular, thIs report presents the development of a software tool, known as Abacus, and how
It addresses the IdentIfied problems Abacus has been Implemented to support the pIlot projects
undertaken as part of the same DelIvery Order and has generally met WIth WIdespread user
acceptance A number of recommendatIOns are also prOVIded, IncludIng detaIled system changes
that should be made, If there IS a deSIre to further rephcate the program In the Armeman energy
sector

II. PROBLEMS IDENTIFIED REQUIRING SYSTEMIC IMPROVEMENT

EXamInatIOn of the dIstnbutIOn sector IdentIfied a number of overall problem areas, as shown
below, that adversely affected metenng, bIlhng and collectiOns

OperatIonal (day-to-day) categorIes

A number of operatIonal problems were IdentIfied These Include

Hagler BaIlly ---------------
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METERING, BILLING, & COLLECTIONS SYSTEM IMPROVEMENT 15i'l 3

Manual (hand entry) paper based bIlhng processes The usual errors and features that
accompany such manual processes were present throughout and compnse
1) accuracy and speed vary by accountant/clerk,
1) arIthmetIc errors,
1) data loss,
1) data hoardIng and unwIllIngness to share InfOrmatIOn,
1) InCOnsIstent apphcatIOn of tax and collectIOn polIcIes,
1) no backup,
1) no easy way to track or summarIze dally receIpts or amounts owed,
1) ongmal mformatIOn stored only In one locatIOn,
o sIgmficant tIme lag to answer bIllmg quenes

InabIhty to properly assess collectIOn performance It was difficult to track and venfy the
work bemg performed by local collectIOn agents and the proper comrmSSIons they
deserved ThIS process IS now discontmued However, a SImIlar SItuatIOn eXists WIth the
dlstnbutIOn companIes' meter readers It IS difficult to track the performance of specIfic
meter readers

Lack of controls ThIS mcluded such factors as
1) maccurate bIlhngs,
1) collUSIOn With the account holder,
1) faulty collectIOn procedures,
1) pOSSIble diversIOn of funds

Inadequate government pohcIes placed constramts on the dlstnbutIOn compames' abIhty
to effectIvely manage then workforce The best example of such a pohcy IS the
reqUirement (stIll In effect) that all meters be read on the last day of the month ThIs
reqUirement IS mtended to allow management to compare meter readmgs at dIfferent
dIstnbutIOn network levels and note dIscrepancIes exceedIng expected and normal hne
losses (m other words, to create an energy balance) The resultIng InordInately heavy
workload for that day leads to some meter readers falsIfymg some unknown number of
meter readmgs ThIS negates the ratIOnale behmd the smgle day meter readIng program
There are also much greater mdicatIOns of data entry errors as clerks rush to mput all of
the meter readmgs collected at month's end

Inadequate mformatIOn about the meters m place ThIS mcluded the lack of a meter
mventory to proVIde mformatIOn such as 1) when the meter was mstalled, 2) the date the
meter was last tested and cahbrated, 3) the age of the meter (thus perhaps mdicatmg
obsolescence) Not surpnsmgly gIVen the lack of such mformatIOn, there was no
comprehensIve meter testmg program m place

Hagler BaIlly ---------------
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METERING, BILLING, & COLLECTIONS SYSTEM IMPROVEMENT ~ 4

AdminIstrative (analysIs) category

The dependence on manual record keepIng resulted In the lack of easIly retnevable, hlstoncal
InfOrmatIOn for any gIven customer or subset of customers Data could not be Independently
verIfied, nor could management receIve timely, accurate and audltable reports and summarIes
pertaInIng to finanCIal performance There were no current or mstoflcal records avaIlable for
easy query by premIse, by account, by IndIvIdual, by payment hIstory, or by metered/billed
energy sales In a gIven area Consumer debt was not aged FInanCial InfOrmatIOn overall was not
eaSIly aVailable m electrOnIC form for analySIS or verIficatIOn purposes

Lack of adequate mformatIon technology mfrastructure

DUrIng the analySIS perIod, It also become ObVIOUS that the utIlIties lacked computer eqUIpment
and modem software to support the meterIng, bIllIng and collectIOn process The lImIted
eqUIpment that was avaIlable was generally obsolete Few staffhad adequate knowledge and
trainIng about computer hardware and software The dIstrIbutIOn utIlItIes were not captUrIng
easIly gamed effiCIencIes from adoptIOn of even the SImplest software programs

In lIght of all of these weaknesses, Hagler BaIlly and CMP InternatIOnal (the project team)
deCIded that there was a need to Introduce an InfOrmatIOn technology based solutIOn to help
support the redeSIgn of the metenng, bIllIng and collectIOn functIOn After dIscussIOn WIth
USAID, the declSlon was made to begm development of a software program that would be used
solely on a pIlot baSIS to support the electrICIty and natural gas dlstnbutIOn commerCialIzatIOn
pIlot projects

III. DEVELOPMENT OF ABACUS FOR BUSINESS PROCESS IMPROVEMENT

WIth the help and aSSIstance of ArmenIan counterparts In the varIOUS mmistnes and companIes,
the project team created a program known as Abacus (for Automated BIllIng and CollectIOn
UtIlIty System) The system deSIgn enables and faCIlItates the process ofbI1hng customers and
collectIOn ofpayments It also proVIdes proper reportIng to meet the reqUIrements of
management, accountIng, sales and technIcal departments of the dlstnbutIOn companIes, as well
as those of the MInIStry of Energy In addltlon, Abacus enables the dlstnbutIOn companIes to
maIntaIn current and histoncal mformatIOn about then dlstnbutIOn network (a meter database for
mstance)

Abacus supports the followmg overall metenng, bIllmg and collectIOn strategy

[1iil] Meter-readmg routes and cycles,

[Ijl] Separate procedures for meter readmg, bIllIng and payments,

Hagler Badly ---------------
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METERING, BILLING, & COLLECTIONS SYSTEM IMPROVEMENT ~ 5

I'1jl] Database on meters and meter cychng,

~ Debt agmg and development of dIsconnectIOn hst

Abacus also supports the analysIs of energy flow mformatIOn throughout the dIstnbutIOn
network through the use of a "tree" structure ThIs structure permIts trackmg of purchased
energy, the flow of energy WIthm the dIstrIbutIOn company, and the consumptIOn by end users
WIth thIS mformatIOn, the program can hIghlIght those areas where losses appear exceSSIve, thus
helpmg to pmpomt areas of the network that warrant closer mspectIOn and more aggressIve loss
reductIOn/revenue collectIOn efforts

It should be noted that thIS "tree" structure IS better SUIted for the electncity dIstrIbutIOn utIlIty
For natural gas utIlItIes, thIS structure WIll work at the low pressure network level (such as
encountered durmg the pIlot proJects), but due to the loopmg nature of a gas dIstnbutIOn
network, the tree structure IS not as effectIve at IdentIfymg areas of exceSSIve losses

Abacus stores varIOUS types of data

I'1jl] Customer mformatIOn DetaIled mformatIOn about each customer, mcludmg name,
address, phone number, account number, account openmg date, tarIff, metermg, bIllIng
and payments mformatIOn

AssocIatIve relatIOns between customers Tms mcludes the cases where
(I One customer IS responsIble for bIlls of other customers (consohdated

bIllmg), or,
(I A customer IS not responsIble for consumptIOn of ItS sub-customers who are

connected to the same supply lIne

MeterIng of common areas One bIll IS produced for each common area every month
Users are collectIvely responsIble for paymg the specIfied amount It IS possIble to define
the oblIgatIOn or commItment of customers to pay a certam portIOn of the collectIve bIll
(e g the oblIgatIOn of a water supply company to pay for a certam amount of power
consumed by a water pump)

Cycles/routes The system helps to mamtam mformation about meter readmg cycles and
bIllmg routes The cycle InformatIOn also IS used to produce monthly bIlls m a batch
mode Tills feature, wmch receIved great mterest from management, has not yet been
used due to the government polIcy that all meters are to be read on the last day of the
month

TransformatIOn and dIstrIbutIOn losses The system IS able to speCIfy fixed and vanable
losses that occur before or after the meter of each mdiVIdual customer and whether the
customer IS responsIble for payment of these losses

Hagler Bailly ---------------
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METERING, BILLING, & COLLECTIONS SYSTEM IMPROVEMENT I1il 6

Meter mformatlOn The system mamtams detailed mformatlOn about meters, mcludmg
type, senal number, multIplIer factor, maxImum length ofreadmg, mstallatlOn date, last
testmg date, replacement date, etc

Meter readmgs PenodIc meter readmg data are kept for each meter Normally, meter
readmgs are entered mto the system on a monthly baSIS, however, multIple readmgs
dunng a month are also pOSSIble For exceptlOnal cases, the system allows estImated
consumptlOn to be entered mstead of the actual meter readmg CorrectlOns and
adjustments can be made to the meter readmg data entered mto the system, however, all
such mstances are tracked m an unalterable audIt database

BIllmg The bIllIng process IS computenzed and all bIlls are produced based on the
metenng mformatIOn entered mto the system In addItIon, the system allows checkmg the
current balance of customers and prmtmg out statements that reflect past due debt, late
payment charge, power consumptlOn, recent payments and outstandmg balances

CollectIOns/payments InformatlOn about payments made WIth reference to the actual
payment documents are stored m the system

MultIple tarIffs The system WIll support multIple tarIff deSIgns and dISCOuntS mcludmg
tIme-of-use tarIffs, demand charges, and customer charges

Late payment charges Late payment charges are accrued on a monthly baSIS The system
supports grace penods durmg whIch customers have to make payments for the power
consumed by them dunng the prevlOUS month Late payment charges are not accrued
durmg the grace penod

Data collected by the branch offices IS entered mto Abacus and stored m the local databases
ThIS data IS uploaded mto the central database stored on the server located at the mam office thus
provIdmg management, accountmg and sales departments of the utIlItIes full access to the
collectlOn and energy use mformatlOn

Abacus can be used eIther "stand alone" on a smgle workstatlOn, or m a computer network
enVIronment consIstmg of a server computer located at the mam office of the dIstrIbutIon
company and workstatIOns located at the branch offices

Abacus does not reqUIre mteractIve updates and/or requests to the remotely stored databases The
amount of data to be exchanged between the central and branch offices IS not large and can be
transferred usmg dIal-Up networkmg connectlOns usmg remote access servIces supported by both
MIcrosoft Wmdows 95 and NT Server

Hagler BaIlly ---------------
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METERING, BILLING, & COLLECTIONS SYSTEM IMPROVEMENT ~ 7

A back-up process usmg dIskette or tape medIa has been developed to allow updatmg of the
central database when dIal-up connectIOns are not possIble

The program currently supports the Armeman, RUSSIan and EnglIsh languages A translatIOn
module was developed and mcluded to gIve the program the abIlIty to accommodate any
language and font

Abacus was developed m PowerBUIlder and uses Sybase SQL Anywhere Server as a scalable
"backend" database Most necessary reports are mcluded as context senSItIve optIOns but ad hoc
reportmg IS pOSSIble through PowerBUIlder's Infomaker or any SQL compatible tool and
MIcrosoft's ODBC dnvers

IV. SYSTEM IMPROVEMENTS TO ADDRESS THE IDENTIFIED PROBLEMS

Abacus has a number of features bUIlt m that are deSIgned to speCIfically address the problems
noted m sectIOn II of thIs report The program mcludes a number of features to strengthen
mternal controls, streamlme performance and Improve productIVIty, and prOVIde utIlIty
management WIth the mformatIOn needed to properly manage the metenng, bIllmg and
collectIOns process

[i1jI] Abacus permIts the mtroductIOn of bIllIng cycles and rotatmg meter readmg ThIs helps
to faCIlItate workforce rotatIOn for better mternal control (helps to reduce meter
reader/consumer collUSIOn) The model's abIlIty to pnnt out suggested routes and meter
readmg lIsts Improves meter reader effectIveness The meter cycle control abIlIty and
ImmedIate reportmg m Abacus Will allow loss preventIOn and control even when meters
are read on a cyclIc baSIS ThIS can enable optImal use of labor With a sIgmficant
Improvement m both accuracy and control

The model reduces the lIkehhood of data entry errors Batch based data entry IS cross
checked on entry thus makmg It eaSIer to trace problems The model also has the
capabIlIty to upload and download data dIrectly mto handheld meter readmg deVIces
These deVIces have been deployed m the Komitas network and Abacus IS bemg used to
support thIS effort 2

BIll productIOn IS automated The model calculates a bIll based on "raw" meter readIngs
WIth data automatIcally checked for reasonableness The bIll productIOn process IS much
faster and SImpler USIng the model, thus IncreaSIng productIVIty Further, there IS
conSIderable fleXIbIlIty m the kmd of mformatIOn that can be shown on the bIll (e g ,
consumer debt, pnor meter readmgs)

2 ThiS IS takmg place as part of the pilot project activities ofDehvery Order 15

Hagler Bailly ---------------
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METERING, BILLING, & COLLECTIONS SYSTEM IMPROVEMENT [iii) 8

The model's ablhty to qmckly process large databases perrmts accounts receIvables to be
tracked and penaltIes Imposed m an Impartial and conSIstent manner

The meter mformatlOn database IS able to track senals numbers for depreClatlOn
estimatIOn purposes and also to develop a meter testmg/cahbratIOn program The model
tracks meter "change outs" and mcludes a meter seal trackmg number to help IdentIfy If
the meter has been tampered With

The model's tree structure, as descnbed earher, IS one of the key features m that It helps
to IdentIfy sources of current loss and dIversIOn An addItIOnal benefit of the tree
structure that was unantIcIpated durmg model development IS that It assIsts WIth network
mappmg 3

The model has a number of features that mcrease ItS fleXlblhty It IS table dnven thus
makmg tax and rate changes straightforward, even WIth block rates and tIme-of-use
provlSlons It also mcludes a graprucal user mterface that proVIdes mstant vIsual
IdentificatIOn of key Issues usmg Icons and color codmg

Management performance IS Improved by the reportmg functIOns proVIded Management
reports mclude
() Summary/detailed receIvable and collectIOns performance by subdlvlSlon, by

feeder, by meter reader,
() Branch office performance comparIsons,
() TransactIOn audIts,
() Account rustones,
() Energy flow breakdown by orgaruzatIOn,
() Meter JunctIOns configuratlOn,
() Delmquency and dIsconnectIOn reports,
() Cycle totals report

CopIes of the management reports produced by Abacus are attached m Exillbit A 4

3 Durmg the ImplementatIOn ofAbacus at the Klevan branch of the Komitas network utIlIty, It became
apparent that utIlIty records dId not match actual system configuratIon Dunng the energy cnSIS, many network
reconfiguratlOns took place and record-keepmg dId not keep up WIth the changes bemg made Abacus proVIded
a way for the utIlIty to realIze where Its records needed updatmg due to large, unexplamed dIfferences between
master metered nodes and the end user consumptIOn
4 For more mformation about Abacus, see the User DocumentatlOn (September 1998) prepared by Taurus Ltd
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V RECOMMENDATIONS

Based on the project team's assessment, there are a number of recommendatIOns for further
refinement and Improvement of the Abacus model

1 Complete Further TechnIcal Improvements to Abacus

Abacus has successfully met the reqmrements needed for the pIlot project actIvIties undertaken
as part ofthls Dehvery Order Should, however, effort be made to rephcate Abacus further, there
are a number oftechmcal changes suggested that WIll Improve system performance ExhIbIt B IS
a report from an expert reVIewer of the model, the report provIdes suggested changes to the
source code to Improve the model's effiCIency Some screens and mtemal operatIOns of the
model can be modIfied to Improve efficIency, both of Abacus Itself and of the operators and
other personnel that use It Some of the algonthms used to morutor and track performance (e g ,
energy losses m a gIven area) can also be refined These changes, If Implemented, can be
expected to Improve both executIOn speed and throughput

It should be noted that these changes are deSIgned to permIt the model to be operate more
effiCIently, It does not change the functIOns that the model supports

2 Update Abacus as ReqUIred

As the user-base gams expenence and famiharity WIth Abacus, then comments and suggestIOns
could be mcorporated mto Abacus to ensure contmued Improvements m user effectiveness
PartIcular attentIOn should be paid to the mterface between Abacus and the user communIty The
software language used IS qUIte fleXIble and should be able to respond to user needs

3 Create a Stronger Lmk to the Accountmg Systems lD Use

As the dIstrIbutIOn companIes move towards automated accountmg and control functIOns,
Abacus can be modIfied to faCIlItate exchange of finanCIal and other mformatIOn dIrectly WIth an
accountmg package One partIcular compleXIty WIth adoptmg thIS recommendatIOn IS that there
IS no standardIzed accountmg package muse m the energy sector Tills may mean that Abacus
would have to have customIzed "hand shakes" for each partIcular utIhty

4 ModIfy the Model to Better Support Gas DIstrIbutIOn Compames

Abacus' baSIC structure IS suffiCIent whether It IS used m an electnc or natural gas utilIty Smce It
IS table drIven, It can prepare accurate bIlls as long as It has access to the rate structure and
accurate metenng mformatIOn However, as currently configured, certam data VIews and
presentatIons, such as the "tree" structure, are better SUIted for an electnc utIlIty As gas
commerclahzatlOn efforts continue, it is warranted to conslder development of a gas-speCIfic

Hagler Bailly ---------------
C IWINDOWSITEMPISYSREP DOC



I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

METERING, BILLING, & COLLECTIONS SYSTEM IMPROVEMENT [1ii'] 10

model that would take mto account features of the gas mdustry, such as the "loopmg" nature of
the network as referred to earher

VI CONCLUSION

Armema's electnclty and natural gas dlstnbutIOn utlhtles are m a poor condItIOn wIth regards to
the adoptIOn and uptake of mformatIon technologIes Although such technologIes should never
be seen as a solutIOn on theIr own, they are certamly an Important part of the utilIty
commerCialIzatIOn process Based on an analysIs of the problems seen m the sector, the project
team IdentIfied the need for a software package that would permIt other commerCialIzatIOn
recommendatIons focusmg on metenng, bIllmg and collectIOns to be Implemented In addItIOn to
Armema, the model has also been demonstrated mother settmgs, mcludmg RussIa and Ukrame,
and the reactIOn has been qUIte pOSItive WIthIn Armema, the software has receIved Widespread
user acceptance m the pIlot project areas and based on the results seen to date, ItS further
ImplementatIOn should be senously consIdered

Hagler Bailly ---------------
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Hagler Badly Abacus EnhancementIMlgratlon Plan

'-- Abacus Application Development Vision

The application needs to provide effiCient and reliable performance In multiple languages The
application needs to support both dlstnbuted and centralized multi-user database models I further believe that It
IS deSirable that this application be able to support multiple database engines The support of multiple database
engines will enhance the scalability and portability of the application

Executive Summary

In my OpiniOn, the current state of the application will not support direct movement toward of the above
VISion Several Initial steps are required to create stable and reliable application capable of being migrated Into
the above VISion The are Significant deSign and coding Issues that must be addressed Involve creating a
complete consistent set of application objects and haVing those objects Interface with their database In a fashion
that protects the data The database also requires enhancements so that It can assure that application requests
do not Violate data antegnty requirements After these basiC Items are addressed, there are some suggested
enhancements to migrate thiS application to support the stated VISion Once a stable application IS created,
additional enhancement suggestions should be conSidered In support of the stated VISion and beyond
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Hagler Bailly Abacus EnhancementIMlgratJon Plan

The Database Model

The Application Source (PowerBuilder libraries - PBls)

-
The ABACUS database

Two data models have been prepared Abacus pdm and AbacusN pdrn are the two database model flies
As these fdes are manipulated by the Sybase PowerDeslgner application, I do not expect that you will be able to
process them Therefore, I Will enclose both black and white and color copies In the presentation booklets I Will
also Include two additional copies (b&w and color) separately to allow them to be assembled as wall posters The
first IS the onglnal database as received (see AppendIX A) The second contains information resulting from the
limited investigation of the application (see Appendix B)

Page 4 of 15

Meaning

LocatlonlLevel tables - the suggested change IS shown on the second diagram
Cycle/Route tables - the suggested change IS shown on the second diagram
Tables With data problems preventing establishment of foreign key relationships
Unused tables

Table Color

Green
Yellow
Red
Gray

The abacus db file returned reflects the to be model diagram Note that the application code was not
moddled to reflect the elimination of the cycle_route table or level1 -levelS tables There were a couple of
Indices added for the customer and Junction table's pnmary keys The location table has a complete set of IndIces
and keys assigned VieWing the location table In PowerBullder's database painter Will present a cleariy different
picture that the onglnal tables Notice the indiCes appeanng on the left -one key Indicates a unique key Index ­
two keys indicate a duplicate key Index

The application source has been rearranged Into reasonable sized PBLs (see AppendIX C) PBLs
abaerror, abamess and abaxlate are temporary holding areas for functions to be placed Into other objects
Please note the comment fields for the objects a[mhentja shows the parent of the object Object names appeanng
outside the brackets are where the object IS used The suggested library list for the application can be found In
the main project object In the abacus pbl

There IS a folder of unused objects arranged In pbl(s) named nused_ where _ matches the
abacus_ pblln which they were received (see AppendIX D)
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Hagler Badly Abacus EnhancementIMlgratlon Plan

Step 6 - Reduce memory usage and Increase performance

Step 2 - Exchange memory resources for Improved performance

Step 1 - create a complete and consIstent copy of the applIcatIon source code

Step 4 - ModIfy the database to Insure data IntegTlty and Improve performance

Page 5 of 15

Convert global functions to object functions to elimInate dynamiC loading and the associated performance
delays

Any data WIndow (especially reports) can save memory and database engIne processing by replaCIng
JOIns for decode operatJons WIth dropdowndatawlndows (dddw) In deSIrable cases, the number of entnes
In the dddw IS far less that the number of rows returned and the code IS shorter that the decode value ­
net result a memory saving Plus, network utilIzation savings WIth multi-user databases because fewer

The database tables need to have pnmary keys, foreIgn keys and addItional unique keys defined correctly
and completely In additIon, table IndIces must be present to support the venflcatlon of the key
relatIonships In an effICient fashion Table Indices also can Improve performance of the apphcatJon by
ehmlnatJng table scans - uSing the IndIces to access only the requIred rows

There are missIng objects In the current application
There are reportIng references to tables that are never updated
There are references to columns that no longer eXist In the tables

All of the above Items should be resolved before building upon the 8XlstJng application

Most tables WIll requIre a concurrency checking mechanism to prevent updates of stale data Many of the
updates In the current applicatIon only check the key before updatJng a row The most secure
approaches use a tJmestamp or update counter to assure there has been no intervening update of the
row An alternate approach IS to Include the onglnal column's data values In the update Sal statement.
A strategy needs to be chosen and Implemented on the appropnate tables

Summary Application Enhancement I Migration Plan

Step 3 - ModIfy the eXIstIng applIcatIon to Insure the tImely commItment of transactIons

Step 5 - EstablIsh a secure multI-user envIronment

08/27/98 2.20 PM

___________ A database transactIon COl"IslSts of aset of one 01' more SOL statements-that must either be applied or
'- backed out as a set Every set of updates should be bracketed with a MBEGIN TRANSACTION- and

either a MROLLBACK" or MCOMMJr based on the success of the operation
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Hagler Bailly Abacus EnhancementIMlgratlon Plan

Step 1-MessageBox function

Step 7- CreatIon ofapplIcatIons In vaTlous languages

characters of data are transferred Plus, execution savings from the lesser number of JOinS processed In

the database engine

The Improved PowerBulider Translation Toolkrt that ships With version 6 5 automates the process of
substltutmg altemate language text, font and wldtMocatlon changes Into a base application (developed In
English) creating subsequent appllcatlon(s) where the new language (such as Armenian or Russian) IS
the "native language- ThiS development removes execution time changes that slow processing In the
current application It will also eliminate most of the paraJlel maintenance Issues The portion It will not
eliminate IS the translation, font and wldtMocatlon changes of new Items

Page 6 of 15

Windows Will not display messageboxes dunng mouse capture events Should a messagebox command
be coded dunng a mouse capture event, the default value IS retumed to the messagebox calling scnpL
Generally, messageboxes are used to Inform or receive critical InformatIon for the application I
recommend replacement of messagebox calls with an application response Window that will not be
suppressed by Windows

A custom response Window aJso proVIdes the opportunity to add a pnnt key to record errors for
transmiSSion to a help desk or developer Note also that the newer versions (I believe starting wrth 4) of
PowerBullder can pnnt the screen Image or the graphiC version of a Window By maktng the response
Window temporanly InVIsible dunng the pnnt process the current screen Image can also be pnnted wrth
the error message - unfortunately on separate pieces of paper

The toolkit provides the followmg functions
Supports extraction of the eXlstmg text from the application
Provides for translation by erther the developer

or a non-developer uSing a provided translation application
Applies the translated text to the application creating new source code for the target language
AsSISts In determining font and wldtMocatlon changes for fields
Stores the text, font and wldtMocatlon changes to apply to future moddled versions

Although Armenian does not eXist In the Toolkit, the Toolkit does support addition of new languages
The toolkit also supports nght to left languages like Hebrew and ArabiC with the appropnate versions of
Windows 95 Keep In mind that Powerbullder also has dlstnbutlon kits In vanous languages (I do not
believe that either Armenian or RUSSian IS Included)

Note Jattempted to port the code from Abacua Into- a beta version of PowerBullder 6 5 The port
generated 7 wamlngs that Instance vanables typed from Window structures would default to pnvate In the
next version Jrecompiled after expllcrtly scopmg the affected Instance vanables pnvate without error
ThiS IS NOT an assurance that the application will run successfully However, It did port to the new
version without problem
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add bmplsplash bmp to abacus pbr file

Csetwlndowtext - move to w_calendar - only place used (or Message/global object?)

Step 2 - Exchange memory resources for Improved performance

Step 1 - create a complete and consIstent copy of the applicatIon source code

Page 7 of 15

Possible missing objects
w_reporCdellnquency_dlsconnect needs d-9J-.chJld_ld
w_reporUocgroup needs d..,Junctlon_debCreporCdetad
w_rates may need d_vat
w_act and w_meteccorr

d..,Junctlon_head_e seems to correspond to d..,Junctlon_head_{Jang}
d_bdLn_baLca_sc_e seems to correspond to d_ bdLn_baLca_sc _{lang}
d_ bJlLn_baLe seems to correspond to d_ bJlLn_baL{Jang}

FIX datawlOdows that speedy non-exlstent columns (partial list)
(These can be found by opening the datawlndowand dOing -Edrt Data Source-, If the

SOL can not be displayed In graphiCS mode there IS a missing column or table)

d_meter references meter seal
d_dddw_route references route route_ld
d_dddw_cycle references cycle cycle_ld
d_or9-Path references or9-Qroup repl, oruroup usecname and or9-Qroup extract

Identify and remove unused code attached to the application
(I found these by searching the application's objects with the table names)
w--genapp_sheet, m-genapp_sheet referenced by w-genapp_frame wCnewsheet

- The only call to wCnewsheet () IS commented
w_act_by_lIst and d_act_by_lIst reference the temp_act table

there are no Inserts for the table and no data In the table
~conn_dlsconn_lIst probably accesses an unused table

customectype
- d_ds..,Jcc uses a ddlb Instead of the d_dddw_cusCtype
- d_ds_ca_respcust also uses a ddlb Instead of d_dddw_cusCtype

NOTE Also that the application contains a large amount of commented code Although thiS IS not a
performance Issue at execution time, I would consider deleting such code when the application IS
considered stable

Cdwrtemmodlfled - review function and premise and respond accordingly poSSibly add to
uo_dwstandard (datawlndow user object) and uo_dsstandard (datastore user object)

CreslZ8_em2dw - move Into w_rates • only place used

CreslZe_sle2dw - move to w_locatJon - only place used

Csetmenutext - move to w-poss_conn - only place used (or Message/global object?)

Detailed Application Enhancement I Migration plan
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Hagler Bailly Abacus EnhancementIMlgratlon Plan

Create an extension of the PowerBulider transaction object containing publtc object stub functions to
replace the global functions In abanew10 pbl The actual function code should be placed In a non-Visual
object that IS created by the extended transaction object

Provide a global function stub for access (or leave as global functions) unless they can be removed from
all datawlndows

CcounCsubcust
Cnull

Page 8 of 15

d_ds..,parencorgs
d_contract_temp
d_ds-lunctlon_orgs
d_ds...Junctlon_chlld

Extend the PB Transaction object Implementing the follOWing as PUBLIC functions
(create stub functions that call the functions In an associated non-vIsual object
The non-vIsual Will be the dypamlc rtem that changes to support different
database engines)

Cchecksqlca
Ccheck..,parents
Ccontract
f..Junct_org
Uoad_slde_kwh

Create an extension of the PowerBullder Error object containing publtc object functions to replace the
global functions In abaerror pbl Place the created object Into the abacus pbl

Extend the PB Error object Implementing the follOWing as PUBLIC functions
Cmess
mb
Ccheck

Create an extensloR-Gf the PowerBullder Message object containing publtc object functions to replace the
global functions In abamess pbl Place the created object Into theabacus pbl

Extend the PB Message object Implementing the follOWing as PUBLIC functions
Us_wln_actlve_sheet
Cmaxdate
Cmlndate
CcenteCWlndow (here or In response Window ancestor)
Cdays_fractlon
Cdeparse
CglobaLreplace
Cdmy2date
f..gecschdi
CgetaetJvesheet (reView function - possible problem assumes number of parents

to traverse to find frame)
Cm8XImlZ8 (review function - possible problem assumes parent of Window IS the

frame)
Copen_help
CreslZ8_sheet2max (- move to w_tree and w_locatlon Instead? )

Temporanly add the abaxlate functions to the message object created above As part of converting to the
Translation Toolkit, these functions will be removed

Cnewdwtransl
Udatemenu
PROTECTEDIPRIVATE (as deSired)

Cxlatetab
Cxlatewlndow
UeJatetabpage
f.;datewobj
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Step 4 - ModIfy the database to Insure data integrIty and Improve performance

Step.3 - ModIfy the exIsting applIcatIon to Insure the tImely commItment of transactions

The database tables need to have pnmary keys, foreign keys and additional umque keys defined correctly
and completely In addition, table Indices must be present to support the venflcatlon of the key
relationships In an effiCient fashion Table indices also_can Improve performance of the apphcatlon by
eliminating table scans - uSing the Indices to access only the reqUired rows

Non-Pnmary umque keys must be established as Indices to prOVide complete data Integrtty checking
Application code can not securely check for duplication and add a row because there IS an Intervemng
time delay The database engine will check dunng the Insert/update operation assunng complete
secunty

Page 9 of 15

A database transaction consIsts of a set of one or more Sal statements that must either be applied or
backed out as a set Every set of updates should be bracketed with a "BEGIN TRANSACTION· and
erther a "ROLLBACK" or "COMMIT" based on the success of the operation These Sal commands
should be Implemented as PowerBullder functions In the non-Visual object associated With the extended
transaction object and as stub functions In the extended transaction object

A qUick Investigation of objects With update commands indicates only 14 Windows have commit
commands to save database changes In scanning a dozen or so objects that Issue an update The
application object and seven Windows have update commands wrthout commits Two global functions
that Issue updates were also found that need to be traced Into each object where they are used to assure
a tl'8lllng commit to save their changes

UoglcaUype (new ds)
CsubcusU<wh d_ds_subcust
CcounCsubcust (new ds)
Caging d_ds_focaging
Cdw_valldatlon d_dw_valldatlon
CseCnew_ld
CgeUasUd
CgeUoc_ld
Crelatlvedate ( check Intent code may eXit early If looking for a valid

calendar date less than or equal to a number of
days - the first missing calendar date Will cause
the exit - should the last found calendar date be
returned?)

Crun_sqUong

Should your developer's have problems with thiS section I should be able to alter a copy of the code to
do thiS In about a week Time estimate upwards of between 40 -80 hours Testing will reqUire additional
time - preferably returned to the normal developers

There are no RollBack commands In the application and the application does not specify
CommrtOnOlsconnect='No' Therefore I believe that the application IS committing changes on
disconnect Since there is no RollBack In the application - partial changes are being committed
when database errors occur Adding the CommrtOnOlsconnect='No' to the OBParm ConnectStnng will
NOT proVide an Immediate solution to the problem - because some Windows do not commit their
changes and they would be lost on disconnect If the change IS made Use of RollBack In support of
logical units of work would permit the application to recover from some database errors without having to
Immedl8tely halt the application
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Hagler Bailly Abacus EnhancementIMlgratlon Plan

The column level and descr should compnse a unique key to assure each descr IS unique by
level

- a couple of delete commands and no other references
- no data - thiS table appears to be unused

- no references - thiS table appears to be unused

- customeud and accounCno both appear to be umque keys

Page 10 of 15

- Insert commented - two report data Windows and two rows of data
- thiS table appears to be unused

- no references - thIS table appears to be unused

cusCmsg

msg

customer

Inserts are then a Single operation

updates of parent location levels must be propagated to children In either example

The column level should be a duplicate key for accessing descnptlons for drop down
datawlndows

Updates for the set of tables or Single table should be restncted to a Single user at a time
Replication between multiple users on different databases would be difficult If not Impossible - In
either case

Although not simple to perform, application testing of key relationships with Imbedded Sal can be
removed from the application Testing of the error codes from the database and analYSis of the retumed
message can proVide information as to key problems Use of dropdowndatawlndows can also proVide
advance validation without embedded Sal

cycle_route
- the cycle_route table supports many-to-many relationships

- except that the pnmary key IS rO_ld and not both columns Assuming the pnmary key to
thiS table to be valid It appears that cY_ld should be added to the route table as a foreign
key to the cycle table Making the cycle_route table unnecessary

- dave pbl contains a pipeline that convert the data and one to rename the table

POSSible consolidation of tables level1 - levelS & location
- dave pbl contains three pipelines that convert the data and one to rename the table
- these tables require three operations to add a new row

Insert Into location
Insert Into the appropnate level
update of location with the proper level value

- these tables can be redeSigned Into a Single table
locatlon_ld Integer
level sma/lint ( 1 - S) (really 1, 2 or 4 )
descr varchar(20)
levelCld Integer (fk to locatlon_ld)
level2_ld Integer nullable (fk to locatlon_ld)
level3_ld Integer nunable (fk to locatlon_ld) (not used)
level4_ld Integer nunable (fk to locatlon_ld)
levelS_ld Integer nunable (fk to locatlon_ld) (not used)

reports
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Step 7 - CreatIon ofapplIcatIons In vaTlous languages

Step 6 - Reduce memory usage and Increase performance

Step 5 - EstablIsh a secure multI-user envIronment

Page 11 of 15

A great amount of effort has been expended to create Jl multi-lingual application PB has a translation
toolkit BaslC8lly, It uses the follOWing process to create a multi-language application,

First a Single language has ItS text stnngs extracted for translation
stnngs not requJnng translations like fonnulas and Sal can be eliminated
from conSideration manually by the developer

Second the deSired list of stnngs can be sent to another party for translation

temp_conn_dlsconn - no references this· table appears to be unused

temp_focbalance - no references - thiS table appears to be unused

temp_resp_customer • no references· this table appears to be unused

Additional memory savings can be achieved when shared decode data (possibly Implemented as public
datastores In the extended transaction object) IS used for static or near-static decode dddw(s) Refresh of
non-static codes IS an Issue In thiS technique ThiS shared object can occur at vanous levels Application
level objects would need to be the most static or refreshed consistently Window level objects can be
less statiC - the less statiC Items would be refreshed more often probably on Window retrieve commands

Personally, I prefer the secunty of timestamps or update counters These Items are generally updated via
a tngger An audit trail useud can also be updated In the tngger - useful only If users have unique Ids
The tngger answer does hmlt the target database chOice to ones haVing tnggers This IS not extremely
Significant as most database engines support tnggers NOTE Tngger code does differ between
database engines A tool hke ErWin for PowerBullder or PowerDeslgner from Sybase can assist with
tngger and table generation for different database engines

Any data Window (especially reports) can save memory and database engine processing by replaCing
JOins for decode operations With dropdowndatawlndows In deSirable cases, the number of entnes In the
dddw IS far less that the number of rows returned and the code IS shorter that the decode value - net
result a memory saving Note on report the arrow IS suppressed and the tab order IS set to zero to
prevent actually uSing the drop down feature

temp_Mcons
- d_dddw_tvIean IS dddw for Junction_type Mcon
- Junction_type tvlcon IS JOined to Itself In the d...Junct_type Sal syntax
• no rows In temp_Mcons - datatype does not match for foreign key between

JuncCtype Mean and temp_tvlcons bmp_fllename
- need to review thiS relationship

Most tables Will require a concurrency checking mechamsm to prevent updates of stale data Many of the
updates In the current application only check the key before updating a row The most secure

• approaches use a timestamp or update counter to assure there has been no Intervemng update of the
row An alternate approach IS to Include the anginal column's data values In the Sal statement WHERE
clause A strategy needs to be chosen and Implemented on the appropnate tables
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Third the programmer applies the translated text to a copy of the onglnal appltcatlon
the resulting application IS adjusted for field width and fonts manually
attnbutes (Width and font of the adjusted applicatIon are then stored for future
conversions of the modified application) As these attnbutes are saved and
reapplied to the base application after maintenance Parallel maintenance of
objects can be eliminated when they are not modified Modified objects In each
version of the application will be required to pass through the translation
processing However, text translations Will be maintained and can be reused
from the dictionary Fonts and WIdths may requIre setting at the appropnate
time

Step? - MessageBox function

The advantage of thiS process IS as follows
1) There IS no execution time modification of the application slOWing It down

4) extraction of the eXisting translations from the code and supporting flies Into the
translation toolkit database for creation of appltcatlons solely dedicated to a
specifIC language

Windows Will not display messageboxes dunng mouse capture events Should a messagebox command
be coded dunng a mouse capture event, the default value IS retumed to the messagebox calltng scnpt
Generally, messageboxes are used to Inform or receive cntlcallnformatlon for the appltcatlon I

Page 12 of 15

2) The application IS not bloated with dupltcate Items (like Windows and datawlndows)
where the language, font and Items Widths vary Making the search list for objects
shorter and loading Objects faster (These dupltcate objects require parallel
maintenance another potential source of error)

3) Each language's application appears to have been wrrtten specifically for the target
language The performance should be about the same for all target languages

Disadvantages of the translation toolkit approach
The language text and datatype fonts are both set In the translation process HaVing the

text In one languagelfont and the data In another would be difficult The current
application does not appear to support thiS Except that the Engltsh version of the
application may default to a RUSSian font (uo_dwstandard constructor) ­
assuming thiS IS the way the base application IS defined - Instead of MS San Senf
Or that the EngllshlRusslan combination IS not required translation toolkit should
easily work for a multt-llngual appltcatlon

Items to conSider to migrate to uSing the translation toolkit.
1) the translation toolkit does not translate data When the data must be multl-Itngual, the

database will require columns anellor tables deSigned to allow the entry of data In
each deSired language

2) external files - such as message files are not translated by the toolkit When the files
contain a reasonably small amount of text The text for the base language can be
moved Into the appltcatlon (Ie In thiS case the messages for engltsh can be
placed In the extension of the PB Error object as read-only text Items) The
translation toolkit can then be used to change them

3) Removal of the eXisting multi-lingual support code Including the translatIon object functions
noted above

08127/98 2.20 PM
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recommend replacement of messagebox calls with an application response window that will not be
suppressed by Windows

Step ? - PowerBullder Extended Attributes In the database

NOTE The following diScussion concerns manipulations of PowerBullder system tables I strongly
suggest expenmentatlon on a backUp copy of the database before applying changes to a live database

The pbcattbl pbd_ffce column contains the font name for the display of the data that IS used In the
PowerBuJlder Database Painter The same font IS used dunng datawlndow creation Changing this font
name to the appropnate font for the language stored In the database will allow the data to display In the
development tool correctly

Should the ad hoc query toollnfoMaker be considered for dlstnbutlon wrth the application, there are two
additional columns In pbcattbl that affect the header (pbh_ffce) and label (pbLffce) font display The
remaining pbcat tables such as pbcatcol have text Items that are used dunng datawlndow creation If
the text rtems In these fields match those used In the actual application The translation table database
may be able to be used In conjunction With these tables to "translate" the attnbute text by wntlng SOL

- processing scnpts

I
I
I
I
I
I
I
I
I
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I
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I
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Hagler Bailly Abacus EnhancementIMlgratlon Plan

Items that still concern me

Use of the temp tables
POSSible use of grouped reports to reduce the use of temp tables
Note leading totals can be generated In a datawlndow - a temp table IS not reqUired
AcqUire knowledge of the uses of the temp flies - conSider alternatives

The replication process that merges the database - ThIS stili must be Investigated

Tab objects built on demand when appropnate?
ThiS dlstnbutes the walt time away from the Window open or retneves event and places It In the tab
selection event It IS more a perception of Increased performance than an actual Increase There IS an
actual Increase when the tab pages are not accessed GeneraJly your userobJect constructor for the
tabpage must be able to tngger/post It'S own data retnevall set up

Use of Imbedded Sal In the application In lieu of datawtndows to create a database Independent application
these must be relocated to the transaction object non-visual or placed Into datawlndows

506 SELECT statements
196 UPDATE statements
398 INSERT statements
310 DELETE statements

Windows with large number of controls
The more windows recogntzed controls on a window the more operating system resources are consumed
to control them In any version of Windows thiS translates to less Windows and applications that can be
opened simultaneously Investigate possible decreased use of operating system resources by uSing
external datawlndows effecbvely

Windows with large number of buttons
Should the buttons be menu Items?
If not, should the buttons be simulated In an extemal datawlndow?
If the ability to enable/disable menu Items IS the Issue and the settings are not vaned depending

on the Window with focus - the application can set the frame menu's enabled/disabled
attnbutes and the sheet menus can copy the enabled/disabled status In the selected or
clicked event of the main menu Item

Please do not plan to alter a menultems VISible attnbute - thiS IS a very slow process

1\

I
I
I
I
I
I
I
I
I
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I
I
I
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'-- Appendix

A) Initial Database Model

B) To Be Database Model

C) PowerBuilder Library Configuration

D) Lists of Unused Items

E) Conversion of global functions to object functions
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act type

~
descr
shorLdescr
fin_mode

JIDmtlnt
varchar(15)
char(1)
char(1)

calendar
~ dati
cal_holiday varchar(15)

conlract
kI Jnmsw
contract varchar(6)

cusLtype

~ mmu
descr char(20)
ctrLkwh double
ctrLpmnt double
disc_del double
disc_age smalllnl

Ideas
kI IJJlg[
Ideas varehar(5000)

lasLId
Ibl yarcharf3Q)
lasLid smalllnt

reports vaheIOQlCaUypes

I2sLM2i !Obmill
log_type_descr varchar(20)

L

pavmenLtvpe
~ ma1!IDl
descr varchar(15)
mode char(1)

receipt
org_ld Inleger
IW1...D2 simIbII
lUISl.m dmII2II
start_date dale
end_date date

no
pscdate
pscdescr
pscnarne
Is
uld

Integer
date
varchar(20)
varchar(30)
timestamp
varchar(10)

2Id
conlract
ace_no
reading
kwh
lid
read-dale

Jntggg[
varchar(6)
Inleger
double
double
Integer
dale

val
d...dIlI dati
exp_dale dale
val float

)

- - - - - - - - - _.. - --



Jun

June

melerJd .. melerJd

uncUon

descr varchar(30)
cat char(2)
type_char varchar(4)
Ml.I fDtggg[
level smallint
tv_Icon char(12)

JuncUon_ld .. lunc1loo_ld

I
cuslomecld .. cuslomecld

customer

lunctlon Id fDtggg[
type Integer

~=::- ..Jdescr varchar(20)
roJd .. route metecld Inleger

customer.Jd Inleger

customer_ld .. cuslomecld locaUon_ld Integer
I_':":":':~ -! entcno smalllnt

apLno Char(4)
route sma/lint

cyJd smalllnt
m-ki ~

Ie

mJiI!1Dl
dale
dale
dale
dale
dale
dale
mmIIlnI
mmI!In1

tem

customecld =customeOd

mralllnl
varchar(15)
smalllnt ~'-- .J
sm.a1llnt cyJd .. cyJd
smalllnt
sm~JIlnt

cle

route

~-_~_--Ialsl
cyJd = cyJd create_date

prlnLdate
read_date
bllLdate
pay_date
disc_dale
oerlodno
rmLD2

mJd ~
ro_descr varchar(15)

alsl
cy_descr
cy_day
cy-perlod
cy_cCday
cy_ccperlod

customer Id lDWw
accounLno Integer
type char(1)
name varchar(20)
bill_address varchar(100)

customeccustoffil!lr phone varchar(15)
t-::--:-~=';':';':":==:':':::::"--bUSlomecld .. resp_customerJdcustomer Id Ir~ tarlfUd smalllnt
rasp customer Id Jr~ customec1d .. customerJd dlscounUd smalllnt
kwh smallint I-----=:----.:....=:.:.....~ vaLexemption char(1)
num_users smalllnt grace-perlod sma/lint

late-pmnLcharge sma/lint
accLopn_date date

r.-:-..:t;;:.od;:,;a;;L:;:-p~a=::;e::.:n::...t-+--1 accLcls_date date
Id ~ status char(1)
customer_ld Integer customecld .. customerJd resp_loss_before char(1)
amount doublle 1----------=------..1 respJoss_after char(1)
pmnUnv-"o doubl'e pmnLbalance double
pmnLdate date I asoCdate date
pmnLtype small'nt lasLblll-"o Integer

'-- -,.-..J contacLperson varchar(20)

customecld .. customecld bank-acet varchar(50)r-__'-- .Iaglng smalllnt
pays_mode char(1)
Ipc_calc double

)

--
)

- ----------------
L



losses

Inlg[
varchar(30)
smallint
smallint
smalllnt

t
type = type

1WI
descr
type2
code_len
level

losses Id ~
junctlorUd Integer
fix smallint
vacllne smalllnt
vacioad smalllnt
from date
to date

I
junctloo_ld .. junctlon_ld ora Dhvs

~ Inlg[ org--9roups Ol'!Lorg

junctloo_ld .. juncLid
aroUD Id Inlg[group_Id Integer group_ld .. groupJd lWd Inlg[

juncUd Integer descr varchar(30) group_1d '"' parenLold parenLold Integer
link_from date comments varchar(200)

link_to date type Integer
child_old Integer

contract varchar(6) code varchar(16)
conn.Jrom date
COM_to date

meter Id
serial_no
type
max_length
mulUactor
InsLdate
repLdate
lasUesLdate
own
locatloo
mcno
phase
amps_min
amps_max
volts

meter

Intmw:
varchar(8)
varchar(6)
smallint
smallint
date
date
date
char(1)
char(1)
smallint
smallint
smallint
smalllnt
smalllnt

metecreadln
I!DLkI Inlg[
lunctlon!d Inlg[
type char(1)
read_date date
reading double

meteUd =metecld kwh double
~--------l ref varchar(10)

bilLno Integer
~ mwIlnl
ts timestamp
uld varchar(10)
status char(1)
margin char(1)
acLtype sma/lint

kI
junctlonJd
from
to
fix
vaUlne
var_Ioad
kwh
loss
subkwh
rema/n
level
rep_no
mtr
other
org..Jd
sub_cnt

Jrmlai[
Integer
date
date
smallint
smallint
sma/lint
double
double
double
double
smallint
sma/lint
char(1)
char(1)
Integer
Integer

L
))

- - - -
)

- - - - - - - - - - -



lsi
customerjd
Junctlon_ld
acL\Ype
reading
kwh
amount
resp_customeCld
resp_kwh
resp_amount
acLdate
ref

Intisw
Integer
Integer
smalllnt
double
Integer
double
Integer
double
double
date
varchar(10)

temp_ balance
Junctlon_ld Integer
um: §Ilmllinl
II!QIllb mm!!Int
customer \d ~
starLbaiance double
kvm double
ceccash double
cecnoncash double
cecresp double
crCcash double
crCbank double
crCseUement double
cr1_other double
end_balance double
rep_no smalllnt
ch_deb double
ch3red double

temp_conn d1sconn
cystomer!d fnIggg[
Dl2dI !ClmrL1l

temlt contract
JJsI IDtim
contract char(6)
gld Integer

temp electrfc

lsi IoWa
pld Integer
level smallint
resO Integer
res1 Integer
res3 Integer
oresO Integer
ores1 Integer
ores3 Integer
corpO Integer
corpi Integer
COrp3 Integer

temp_for_baIance
c1d Integer
t1d2 smaJllnt
dld2 smallint
vat float
kwh double
muh double
days smallint
cons double
nUrTLusers smallint

tempbllLbodv

L

temp-parenLchlld
Darent Id ~
~~
level smallint
number1 double
Int1 Integer
numbel2 double

tem
Id
kwh
bill
paid
curr_bal

a ent
Integer
double
double
double
double

lsi Jnmw
start_no double
end_no double
flrsUree double
lasUree double
firsLuse double
lasLuse double
dbl char(1)

temp_rasp_customer
kwh double
consumtlon double
type char(1)
customaUd Intager
k!UI JoIggi[
tarlfUd amallint

I ~ ...... I~Q IIlename varchar(32) \Ill
\Ill
ID1m..l!2
rmLIl2
portlono
portion
kwh...,portlon
tariff
subtotal
tarllfJd
tarllfJd2
dlscounLst
vaUnc_st
valpls_st
vaLmns_st
total_st
type
~

IDtim
IDtim
mmllIDl
mmIIInI
double
double
double
float
double
smallint
smallint
double
double
double
double
double
char(1)
InWw

\

) )

- - - - - - - - - - - - - - -- - - -



I

tarifCbreakdown
larlff Id2 mJi!IIInl
POrtion no mJi!IIInl tarifUd2 '" larlfUd2
portionO Inleger
portion Inleger
larlff noal

WI!1..kt2
tarlfUd
eff_date
exp_date
locI_vat
discountable
grace-period
lale-pmnLcI1arge

level1
~ Inmsw
descr varchar(20)

InIiQti
double
date
double
date
double
double
char(1)
Inleger
InIiQti
smalllnt
double

tem c..Junctlon

IocallorUd -locatlon.Jd

(unction Id
kwh
prev_read_dale
prev_readlng
lasLread_date
lasLreadlng
consumtlon
type
cuslomer Id
I2QJd -
lanfUd
Ipc

tariff_1d - tarffUd

mmIIInl
smalllni
dale
date
char(1)
char(1)
smalllnt
smalllnt

tariff
liII:IfUI mniIlID1
descr char(30)

taritf2

tarfff_ld = tariff_1d

dlscount!d mmIIIol
descr char(30)

discount

dlscoynt Id2 l!IdIDl
dlscounLid smalllni
eff_date dale
exp_date date
discount smallint

dlscounUd - dlscounLid

dlscount2

msg

cusLmso

mm..1ll JnWw:
msg varchar(2S0)

mm..1ll JnWw:
customer Id ~

I
msg_ld • msgJd

I
fin transactIons

customer Id JnWw:
transaction no mmIl/nl
type char(1)
Icdate dale
amount double
ref varchar(10)
kwh double
Ipc double
lunctlon_ld Inleger
Is timestamp
uld Varchar(10)
acLlype smalllnt

level2 locatlon_ld '" locatlon_ld location

level_ld .. levelUd

ImlJd ID1ww
locaUon_ld Integer
descr char(6)

InWw
Integer
varchar(20)

level4

I eUd .. level5 Id
lev Jd .. level4_ld \ -

locaUon_ld .. locaUon_ld locaUonJd -locaUon_ld

IDtg[
Integer
varchar(20)

level3

I!lmm I eI I location Id lnWir
Integer /""If-_ev d_"'_le_v_el_2__I_d--JleVelUd Integer
varchar(20) level2_ld Inleger

L..- .:..-:.J level3_ld Integer
level4Jd Integer
levelS_ld Inleger

L
)

-
)

- - - - - - -
)

- - - - - - - - - - -



tem

tempblll.Jnr

I!JImw:
I!JImw:
double
double
double
double
smallint
double
double
double
double
double
double
double
double
double
double
double
char(1)

tern IUnteN

tem bill_sheil

Ikl JDIeggr
lliI I!JImw:
JnWulg IOlAI1IDl
dLfrom date
dLto date
kwh_lnteN double
sum double
discount double
vaLine double
vaLp/s double
vaLmns double
total double
g,d Intiggr

Ikl
1Il1
sum_kwh
loss_var_bef
loss_lIlLbef
kwh_total
kwh_days
dUotal
vaLine_total
valJlls_lotal
vaLmns_total
sum_total
dlscounUotal
prevJasLrdng
lasLrdng
olheckwh
othecamount
subjrNh
change_mtr,

Jnma:
IDW1.lu
char(1)
Jnma:
double
smallint
double

I!JImw:
I!JImw:
IOlAI1IDl
char(1)
Integer
date
double
double

Id .. 11d
unctlon_ld .. lid

lliI
lliI
type
"d
kwh_share
users
deshare

lliI
IkI
mw....ng
type
meter_ld
realf-date
reading
kwh

Id.lld
)uncUorUd .. )Id

Id.11d
)uncUOILld • lid

I!JImw:
I!JImw:
double
double
double
char(1)
char(1)
char(1)
char(1)
char(1)
date
date
date
double
timestamp
timestamp
timestamp
smalllnt

tem
tempi _dlr lsi

r.1sI:-;----'-'--''''-'-''=;-'n--:teg-e-r--I lunctlon Id
I<lg.-date date data
cat char(1) data2
type char(2) data1
parenUd Integer poste<Lrdng
cycle smallint posted-JlfTlnt
route smallint posted_bill
descr varchar(60) ..... ld_.._I_d__--1 foeblll
children smallint selected
print_alt smallint date_rdng
posLrdn!Lcnt smallint date-J)mnt
posLbllLcnt smallint date_bill
post-JllTlnLalt smallint pmnUnv_no
enteerdnll-cnt smallint ts-J)Osted_rdng
enter-J)mnLcnt smallint ts_posted-J)mnt
purged smallint ts-J)Osted_blll

pmnLtypeJd

L
))

./
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temp_cYCle

a.Is1 mJB!!Int evcIe
creale_date date a.Jd mmIl!nl
prlnLdate date

cy_ld =CV_ld
cv_descr varchar(15)

read_dale date cy_day smallint
bllLdate date CV-perlod smalllnt
pay_date dale CV_cUfay smallint
disc_date date cv_cr-perlod smallint
period no mmIIlDl
WLlHl mmIlInl

f
cvJdicyJd

roule

CUi mmIIInl
CVJd smallint
ro_descr varchar(15)

---

~
e .. type

- -
cuslomeOd .. euslomecld~

/)
--

cusL e

Ma mmm
descr char(20)
elrf_kwh double
clrf-pmnt double
disc_del double
disc_age smalnnt

-

customer Id InI§gg[
reSD customer Id InI§gg[
kwh smalllnt
num_users smalllnt

--
)

-

cusLmsg

~ ~
customer Id ~

msgJd .. msgJdms

ma..kl ~
msg varchar(250)

dlscount2

~discount Id2 mla!Ilnl
dlscounLid smalnnt dlscounLid =dlscounLid discount dlscounLid • dlscounUd
elf_date date discount Id mmlIInl
exp_date date descr char(30)
discount smalnnt customer_ld • cuslomerjd

)
L

I



---
)

/
Junct!on_1d .. JuncllonJd

descr
cat
type_char
IWI
level
tv_Icon

- --
jL.nc.t!ooJd .. Jun..tlonJd

\

-

1DlIsw
Integer
Integer
date
date
smallint

---

ID1ilm
double
date
double
date
double
double
char(1)
Integer
lnIggti
amallint
double

-

tern Junction
lunctlon Id
kwh
prev_read_date
prey_reading
lasUead_date
lasLreadlng
consumtlon
type
customerJd
I2UI
tarifUd
Ipc

---

tariff breakdown
IW:IfLkf2 mHIlIInt
portion no mmIlID1
portlonO Integer
portion Integer
tariff lIoat

----

tariff

tarilf2
~
tarifUd
elf_date
exp_date
Incl_vat
discountable
grace-period
lateJ)mnLcharge

mmIIInl
smalllnt tariff_ld2 '" tarifUd2
date L.....__-----
date
char(1)
char(1)
smalllnt
smalllnt r-....

'---------...........J,,_ld =tarilf_ld

-
L

roJd : route

customer
customer Id 1DlIsw
account_no Integer
type char(1)
name varchar(20)
bill_address varchar(100)
phone varchar(15)
tariff_ld smalllnt
dlscounUd smalllnt
vaLexemption char(1)
grace..J)9riod smalllnt
lateJ)mnLcharge smalllnt
accLopn_date date

----I accLcls_dale date
status char(1)
resp_loss_before char(1)
resp_loss_after char(1)
pmnLbaiance double
asoCdate date
lasLblll_no Integer
conlacLPerson varchar(20)
bank...acct varchar(50)
aging smalllnt
pays_mode char(1)
Ipc_calc double

tmIft..M mlaI!lDl
descr char(30)

tarilf_ld = tariff_ld

customer_ld =customerjd



~~_--.:.:los_s_es.....,...__l

losses Id InWw
JuncUorUd Integer
I1x sma/Unt
vacline smalllnt
va,-Ioad sma/lint

./ from date
~ to date

JOJd

~ncLId

_0 or
Q2..JsI ~ ~ InlIm
parenLold Integer descr Varchar(30)
child_old Integer type2 smalllnt
conn_from date code_len smallint
conn_to date level smallint

group_id '" parenLold

or h

SIl..k1 ~
group_ld integer group_ld • groupJd
JuneLld integer
IInlUrom date
IInlLto date
contract varchar(6)

receipt
orlLld Integer
§1II1.Jlll !imlIU
Jml.JlQ !imlIU
starLdate date
end-date date

locatlon_ld '" leveI3_ldlocatiOll_ld .. leval!location Id '" level4 Id- -

location
tnmggr
sma/lint
varchar(20)
Integer
Integer
Integer
Integer
Integer

location fd
level
descr
levelUd
level2 fd
level3-ld
level4=ld
level5_ld

locaUon_ld '" levelUd
1nt§gj[
varchar(8)
varchar(6)
sma/lint
sma/lint
date
date
date
char(1)
char(1)
sma/lint
smallint
sma/lint
smalllnt
smalllnt

meter
DWL...kI
serial_no
type
max_length
mulUactor
InsLdate
repLdate
lasUesLdate
own
location
mcoo
phase
amps_min
amps_max
volts

mmr.Jd Irlli!!Dr
Junction Id Irlli!!Dr
type char(1)
read_date date
reading double
kwh double
ref varchar(10) matecld '" meter_1d
bULno integer
JIlL..DQ ~
ts timestamp
uld varchar(10)
status char(1)
margin char(1)
act_type smallint

metecreadlO

~
lloo_ld meterJd '" metecld

-----------__ locaIlOll_ld .. localloo_ld

L
)

-
)

- - - - - - -
)

- - - - - - - - - - -



InWw
date
char(1)
char(2)
Integer
smallint

, smallint
varchar(60)
smalllnt
smallint
smalllnt
smallint
smalllnt
smalllnt
smalllnt
smalllnt

III
customer_ld
amount
pmnLlnv_no
pmnCdate
prnnLtype

lernpl09-dlr
Id
'09-dale
cal
type
parenUd
cycle

lid =Id route
1----.----__.1 descr

children
prlnLcnt
posLrdn9-cnt
posLblll_cnt
posLpmnLcnt
entecrdn9-cnt
enter..JllTlnLcnt
purged

Imgr
InWw
double
double
double
char(1)
char(1)
char(1)
char(1)
char(1)
date
dale
date
double
timestamp
timestamp
timestamp
smalllnt

code =prnnCtype

kI
Junction Id
dala
dala2
dala1
posted_rdng
posted....pmnt
posted_bIll
for_bill
selected
date_rdng
date-PfTlnt
date_bill
prnnLlnv_no
ts.J)Osted_rdng
ts.J)Osted-PfTlnt
ts.J)Osted_blll
pmnCtype

code = pmnCIype

Id.11d
Junctlon_ld • Jld

Id.11d
Junctlon_ld • Jld

IDWw
~
char(1)
IDWw
double
smalllnt
double

Inmrm
Inmrm
mli!!!!nt
char(1)
Inleger
dale
double
double

lliI
lliI
type
2UI
kwh_share
users
dcshare

tempbllLmr

lliI
/lsi
rmL02
type
meler_ld
read_date
reading
kwh

Id=lId

~"",onJd'I~

Il1Wm
~
double
double
double
double
smalllnt
ttouble
double
double
double
double
double
double
double
double
double
double
char(1)

tempbllLshel1

lid
Ild
sum_kwh
loss_vacbef
loss_fix_bef
kwlUotal
kwh_days
dUotal
vaLloc_total
vat-PIs_total
vaCmns_total
sum_total
dlscounUotal
prey_lasLrdng
lasLrdng
other_kwh
other_amount
sub_kwh
change_mtr

tempblll Interv

lliI InDr
lliI InDr
Intery no mmlI!n1
dUrom date
dUo date V
kwh_lnterv double
sum double
discount double
vaLine double
vat""p1s double
vaCmns double
lotal double
~ InWw

L
) I

i
./

-
)

- _. - - - - - - - - - - - -- - - -



IDtar
Integer
date
date
smallint
smallint
smallint
double
double
double
double
smallint
smalllnt
char(1)
char(1)
Inleger
Integer

iii
Junction_lef
from
to
fix
varjlne
varJoad
kwh
loss
subkwh
remain
level
rep_no
mlr
other
orgJd
sub_cnt

\
'unctlorUd • Junctloo_1d

code .. acLtype

Jnmgg[
Jnmgg[
mIiII!nl
mm!IInl
double
double
double
float
double
smallint
smallint
double
double
double
doUble
double
char(1)
IIJ1g[

tempbllLbody

lid
lid
Intary no
nM...DSl
pordonO
pordon
kwh-porUon
tariff
subtotal
tarlff_ld
tarlfUd2
dlscounCst
vaUnc_st
vat..pls_st
vaLmns_st
total_st
type
!ild.

tnma:
varchar(6)
Integer
double
double
Integer
date

Integer
mm!IInl
mmIIIDl
ID1uiJ:
double
double
double
double
double
double
double
double
double
double
smallint
double
double

m!S!!!!nl
varchar(15)
char(1)
char(1)

dd
contract
ace_no
reading
kwh
Jld
read_date

vahe

~
descr
short..descr
fin_mode

JuncUon_ld
~
IDQ!l1!l
cystomer Id
start..balance
kwh
ceccash
cer_noncash
cer_rasp
cr1_cash
crCbank
crCseUement
cr1_other
end_balance
rep_no
ch_deb
ch_cred

customer_1d '" customeeld

acLtype

tin_transactions
t-:-:-:-:7---=~;:;:::''::=::::;:~_--IJstomecld .. customer_ld
cuskXner Id ~
transaction no mm!IInl
type char(1)
tedate date
amount double
ref varchar(10)
kwh double
Ipc double
lunctlon_ld Integer
ts Umestarnp
uld varchar(10)
acCtype smallint

L
) I

./

- - - - - - - -



calendar
cal date simi
caI_hoRday varchar(15)

contract
lsi 1D1§gg[
contract varchar(6)

Ideas
lsi IDWm
Ideas varchar(5000)

1&SL1d
1bl yarchar(3Q)
luUd smallint

reportslogical Jvpes

~ ~
log_type_descr varchar(20)

no
pscdate
pscdescr
psr_name
Is
uld

Integer
date
varchar(20)
varchar(30)
timestamp
varchar(10)

temp. act
lsi
customecJd
JunctlonJd
acLtype
reading
kwh
amount
resp_customer_ld
resp_kwh
resp_amount
act_date
ref

Jntggg[
Integer
Integer
smallint
double
Integer
double
integer
double
double
date
varchar(10)

temp_conn d1sconn
customer Id 1D1§gg[
IIl2Wl am

temp contrael
Ikl kJtggg[
contract char(6)
gld Integer

temp-parenLchlldtemp electric

lsi Inm9w:
pld Integer
level smalllnt
resO Integer
res1 Integer
res3 Integer
oresO integer
ores1 Integer
ores3 integer
ccrpO integer
ccrp1 integer
ccrp3 integer

temp focbalance
dd integer
tld2 smallint
dld,J smallint
vat float
kwh double
mult double
days smallint
ccns double
num_users smallint

parent Id
~
level
number1
InU
number2

InIg[
InIg[
smallint
double
integer
double

temp-payment
Id Integer
kwh double
bill double
paid double
curcba! double

temp receipt
Id 1D1§gg[
starLno double
end_no double
f1rsUree double
lasUree double
nrsLuse double
luLuse doub/e
db/ char(1\

temp resp customer
kwh double
consumtlon double
type char(1)
customer_ld Integer
1lLId Iolar
tarlfUd smallint

vat
d..slAlI daIl
exp_date date
vat noat

I.-
L

)

-
)

- - - - -
)

- -- - -
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Appendix C

PowerBuilder Library Configuration



I
I
I
I
I
I
I
I
I
I
I
I

_____.~ ~ \~~~~~\~~~u~ ~~~

Dace 8/26/98 T~e 17 06 21

* -------------------------------*
A cat10n entr1es

*-~-------------------------------*
Name
mal.n

*----------------------------------*
Menu entr1es

*----------------------------------*
Name
m_genapp_frarne

*----------------------------------*
Wl.ndow entr1es

*----------------------------------*
Name
w_9c:napp_about
w_9t:.napp_frarne
w_genapp_toolbars
w_logon

*----------------------------------*
ProJect entr1es

*----------------------------------*
NaJllP

m
'--

Date
8/26/98

Date
8/26/98

Date
8/26/98
8/26/98
8/26/98
8/26/98

Date
8/26/98'

T1me
13 35 46

T~

13 36 03

T1Jlle
13 38 50
13 38 51
13 38 51
13 38 52

T1me
13 41 43

Sl.ze
(5031)

S1ze
(65688)

S1ze
(22730)
(5726)
(15543)
(14572)

Sl.ze
(11088)

I
I
I
I
I
I
I

BEST AVAILABLE copy



------ ------~. ~~-

8/26/98 T1Jlle 17 06 24

I
I
I
I

• --------------------------------*
I _J.on entrJ.es

*~~~-------------------------------*
N.:l.me
f_check
f_mess
rnb

Date
8/26/98
8/26/98
8/26/98

TJ.me
13 35 52
13 35 51
13 35 51

SJ.ze
(620)
(1404)
(489)

Lf1



I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

~.~ ~ \Q~a~U~\QQamess po~

L_ _ 8/26/98 T~e 17 06 26

-------------------------------*
f _J.on entrJ.es
'--*----------------------------------*

NaIfl..

f_c",nter_wJ.ndow
f_d.:i.{s_fract.1on
f_daparse
f_d.. ly2date
f_0'::C_schdl
f_G",cactJ.vesheet
f_global_replace
f_-~_wJ.n_actJ.ve_sheet

f_H..1xdate
i_I .........J.I1U.ze
f_lf.l.ndate
t_n ..dl
t_L.po=n_help
f_ ..sJ.zesheet2max

Date
8/26/98
8126/98
8126/98
8126/98
8126/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

TJ.me
13 35 51
13 35 50
13 35 49
13 35 48
13 35 48
13 35 47
13 35 46
13 35 46
13 35 47
13 35 47
13 35 48
13 35 49
13 35 49
13 35 50

SJ.ze
(1095)
(1630)
(987)
(644)
(1434)
(789)
(913)
(989)
(592)
(843)
(592)
(483)
(547)
(692)



______ ____ n ... _ ~__

8/26/98 T:une 17 06 29

I
I
I
I
I

* -------------------------------*
1:. lJ.ndow entr~es--*----------------------------------*
Name Date T~me S~ze

d_dddw_lev1 8/26/98 13 34 43 (2608)
d_Jddw_lev2 8/26/98 13 34 43 (2836)
d_dddw_lev3 8/26-/98 11 -3-4 4' (27451

d_dddw_lev4 8/26/98 13 34 42 (2745)
d_dddw_lev5 8/26/98 13 34 42 (2745)

-----------------------------------*
Funcc~on entr~es
s __________________________________ *

N...nc Date T~me S~ze

I_'..l\atenunod~f~ed 8/26/98 13 35 52 (940)

-----------------------------------*
Structure entr~es

-----------------------------------*
NaIl'''' Date T~me SJ.ze
::,_logd~r_~tem 8/26/98 13 35 52 (598)

w__________________________________ *

11~"'l.ObJect entrJ.es
*----------------------------------*
h Date T~me S~ze

\,.."_..... 0 8/26/98 13 35 53 (2669)
uo_cbcancel 8/26/98 13 35 53 (1519)
l.u_u3standard 8/26/98 13 35 53 (6954)
u<J_uwlocatJ.on 8/26/98 13 35 55 (4884)
uCo_.lwstandard 8/26/98 13 35 54 (7941)



8/26/98
r---

TJ.me 17 06 31

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

*- -------------------------------*
I:\ l~ndow entr~es

.~~-------------------------------*
NWIle
d_customer
d_customer_qv
d_dd_Junct_type
d_od_log~cal_types

d_dd_org
d_dd_org_type
d_dd_route
d_dddw_act_type
d_addw_contract
d_dddw_cust_type
d_dddw_cycle
d_dddw_dJ.scount
d_dddw-Junct_cat
d_uddw_Junct_cype
d_dddw_log_type
d_dddw_log1cal_types
a_dddw_meter_type
d_..lddw_org
d_dddw_org_type
d_dddw-pmnt_type
d_dddw_route
d_oddw_tar1ff
d_ds-Junct10n_ch11d_subkwh
d_d~-JunctJ.on_losses

d lUP-Junct10ns
a"::'~-tlct

O_junct10n_ch11d_1d
d_fU.:cer
d_lfi.::cer_rdng
d_nlecer_readJ.ng_deta11
d_org
d-IJ a1ment_deta11_bJ.IIJ.ng
d-I~yment_deta11-payment

d_receJ.pc_org

Date
8126/98
8/26/98
8/26/98
8/26/98
8126/98
8/26/98
8126/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8126/98
8/26/9a­
8/26/98
8/26/98
8/26/98
8126/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

TJ.me
13 34 50
13 34 49
13 34 49
13 34 48
13 34 48
13 34 47
13 34 47
13 34 46
13 34 46
13 34 45
13 34 45
13 34 45
13 34 44
13 34 44
13 34 44
13 34 43
13 34 43
13 34 43
13 34 44
13 34 44
13 34 44
13 34 45
13 34 45
13 34 45
13 34 46
13 34 46
13 34 47
13 34 47
13 34 48
13 34 48
13 34 49
13 34 49
13 34 50
13 34 50

S~ze

(31590)
(17327)
(2810)
(2524)
(2907)
(2791)
(2486)
(2659)
(2724)
(2533 )
(2854)
(2576)
(2755)
(3666)
(2790)
(2889)
(2483 )
(3121)
(2716)
(2758)
(3563)
(2575)
(6897)
(4954)
(8680)
(16228)
(5633 )
(28729)
(16742)
(12758)
(10092)
(9598)
(9954)
(8305)



- --- --_...... ~--

L.. t:e 8/26/98 Tune 17 06 33

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

*----------------------------------*
WJ.ndow entrJ.es

~-------------------------------*
Name
d_bJ.ll
d_bJ.l1_ca_sc
d_bJ.ll_n_oal_arm
d_bJ.ll_n_ba1_ca_sc_arm
d_bJ.11_n_bal_ca_sc_eng
d_bJ.ll_n_bal_ca_sc_rus
d_bJ.ll_n_bal_eng
d_blll_n-bal_rus
d_dddw_log_cust
d_ds_exp_datel
d_ds_exp_date2
d_ds_exp_date3
d_ds_org
d_ds_tempb11 l_body
d_ds_tempbJ.ll_mr
d_ds_tempbJ.ll_other
d_report_9J_J.n_cycle_for_hashv

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

TJ.me
13 34 55
13 34 54_
13 34 54
13 34 53
13 34 52
13 34 52
13 34 51
13 34 51
13 34 51
13 34 51
13 34 51
13 34 52
13 34 53
13 34 53
13 34 54
13 34 54
13 34 55

S1ze
(16830)
Cl44041
(11229)
(20103 )
(20045)
(20071)
(11851)
(11754)
(4135)
(3085)
(2654)
(2618)
(4248)
(16147)
(11976)
(3977)
(20931)



------ -- - ~--

L L~ 8/26/98 T1Ille 17 06 36

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

*- -------------------------------*
D hndow entrl.es

*~-------------------------------*
Nan a
d_contract_temp
d_ds_for_agl.ng
d_os_Junctl.on_chl.ld
d_ds-Junct1on_orgs
d_os-parent_orgs
d_d",_subcust
d_aw_vall.datl.on

~----------------------------------*
FWlcCJ.on entrloes
*----------------------------------*
Namt:
f_'lgl.ng
f_check-parents
f_checksqlca
f_concract
f_cuunt_subcust
f_dw_vall.datloon
f_gec_last_lod
f_rJ",c_loc_J.d
f-:; unct_org
f_loGLd_sl.de_kwh
f_ 1 '"lgl.cal_type
f atlovedate
C._...!Lsql_long
t_",,,,c_new_J.d
f_SUDCUSt_kwh

Date
8/26/98
8/26/98
8/26/98
8126/98
8/26/98
8/26/98
8/26/98

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/9B­
8/26/98
8/26/98
8/26/98

Tlome
13 34 56
13 34 56
13 34 56
13 34 56
13 34 56
13 34 55
13 34 55

T1Ille
13 35 58
13 35 57
13 35 56
13 35 56
13 35 55
13 35 56
13 35 57
13 35 57
13 35 58
13 35 59
13 35 59
13 36 00
13 36 00
13 36 00
13 36 01

Sloze
(3248)
(4287)
(4455)
(3997)
(4412)
(4922)
(3097)

Sl.ze
(2405)
(1551)
(792)
(1991)
(921)
(3618)
(1127)
(1760)
(1335)
(2339)
(1034)
(1397)
(1312)
(1083)
(2850)



I
I
I
I

~_~.~.~ ~ \Q~Q~~~\~~.=W~Y ~~~

Dace 8/26/98 T1me 17 06 38

* -------------------------------*
L~J~ndow entr~es

*----------------------------------*
Name Date TJ.me SJ.ze
d_conn_dJ.sconn_l~st 8/26/98 13 34 59 (7935)
d_conn_dJ.sconn_1J.st_for-prJ.nt 8/26/98 13 34 58 (8148)
d_cons_subcust 8/26/98 13 34 58 (7889)
d_cons_subcust_free 8/26/98 13 34 58 (6869)
d_consolJ.dated 8/26/98 13 34 58 (6357)
d_ds_cust_hav~ng_resp 8/26/98 13 34 57 (3033)
d-J unct_by_cat 8/26/98 13 34 57 (4032)
d-poss_conn_1J.st_for-Junct~on 8/26/98 13 34 57 (7331)
d_sporadJ.c 8/26/98 13 34 57 (6947)
d_term_customer 8/26/98 13 34 57 (5570)

~

*----------------------------------*
FunctJ.on entrJ.es

*----------------------------------*
Name Date TJ.me SJ.ze
f_setmenutext 8/26/98 13 36 01 (2484)

*----------------------------------*
Menu entrJ.es

*----------------------------------*
N.:un~ Date TJ.me SJ.ze
m ,.."nsol~dated 8/26/98 13 36 05 (35045)
rr a_entry_conn_dJ.sconn 8/26/98 13 36 06 (33285)
m~vP-possJ.ble 8/26/98 13 36 07 (4020)
m_sporadJ.c 8/26/98 13 36 08 (31123)
m_termJ.nate 8/26/98 13 36 08 (33012)

*----------------------------------*
W~ndow entrJ.es
*----------------------------------*
Name Date TJ.me SJ.ze
w_conn_dJ.sconn_1J.st 8/26/98 13 36 11 (34458)
w_consolJ.dated 8/26/98 13 36 13 (54105)
w-poss_conn 8/26/98 13 36 15 (29761)
w_sporadJ.c 8/26/98 13 36 16 (24933)
w_cerm_customer 8/26/98 13 36 17 (21755)



I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

- ...... -.1 .... \~""" .... w.w \Q,...... I;;U..a.t=W4a ... .IJ~J.

~~L_ 8/26/98 T~e 17 06 40

- -------------------------------*
D J~ndow entr1es

'-.---*----------------------------------*
Name
d_Q.:c_11st
d-l)ayment_b111_seach_11st
d-PdJrnent-master
d-payment-rnaster_corr
d-payment_master_corr_cur
d-Payment-master_cur
d-pa yment_seach_11st
d_coday-payment~ster

d_coday-payment-pr1nt
d_coday-payment-pr1nt_b

*----------------------------------*
M£nu entr1es

-----------------------------------*
NaIlI<;

rn_.......ca_entry
n,_":!..ca_entr:{_act_by_11st
rn_d ca_entry-payment_today

*----------------------------------*

-----------------------------------*
N
uO':'::-Dhelp
uo_cbok
uo_cxstandard

-----------------------------------*
\I'_r ,jow entr1es

~----------------------------------*
IJaIl,;;

w_...cc_by_11st
w_ ,,_ter.Jt\ov1ng
w_, -.cer_read::Lng
W-foClyment
w-payrnent_corr
W_t~y.ment_for_today

wr~J~yment.Jt\ov::Lng

~_~earch-payment

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

Date
8/26/98
8/26/98
8/26/98

Date
8/26/98
8/26/98
8/26/98

Date
8/26/98
8/26198
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

T1rne
13 35 01
13 35 01
13 35 01
13 35 01
13 35 00
13 35 00
13 35 00
13 35 00
13 34 59
13 34 59

T~e

13 36 06
13 36 19
13 36 18

T1IIIe
13 36 09
13 36 09
13 36 19

T1rne
13 36 21
13 36 22
13 36 24
13 36 26
13 36 27
13 36 28
13 36 29
13 36 31

S::Lze
(10768)
(11153)
(11935)
(11730)
(11918)
(11905)
(11287)
(116B1)
(15523)
(16639)

S1ze
(30749)
(33283)
(33291)

S1ze
(1394)
(1361)
(1140)

S1ze
(47519)
(32476)
(39868)
(28787)
(26812)
(42682)
(14278)
(45345)



___ .... '-4.- ....... t... .......... j:J1ooJ ...

D_cEO: 8/26/98 T:une 17 06 42

I
I
I
I
I

" -------------------------------*
r. hndow entrJ.es

~

._~--------------------------------*
Numa Date TJ.me SJ.ze

d_class_by_type 8/26/98 13 35 05 (4349)

d_.::1ass_type 8/26/98 13 35 05 (2667)

d_od_contract 8/26/98 13 35 04 (2620)

d_dJdw_class_type 8/26/98 13 35 04 (2593)
d_dddw_group_type 8/26/98 13 35 04 (2593)
d_Qs_check-parent 8/26/98 13 35 04 (4046)
d_Jl:"oup_by_type 8/26/98 13 35 04 (4031)
d_£lroup_type 8/26/98 13 35 04 (2667)
d_Junct_by_cycle_route_new 8/26/98 13 35 04 (9129)
d_Junct_by_group_new 8/26/98 13 35 03 (10396)
d_Junct_bY_Junct_new 8/26/98 13 35 03 (8632)
d_J-ulct_subcat 8/26/98 13 35 03 (2630)
d_ll.ne_sJ.de 8/26/98 13 35 03 (11591)
d_1J.nk_org 8/26/98 13 35 03 (8291)
C1_1 ...c_ClS 8/26/98 13 35 02 (7779)
d_;:;'I-g_by_type 8/26/98 13 35 02 (4009)
d_vrg_1J.st_by_type 8/26/98 13 35 02 (3425)
d_urg_type 8/26/98 13 35 02 (2665)
d_q:>_lJ.st 8/26/98 13 35 02 (7348)
d_ t ...[ Iplog_new 8/26/98 13 35 02 (8872)

*----------------------------------*
W.lnrl.ow entr1es
* ------------------------------*
Nc:1. .;: Date TJ.me SJ.ze
w-_lnll_now 8/26/98 13 36 34 (50171)
w_l.l.nk 8/26/98 13 36 35 (17075)
w_1J.nk_class 8/26/98 13 36 36 (16692)
w_••nk_group 8/26/98 13 36 37 (17048)
~_l.:;gs_select 8/26/98 13 36 38 (26817)
w.l:_code 8/26/98 13 36 38 (6978)
w__,-onn_type 8/26/98 13 36 39 (9805)
wr__ontract 8/26/98 13 36 39 (7512)
wr__ ount 8/26/98 13 36 40 (7049)
wl_.late 8/26/98 13 36 40 (8145)
wr_..umber 8/26/98 13 36 40 (7610)
wr_Jul.cksearch 8/26/98 13 36 42 (66903)
wr_qlll.cksearch_group 8/26/98 13 36 43 (13230)
...... _~l.me.....Perl.od 8/26/98 13 36 44 (12331)



Da.ce 8/26/98
.

TllUe 17 06 44

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

*----------------------------------*
r V'~ndow entr~es

~~-------------------------------*
Name Date T~me S~ze

d_ds_Jcc 8/26/98 13 35 08 (6998)
d_ds_JJc 8/26/98 13 35 07 (8290)
d_ds-J J c1_org 8/26/98 13 35 07 (8855)
d_ds_JJc1_org2 8/26/98 13 35 06 (9020)
d_ds_JJc1.,.phys 8/26/98 13 35 06 (8634)
d_hnk_class 8/26/98 13 35 06 (8506)
d_l~nk_group 8/26/98 13 35 05 (8291)
d_load_s~de 8/26/98 13 35 05 (8288)
d_losses 8/26/98 13 35 05 (8659)
d_temp_ch~ld 8/26/98 13 35 06 (4879)
dp_balance 8/26/98 13 35 06 (3485)
dp_bnak~ch 8/26/98 13 35 07 (11318)
dp_last_read~ng 8/26/98 13 35 07 (4008)

*----------------------------------*
Menu entr:Les

*----------------------------------*-NcUne Date T:Lme S:Lze
I1Ltree 8/26/98 13 36 46 (113866)

*----------------------------------*
\'hndow entr1es
* ------------------------------*N____

Date T1me S1ze
w_tree 8/26/98 13 36 56 (272057)

'--



------ --~ ....n~ ... .t:J~ ...

8126/98 TJ.lILe 17 06 47

-
I
I
I
I
I
I
I
I
I
I
I

a __________________________________ *

r il.ndow entrl.es
\a __________________________________ *

N.mle Date Tl.me Su;e
d_~ct_for_Junctl.on 8/26/98 13 35 10 (8221)
d_bl.ll_summary 8/26/98 13 35 09 (14067)
d_cust_fl.ntr_bl.ll_by_no 8/26/98 13 35 09 (5766)
d_ds_mr_1nterval_for_b111 8/26/98 13 35 08 (3319)
d_d$_tempb111~_b111_no 8/26/98 13 35 08 (9072)
d_Junctlon_head_arm 8/26/98 13 35 08 (6096)
d-Junct10n_head_eng 8/26/98 13 35 08 (5612)
d-Junctl.on_head_rus 8/26/98 13 35 09 (5688)
d_meter_rdng_corr 8/26/98 13 35 09 (17797)

t __________________________________ *

Wl.udow entr1es
*----------------------------------*
N<:1.llle Date T1me S1ze
w_u.ct 8/26/98 13 37 04 (74657)
w_uer.er_corr 8/26/98 13 37 09 (82342)



L.... l._ 8/26/98
-- --- - &;"--

TUie 17 06 49

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

*- -------------------------------*
[ l~ndow entr~es

*~-~-------------------------------*
N""lnd
d_cons_resp_users_customers
d_cust_type
d_dd_cycle
d_od_Junct_cat
d_d:._cr_1J.st
d_ds-JunctJ.on_cat_type
d_d;;>_templog
d_u:._templog_dJ.r
d_log_hst
d_log_l~st_for_balance

d_log_1J.st_for_readJ.ng
d_macer_rdng_hh
d_t:.::mplog_d~r

*----------------------------------*
Menu entrJ.es
~----------------------------------*

*----------------------------------*
Us~TObJect entr1es
* ------------------------------*

\Nco. _

uo_!"bstanciard

x *

Wl.ndow entrJ.es
-----------------------------------*
N...un~

nJ_upenlogfor
w_log_dJ.r
w_~cport_recollected

w!"_cur
wt"-pnnt_bJ.ll
wr_!"ecollect
w.c_bporadJ.c

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

Date
8/26/98

Date
8/26/98

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

TJ.me
13 35 12
13 35 12
13 35 12
13 35 12
13 35 12
13 35 12
13 35 11
13 35 11
13 35 11
13 35 10
13 35 10
13 35 10
13 35 11

TJ.me
13 37 11

TJ.me
13 36 30

TJ.me
13 37 11
13 37 20
13 37 23
13 37 23
13 37 24
13 37 25
13 37 26

SJ.ze
(5246)
(2645)
(2484)
(2925)
(5381)
(4945)
(7719)
(14816)
(10766)
(9327)
(14894)
(11226)
(13854)

SJ.ze
(43529)

SJ.ze
(1098)

SJ.ze
(9658)
(168625)
(7824)
(11723)
(8269)
(37117)
(9104)



I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

_ ... _ .... _..1; \0.., ~ ..........~_ ..... .;l \~~",CW.,j" j:JJ.JJ.,

Dace 8/26/98 T~e 17 06 51

* -------------------------------*
S- hndow entr.les
*----------------------------------*
Name
d_class.lf.lers
d_class.lf.lers2
d_ds_org1
d_group_orgs-parent
d_groups
d_groups2
d_groups_.ln_org
d_org_ch.lld
d_org-path
d_overflow
d_tbl_.lds
d_tbl_lst

*----------------------------------*
Menu entr.les

*----------------------------------*

*----------------------------------*
W.lndow entr.les

*- --------------------------------*
N
w~vg.lcal

Date
8/26/98
8126/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

Date
8/26/98

Date
8/26/98

T.lme
13 35 15
13 35 14
13 35 14
13 35 14
13 35 13
13 35 12
13 35 13
13 35 13
13 35 13
13 35 14
13 35 14
13 35 14

TJ.me
13 37 27

T.lme
13 37 35

S.lze
(5886)
(6151)
(3094)
(4979)
(5376)
(6183)
(7020)
(3972)
(4259)
(11589)
(8558)
(2693 )

S.lze
(109182)

S.lze
(229429)



------ --- - ~_ .....
D",te 8/26/98 TUDe 17 06 54

I
*- --------------------------------*

I
I Ihndow entrJ.es

.~---------------------------------*
Name Date TJ.me SJ.ze
d_ctct_type 8/26/98 13 35 19 (7181)

I d_customer_by_month 8/26/98 13 35 19 (23512)
d_~ustomer_status 8/26/98 13 35 18 (12251)
d_customer_status_bJ.ll_arm 8/26/98 13 35 18 (5741)
d_customer_status_bJ.ll_eng 8/26/98 13 35 18 (5689)

I d_customer_status_bJ.ll_rus 8/26/98 13 35 18 (5743)
d_customer_status_tr_arm 8/26/98 13 35 18 (5496)
d_customer_status_tr_eng 8/26/98 13 35 17 (5413)

I
d_customer_status_tr_rus 8/26/98 13 35 17 (5465)
d_customer_type 8/26/98 13 35 17 (8679)
d_dddw_tvJ.cons 8/26/98 13 35 17 (2867)
O_J ,mct_type 8/26/98 13 35 17 (9974)

I
u_crganJ.zatJ.on_type 8/26/98 13 35 16 (6252)
u-payment_type 8/26/98 13 35 15 (5821)
d_r",ceJ.pt 8/26/98 13 35 15 (17853)
d_l.L.ceJ.pt_day 8/26/98 13 35 16 (17200)

I d_c,-ceJ.pt_J.nt 8/26/98 13 35 16 (15346)

-----------------------------------*

I hL.!'u entrJ.es
w__________________________________ *

l~aJ:c '" Date TJ.me SJ.ze

I
m I,lw 8/26/98 13 37 38 (31264)
Ii )ort 8/26/98- 13 37 39 (44461)
'---

I *----------------------------------*
WJ.naow entrJ.es

*----------------------------------*
N...rll<: Date TJ.me SJ.ze

I "'_ldw 8/26/98 13 37 40 (11377)
w_...cc_type 8/26/98 13 37 41 (8478)
W_cl...stomer_type 8/26/98 13 37 42 (4876)

I
w_J ..nct_type 8/26/98 13 37 42 (10805)
w_cLg_type 8/26/98 13 37 43 (10515)
w-lJ",yment_type 8/26/98 13 37 43 (8492)
\-,_r;port 8/26/98 13 37 22 (8363)

I
W_JL.port_customer_status 8/26/98 13 37 44 (22805)
w__ dport_receJ.pt 8126/98 13 37 46 (40494)
w_~cports_vJ.ewer 8/26/98 13 37 47 (8382)

I
I
I
I
I
I



*- --------------------------------*
r ~~ndow entr~es

*~-------------------------------*

G
*----------------------------------*
WJ..ndow entr~es

*----------------------------------*
Ncur",
w_r~port_by_tar~ff

w_report_cycle_log~cal

w_report_del~nquency_d~sconnect~on

w_report_locat10n
w_report_meter_tst
w_r",port_rates
WT_d1sc_del_report

Name
d_class_subgroups
d_c~cle_ch~ld_customers

d_cycle_ch~ld_Junct~ons

d_cyc1e_dd
d_cycle_dddw
d_dd_cycle_log1cal
d_dddw_cycle_log~cal

d_d~l~nquency_report

d_d~sconnect~on_report

d_ds_d~scdel_by_cycle_route

d_d.:,_mr_~nt

d_ds_other_kwh
d_ds_other_kwh_1nt
d_Junct~on_ch~ld_~d_for_~nt

d_org_or~roup_Junct~ons_for_~nt

d-parent_ch~lds-phys

d_r~port_by_tar~ff

d_report_d~sconn_l~st

d_report_d~scount

d_report_locat~on

d_r~port_meter_tst

d_report_tar~ff

d_report_vat
d_st=l_loc

SJ..ze
(6838)
(4883)
(3198)
(2616)
(3030)
(2806)
(4982)
(12250)
(10378)
(7209)
(7924)
(5947)
(5998)
(5776)
(3987)
(5660)
(29883 )
(10249)
(6613)
(6257)
(11350 )
(8850)
(5183)
(5012)

TJ..me
13 35 24
13 35 24
13 35 23
13 35 23
13 35 23
13 35 23
13 35 23
13 35 23
13 35 22
13 35 22
13 35 21
13 35 21
13 35 21
13 35 20
13 35 20
13 35 19
13 35 20
13 35 20
13 35 21
13 35 21
13 35 22
13 35 22
13 35 22
13 35 23

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

Date T~ S~ze

8/26/98 13 37 49 (57734)
8/26/98 13 37 52 (65383)
8/26/98 13 37 54 (65396)
8/26/98 13 37 56 (12596)
8/26/98 13 37 56 (9935)
8/26/98 13 37 57 (23376)
8/26/98 13 37 58 (8191)

17 06 56TJ.me

______.... , ...... ltV ......... &-"J1.J_

8/26/98Date

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

I
I
I
I



______ ---.. lo,.-Rw_ J:o",IiJ,.

D .... 0 8/26/98 Tune 17 06 58

•

I

•

I
I
I
I
I
I
I

~- --------------------------------*
r ~~ndow entr~es

.~-~-------------------------------*
Nwn<;
d_bom
d_Lbm_b~ll

d_ds_cons_and-servprov_cust
d_~~nanc~al_chang~ng

d_oroup_subgroups
d_group_subgroups_kwh
a_Junct~on_debt_report_gr

d_Junct~on-Junct~on_report

d_Junct~on_report~r

d_J~ct~on_report_~mpl

d_Junct~on_report_~l_by_level

a_Junct~on_report_~nformat~on

d_l \Jh_act_l~st
d_ot:her_kwh
d_rece~pt_control

d_rt::ce~pt_tr

a_sules_by_log~cal

*----------------------------------*
W~ndow entr~es

-----------------------------------*
Na.Ill>::

w_report_f1nance_by~onth

w lort_for_group
w~.port_for~roup1

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

Date
8/26/98
8/26/98~

8/26/98

Tune
13 35 28
13 35 27
13 35 27
13 35 27
13 35 26
13 35 26
13 35 25
13 35 25
13 35 25
13 35 24
13 35 24
13 35 25
13 35 25
13 35 26
13 35 26
13 35 26
13 35 27

Tune
13 38 01
13 38 05
13 38 08

S1ze
(35583 )
(18695)
(3267)
(16185)
(7715 )
(7459)
(4471)
(6089)
(5768)
(18917)
(16211)
(11334)
(12967)
(8050)
(12801)
(12252)
(15877)

S1ze
(81229)
(65593)
(38720)



-- -- - 1::'--
L .... e 8126/98 T.une 17 07 00

•

I
I
I
I
I
I
I
I
I
I

*- -------------------------------*
I: lJ..ndow entrJ.es
~*----------------------------------*

Nd.ffi\,. Date TJ.me SJ.ze
d_baCch_Junctl.ons 8/26/98 13 35 31 (3357)
d_uJ.ll_cons 8/26/98 13 35 30 (18033)
d_bJ.ll_cons_head_arm 8/26/98 13 35 30 (7986)
d_~J.ll_cons_head_eng 8/26/98 13 35 30 (7966)
d_bJ.ll_cons_head_rus 8126/98 13 35 30 (7962)
a_control_db 8/26/98 13 35 29 (12056)
d_cd_log_lJ.nk_JunctJ.on 8/26/98 13 35 29 (2527)
Q_dddw_log_lJ.nk-JunctJ.on 8/26/98 13 35 29 (2889)
u_LlectrJ.c 8126/98 13 35 28 (14524)
Q_L~ectrl.c-parents_cust_ds 8126/98 13 35 28 (11109)
d_~lactr.c-parents_ds 8126':;,8 13 35 29 {450~

d_lag_cust 8/26/98 13 35 29 (2540)
d_uLg_or_group_JunctJ.ons 8/26/98 13 35 30 (4048)

*----------------------------------*
FUI.':: cJ.on entrJ.es
*----------------------------------*
NaJllt:: Date Tl.me SJ.ze
f_Junct_org_sales 8/26/98 13 38 08 (1981)

*----------------------------------*
Wl.fll"tOW entrl.es
* ------------------------------*
N.... _ Date TJ.me S1.ze
w_bl.11J.ng 8/26/98 13 38 12 (69673)
w_r<-port_electrJ.c 8/26/98 13 38 15 (51777)
w_r~port_for-JunctJ.on 8/26/98 13 38 19 (138827)
w_LLport_for-JunctJ.on_an~chJ.lds 8/26/98 13 38 23 (57111)



I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

____ --.l - '_.....-'-_looIo~ \Q.J,JQ",,4...C;W;l~ ,tJ.u....

Dace 8/26/98 T~e 17 07 02

* -------------------------------*
D'--l~ndow entr~es

*----------------------------------*
Nc;Ul\e
d_calendar
d_cycle
d_cycle_l~st

d_d~scount

d_d~scount2

d_~deas

d_levl
d_lev2
d_lev3
d_lev4
d_h,v5
d_route
o_roure2
d_tar~ff

d_tar~ff2

d_t..r~ff_bd
d_vat2

*----------------------------------*
Fur.ct~on entr~es

*----------------------------------*
Nd1lI<::

f_ - ...s~ze_em2dw
f, ~ze_sle2dw

f_:>.::cw~ndowtext

*----------------------------------*
Menu entr~es

*----------------------------------*
Nama
IrLC<.l1endar
m_cycle_route
m_locatJ.on
IrLr",ces

*----------------------------------*
WJ.I.dow entr1es

*----------------------------------*
NaJl'....
w_c~lendar

w_cycle_report
w_cycle_route
w_~deas

w_locatJ.on
w_r<.lt:es

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

Date
8/26/98
8/26/98·
8/26/98

Date
8/26/98
8/26/98
8/26/98
8/26/98

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

TJ.rne
13 35 34
13 35 34
13 35 34
13 35 34
13 35 33
13 35 33
13 35 33
13 35 33
13 35 33
13 35 32
13 35 32
13 35 32
13 35 32
13 35 31
13 35 31
13 35 31
13 35 32

T~e

13 38 24
13 38 24
13 38 25

TJ.Ine
13 38 25
13 38 26
13 38 27
13 38 28

T1rne
13 38 30
13 38 31
13 38 33
13 38 35
13 38 36
13 38 38

S1ze
(5051)
(9968)
(12306)
(2673 )
(8468)
(2543 )
(2610)
(2764)
(2480)
(2480)
(2746)
(6918)
(6608)
(2706)
(11665)
(9790)
(7818)

Sloze
(1194)
(1212)
(814)

Sloze
(31005)
(36447)
(38723 )
(40886)

S~ze

(40621)
(16410)
(78867)
(6766)
(46031)
(48382)



_________ n_ "'" ~4>",I_

*----------------------------------*

*~~--------------------------------*

L JJ.ndow entrJ.es

S1ze
(24325)
(92333)

SJ.ze
(8798)
(9724)
(4271)
(4513 )
(3350)
(6211)
(3135)
(10588)
(3701)
(3812)
(3705)
(9759)
(3265)
(3100)
(3961)
(9007)
(4904)
(4362 )
(5189)
(7946)
(3706)
(9716)
(3875)
(4432)
(4621)
(4927)
(3657)
(5750)
(3273 )
(5097)
(3997)
(7788)
(7788)
(4549)
(4933)
(5364)
(4358)
(3750)

TJ.me
13 38 40
13 38 43

TJ.me
13 35 42
13 35 41
13 35 41
13 35 41
13 35 40
13 35 40
13 35 40
13 35 39
13 35 39
13 35 38
13 35 38
13 35 38
13 35 37
13 35 37
13 35 37
13 35 36
13 35 36
13 35 35
13 35 35
13 35 34
13 35 35
13 35 35
13 35 36
13 35 36
13 35 36
13 35 37
13 35 37
13 35 38
13 35 38
13 35 38
13 35 39
13 35 39
13 35 39
13 35 40
13 35 40
13 35 41
13 35 41
13 35 42

Date
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98­
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98
8/26/98

Date
8/26/98
8/26/98

TJ.me 17 07 058/26/98Daca

*- -------------------------------*

*----------------------------------*
WJ.rdow entrJ.es

Nam..
w_r<-port_temp
wv,1_servJ.ce

Nam..
d_",ct_fJ.n_tr
d_act_rdng
d_all_customers
d_contract
d_customer_JunctJ.on-regular
d_dave_common_area
d_dave_customers
d_tJ.n_tr-Junct
d_JJ_connect_date
d-J unctJ.on-route
d_lass_date
d_ternp_meter_readJ.ngs
d_crans
dd""ve_agJ.ng
daave_cust_J.nJ.t
ddave_fJ.n_trans
ddave_fJ.n_trans_cust-Junct
ddave_J.nJ.t_balance
ddo:1ve_kwhO
ddeiJe_1og_rIDn
dd....ve_meter
dd~ve_meter-phase

ddave_mr_bJ.1l_no
ddcve_mr_margJ.n
d '-PIIU'lt_type
dc.._ e_read.-date
ddaJe_templog_type
dddJ
dddJ-JJ
dr:-c_log
d~l:_log_ft

dVo:1he_1ast_meter_readJ.ngs
dvan.._1ast~eter_readJ.ngs_hanr
dvaz_cust
dv..z_cust_fJ.ntr
dvaz_cust~dng

dva..:_mrdng
tr_JJ

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

I
I
I
I



I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

~~~.~.~ ~ \~Q~u~\aoax~ace PD~

Dace 8/26/98 T~e 17 07 07

*. -------------------------------*
F\ 10n entr1es

*-~--------------------------------*
Name Date T1me S1ze
f_newdwtransl 8/26/98 13 38 47 (1581)
f_>..la temenu 8/26/98 13 38 46 (1362 )
f_xlatetab 8/26/98 13 38 46 (1448)
f_xlatetabpage 8/26/98 13 38 45 (3829)
f_xlatew1ndow 8/26/98 13 38 44 (1382)
C>..latewobJ 8/26/98 13 38 45 (3863)

*----------------------------------*
UserObJect entrJ.es
*----------------------------------*
Name Date T1me SJ.ze
uo_stxlate 8/26/98 13 36 13 (1592)

*----------------------------------*
W1ndow entrJ.es

*----------------------------------*
Name Date TJ.me SJ.ze
wr_xlate 8/26/98 13 38 48 (61897)

\



---------------
------ ,-- - Z!~-

* -------------------------------*
~ P1pe11ne entr1es

*----------------------------------*
Name
pl_locat1on1
pl_locat10n2
pl_locat10n4
pl_locat1on_copy
pl_route2
pl_route_copy

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

Dar.e:: 8/26/98 TJ.mE! 17 07 09

Date
8/21/98
8/21/98
8/21/98
8/26/98
8/26/98
8/26/98

T1me
17 52 04
18 07 30
18 14 43
13 49 57
13 55 39
13 57 24

S1ze
(2151)
(2162)
(2073 )
(1832)
(941)
(800)



I
I
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Appendix 0

List of Unused Objects



8/26/98 'l':une 17 05 38

I
I
I
I
I
I
I
I
I
I
I
I
I
I
~
I

* -------------------------------*
W. )w entrJ.es.....--*----------------------------------*
Name
w_g~napp_sheet

\ .........

Date
8/24/98

'l'J.rne
09 09 10

SJ.ze
(2999)



_____-' \_........ vc.... a...J.t: , .....I",t,,~c::u

• -------------------------------*s...... _v.lndow entr.les
-----------------------------------*
Name;:
d_dd_report-name
d_ddJw_report_name
d_dJdw_resp-pers

S.lze
(2876)
(3471)
(3078)

TJ.me
16 28 23
16 28 26
14 11 45

Date
8/24/98
8/24/98
8/25/98

1'7 05 41Tune
------...1
D~L~ 8'26'98

I
I
I

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I



Da.ce: 8/26/98 TJ.IIle 17 05 43
-- - ~--

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

-----------------------------------*
r l~ndow entr~es

*~-------------------------------*
Name
d_armen
d_belong~ngness

d_clu.ld-J J
d_corporate-kwh-~n~onth

d_cust_w~thout

d_customer_
d_ds_ch~1d.-J1d

d_ds_cr
d_ds_tempb~ll_mr_vvv

d_JJ
d_JJJJJ
d-Junct_
d--Pmnt_~~log

ddave_b:LIIs
dd~ve_corp_kred:Lt

ddClve_err_ag:Lng
dddve-pmnt_for_day
dvahe_amsva_verJ
dvahe_deb_cr
dvahe_meter_read:Lngs
dVd~_cust_f:Lntr_mrdng

gd_contract
gd_customer
gd_customer_customer
9 ·cle
gl._ .lcle_route
gd_f:Ln_transact1ons
gd_Junct~on

gd_Junct:Lon-Junct:Lon
gd_losses
go_meter
gd_meter_read~ng

gd_route
gd_car:Lff
ga_tar~ff2

gd__tar:L f f_breakdown

Date
8/25/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/25/98
8/24/98
8/24/98
8/25/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98­
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98

TJ.IIle
09 08 54
09 09 13
09 10 09
09 10 09
09 10 09
09 09 15
09 09 21
09 09 21
09 10 10
09 09 25
09 09 25
09 09 26
09 10 11
09 10 12
09 10 12
09 10 13
09 08 58
09 10 16
09 10 16
09 09 00
09 10 18
09 10 18
09 10 18
09 10 19
09 10 19
09 10 19
09 10 19
09 10 19
09 10 19
09 10 20
09 10 20
09 10 20
09 10 20
09 10 21
09 10 21
09 10 21

S~ze

(18451)
(2757)
(2929)
(6247)
(6273)
(32494)
(2622)
(2855)
(909S)
(3582)
(14654)
(16313)
(4520)
(8156)
(4560)
(4695)
(5949)
(5580)
(8004)
(4047)
(7976)
(3322 )
(14091)
(4302)
(4379)
(3078)
(7727)
(6836)
(5259)
(6169)
(9716)
(6873)
(3161)
(3174)
(6479)
(4777)



8/26/98 Tune 17 05 46

-
I
I
I
I
I
I
I
I
I
I
I

*----------------------------------*
D T1ndow enCr1es
.~-------------------------------*
Name
d_ch11d_custorners
d_cycle_gJ_dd
d_c:r cle_gJ_dddw
d_rep_loc
d_report_by_tar1ff _
d_report_by_tar1ff~

d_report_cycle~J

d_rcport_cycle_gJ_rnr_deta11
d_report_del_cycle
d_rcport_del~roup

a_r~port_de11nquency

d_rsport_tar1ff_cycle

*----------------------------------*
W1ndow entrJ.es
-----------------------------------*
N..;l.Il\e
w_r=port_de11nquency_cycle

Date
8/24/98
8/24/98
8/24/98
8/24/98
8/25/98
8125/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98

Date
8/24/98

TJ.rne
09 10 26
09 10 27
09 10 27
09 10 28
00 54 03
00 54 03
09 10 30
09 10 30
09 10 30
09 10 31
09 10 31
09 10 33

TJ.rne
09 10 40

SJ.ze
(3486)
(2760)
(4475)
(4456)
(29883 )
(30682 )
(17012)
(5892)
(10955)
(8403)
(10971)
(20659)

SJ.ze
(37918)



---- --- ...
Date 8/26/98 Tune 17 05 48

•
I
I
I
I
I
I
I
I
I
I
I
I
I

*- -------------------------------*
~11ndow entr1es
*----------------------------------*
Ham£:!
d_dd_cycle, _

d_templog

Date
8/25/98
8/24/98

TJ.me
00 54 04
09 10 49

S1ze
(2610)
(9036)



D ::'" 8/26/98 Tune 17 05 50

I
I
I
I
I
I
I
I
I
I
I
I
I

*- -------------------------------*
D~ 1ndow entr1es

*--~-------------------------------*
N<UlIc:
d_cycle_route
d_dddw_ho11day
d_ds_Junct10ns_cr
d_route2_
d_route_
d_route_free

&_---------------------------------*
WH'10W entr1es
*----------------------------------*
NaIr",.
W_b~ll_days

Date
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98

Date
8/24/98

T1me
09 11 10
09 11 10
09 11 11
16 29 47
16 29 47
09 11 11

T1me
09 11 12

S1ze
(6167)
(2660)
(3539)
(6308)
(6151)
(5821)

S1ze
(7708)



----_ ..... ~

8/26/98 T:une 17 05 52

I
I
I
I
I
I
I
I
I
I
I
I
I
I

*- -------------------------------*
~ IJ.ndow entr:Les

*----------------------------------*
Namt..
d_bJ.1 l_ca_sc_r_arm
d_bJ.1 l_ca_sc_r_eng
d_bJ.1 l_ca_sc_r_rus
d_bJ.ll_n_mr
4-customer_status_b:Lll
d_cic1e_route_head_arm
d_cycle_route_head_eng
d_cycle_route_head_rus
d_a~_ca_respcust

*----------------------------------*
FunccJ.on entr:Les

*----------------------------------*
Narll'"
f_cnc
f_current_balance

Date
8/24/98
8/24/98
8/24/98
8/25/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98

Date
8/24/98
8/24/98

TJ.me
09 11 19
09 11 20
09 11 20
14 11 48
09 11 25
09 11 26
09 11 26
09 11 26
09 11 27

TJ.me
09 11 30
09 11 31

SJ.ze
(18568)
(18966)
(18992)
(6639 )
(5728)
(5082)
(4917)
(4938 )
(4463)

SJ.ze
(860)
(889)



Date 8/26/98 Tune 17 05 54

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

*----------------------------------*
~ 11ndow entr1es

*~-------------------------------*
Name
d_act_for_customer
d_bbm-b111_dave-porc
d_customer_by_month ___
d_customer_by~onth_graph

CLdd_log_type
d_ds-Junct1o~by_tar1ff

CLds_tempb111_mr_by_tar1ff
d_f1nanc1al_chang1ng_cons
d-J unct_by_cycle_route_new__
d-Junct10n_report_~1_

d_log_type
d_tbl_1ds_

*----------------------------------*
Query entr1es

*----------------------------------*
Name
ddd

Date
8/25/98
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98
8/25/98
8/25/98
8/25/98
8/24/98
8/24/98
8/25/98

Date
7/11/98

T1me
14 11 49
09 11 34
16 30 05
09 11 36
09 11 36
09 11 39
14 11 52
14 11 53
14 11 53
09 11 44
09 11 46
14 11 56

T11IIe
03 17 18

S1ze
(6425)
(29765)
(23296)
(22852)
(2692)
(2462)
(9160)
(15120)
(9712)
(17826)
(2641)
(8721)

S1ze
(1203)



_____________ - _ ............. ..... -J("". ..... _~ \ ... -...we"""",,,,, j:J,j"J ...

* -------------------------------*

*----------------------------------*
WJ.ndow entr1es

*----------------------------------*

S1ze
(17797)
(6429)
(11957)

T1me
09 12 52
09 12 54
00 54 26

Date
8/24/98
8/24/98
8/25/98

17 05 59Tune8/26/98Dace

~l~ndow entr~es

-----------------------------------*
Name
d_akc
o-mecer_read~ng_deta11~1n

o.J[lrd

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I,
I
I

Nc1l11e
w_meter_corr_070698

Date
8/24/98

T1me
09 13 03

S1ze
(82364)



Date 8/26/98 Tune 17 06 01

I
I,
I
I

* --------------------------------*
1:--.- entrJ.es
*----------------------------------*
Name
DLgenapp_sheet

Date
8/24/98

TJ.me
09 13 12

SJ.ze
(33055)



--~

*----------------------------------*

* -------------------------------*
L\. _/ hndow entrJ.es
-----------------------------------*

SJ.ze
(5178)

TJ.me
20 33 24

Date
8/24/98

17 06 04T:une8/26/98

I
I

I

I
I
I

Fun~c1on entr1es
*----------------------------------*
N..."c;;:
f_t.£ntersheet
f_JunctJ.on_last_contract
f_",~lect_dwrows

f_cclected_dwrows
f_unslct_dwrows

w *

Date
8/24/98
8/24/98
8/24/98
8/24/98
8/24/98

T:une
09 13 24
09 13 27
09 13 30
09 13 31
09 13 32

SJ.ze
(1295)
(1084)
(1066)
(1002)
(1096)

I
I
I
I
I
I
I

M£n.. entrJ.es
*----------------------------------*

*----------------------------------*
U~c;;:L0bJect entrJ.es
*----------------------------------*
N
u~_~wstandard_old

uo-plstandard

*----------------------------------*
Wl. "-'-'Jill entrJ.es
*----------------------------------*

Date
8/24/98

Date
8/24/98
8/24/98

Date
8/24/98

TJ.me
09 13 34

T:une
09 13 39
09 13 39

T:une
09 13 41

SJ.ze
(23778)

SJ.ze
(6633)
(859)

SJ.ze
(8132)

I
I
I,
I
I

\



* -------------------------------*

-_~ _~_~_~\~c•• ~c.~~~\~.~~~~ OQJec~s\nuseap~p PQ~

Dal_ 8/26/98 T1me 17 06 06

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

I
I
I

~ l~ndow entr1es
*----------------------------------*

Date
8/25/98
8/25/98

T1me
00 57 25
00 57 25

S1ze
(7420)
(9897)



I
I
I
I
I
I,
I
I
I
I
I
I
I
I
I
I
I
I

Appendix E

Conversion of global functions to object functions
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ApPENDIXB

SAMPLE OF MODEL OUTPUT REpORTS

----------- HaglerBatlly -----------



18106

•
I

I
I
I

JunctIOns ImplementatIOn Report
4hhllWU

III 01/05/1998 06106/1998

~ ;::'::~tlODi$'iS~lb'::;; ~.ij(ltwiii}TIWP" EMCWbDteQiii'mlEiiP1CWJi1fOiJiifflsjij!1.ti~:.:J~
I (St. 3]2)S[11 l..j 844798 01/05198 06106/98 30720 125 28229 I 166 1325

2 (St. 3]7)S[1 1 I~ 163925 01/05198 06106198 65600 220 57497 I 565 65]8

3 (St. 342)S(1 I l":J 307722 01/05198 06106/98 40000 220 45982 1696 7678

4 (St. 342)S[12 1,(1 54R344 01/05198 06/06/98 34000 155 30260 I 192 254R

5 (~L 1&I)S[11 ,( 263221 01/05198 06106/98 13 560 67 (20R9 471 1000

6 (SL381)SI12 1,(553111 01/0519806106198 17160 42 17464 325 -629

7 (St. 135)S(1 I ,( 339516 01/05198 06106/98 9200 56 23 137 647 14584

& (St. 135)S[12 1;( 316161 01/05/98 06106/98 27800 85 18515 771 8514

9 (~t. 252)S111 I?J 164231 01/05/98 06/06/98 15540 47 14022 312 1206

10 (St. 252)S[12 l?J 863853 01/05/98 06106/98 18000 64 15625 503 I 872

II (St. 272)S[11 0 168615 01/05/98 06/06/98 42600 152 40 058 1518 1024

12 (St.272)S[12 ~1301710 01/05/9806106/98 19680 105 19039 745 104

13 (St. 3 (8)S[1 I ~i 310016 01/05/98 06/06/98 16800 76 15857 589 355

14 (St.318)S[12 ~694600 01/05/9806/06/98 21840 80 14845 554 6442

)) (St. 385)S[1 I !!' 170709 01/05/98 06/06/98 45920 167 42 105 I 560 2255

16 (St. 428)S[11 ~J 314493 01/05/98 06/06/98 39400 146 35788 1327 2285

17 (St.-461)S[11 ~ 227457 01/05/98 06106/98 59000 192 56963 1732 305

18 (q.t.-467)S[12 [J 01/05/98 06106/98 6030 2 6030 0 0

19 (Sh-477)S[l1 ~ 301218 01/05/98 06106/98 48000 198 40301 1493 6206

20 (Sh 583)S[l1 0315363 01/05/98 06106/98 17520 56 23600 614 -6694

21 (Sh 656)S[l1 ~ 676582 01/05/98 06106/98 53000 257 57024 2167 -6191

22 (Sh 711)S[l1 ~ 01/05/98 06106/98 16920 55 16920 0 0

23 (Sh 715)S[l1 ~ 493134 01/05/98 06106/98 55600 190 39305 1483 14813

24 (St. 717)S[I ( 01/05/98 06106/98 9420 44 9083 203 134

2) (St. 78R)SII 1 ~ 640348 01/05/98 06/06/98 46800 207 47247 I 969 2416

26 (Sh 8)4)S)\ 1 [7j 542426 01/05/98 06106/98 22440 78 17 942 705 3793

27 (St. 862)SII I 2 01/05/98 06/06/98 4540 5 4540 0 0

28 (St. 862)S112 01/05/98 06106/98 2 173 2 2 173 0 0

29 (Sh 945)S[I I ~ 009452 01/05/98 06/06/98 29160 86 27322 900 938

30 (St. 945)Sp 2 ,( 025699 01/05/98 06/06/98 20400 53 25196 577 5373

31 (St. 989)Sfl 1 Z 301493 01/05/98 06/06/98 10880 42 9838 410 632

32 (St. 989)SII 2 .:!.. 347115 01/05/98 06/06/98 10560 41 9048 377 1 135

33 (St. 1030)S[l1 ~ 554724 01/05/98 06/06/98 37200 93 37512 683 995

34 (St. 1030)Sp 2 ~ 544673 01/05198 06/06/98 33960 114 24 139 836 8985

35 (St. 1132)S[l1 ~ 173629 01105198 06/06/98 14220 55 17106 558 3444

36 (St. 1132)S[l2 ~ 179905 01/05/98 06/06/98 26400 87 26 144 879 -623

37 (St. 1165)S[l1 0 140827 01/05198 06/06/98 36360 138 32324 1218 2818

38 (Sh 1265)Sp 1 ~ 293138 01/05/98 06/06/98 14240 79 15278 634 1672

39 (St. 1265)S[l2 ~ 454212 01/05/98 06/06/98 5680 41 II 998 351 -6669

40 (Sh 1439)Spl ~415325 01/05/98 06/06/98 27600 117 32860 1171 -6431

41 (St. I439)S[I2 ~ 176220 01/05/98 06/06/98 48480 81 29709 948 17823

42 (St. 1605)S[l2 L~ 960239 01105/98 06/06/98 75200 233 59872 2083 13 245

4] (St. 1635)S[II ~ 543301 01/05198 06/06/98 14040 56 12869 431 740

44 (St.JI3)SIII ~341108 01/0519806/06/98 24400 119 22761 917 722
4) (St. 267)5111 ~J 409791 01/05198 06/06198 29 R80 113 25291 I 054 ] 535
46 (St. 267)5[12 C?J 170706 01/05/98 06106/98 9660 34 9199 371 90
47 (SL (666)5(1 1 L?-: 544292 01/05/98 06/06/98 57720 149 38098 1 587 18035

I
I
I
I

101.11 1 325 303 4 824 1218204 41290 65809



- - _.. -- .. - - .. - - - •
20/0411998

Expected Revenue CalculatIon
01/03/1998 0110411998

~

~~~-- --- - ~- ~

otal Non Residential J 248600 6215000 000 000 000 6215000 6215000 1035833 8

Comorale 248600 6215000 000 000 000 6215000 6215000 1035833 8 5

BWbpLWplluI 0 » 25 248600 6215000 000 000 000 6215000 6215000 1035833 9 5

[otal Residential J 1888800 40795600 000 000 000 40795600 40795600 67992 69 57 6

Residential 1888800 40795600 000 000 000 40795600 40795600 67992 69 57 6

PliwltP! o 100 15 4844 00 7266000 000 000 000 7266000 7266000 1211000 57 6

Pliw4lt! 100 250 22 526800 11589600 000 000 000 11589600 11589600 1931601 44 0

PliwltP! 250 » 25 877600 21940000 000 000 000 21940000 21940000 3656668 25 0

Total 2137400 47010600 000 000 000 47010600 47010600 78351 02 65 II



08/0911998 FmanClal Act Report

lflthlJwfi
01/08/1998 3110811998

~fr:;i(~,:J~~'fl~IJI'31E1~~r__I~~ml~~Wh-~",~'11- Rekre~(
Common Area 47367500 18947

I

-

105501/000 tl}nulI\ PWIJIl 85

2 105503/000 "lnulI\ ~wljnpJwli I

3 105504/000 "lnulI\ ~w1j4 4nul

4 105505/000 tl}nulI\ 411UllUlWU 1

5 105506/000 tl}nulI\ PW(lJl63 65 67

6 105507/000 "lnulI\ O(lJlb1J118

7 105509/000 tl}nuUj O(lphllt 33

8 105511/000 tl}l1uul4nupUlwu 8

9 105512/000 tl}nulI\ PW(lPJIIlU 7 9

10 105513/000 tl}nuUj 'l-lIlu51 53 .ebn58

II 1055) 4/000 tl}nulI\ ~wljnPJwli 7 9 II

12 105515/000 tl}nuul 'l-lIluwli 5 I

13 105551/000 "lIlUlI\ Q.JlIllPh4Jwli 40

14 1055521000 "lnulI\ Q.JlIllPb4Jwli 38w

15 105553/000 "lnulI\ IuWlWUl(lJwli 10

16 350945/000 4phJwli 321J1~Ul

17 355000/000 4phlJwli 2 tll~Ul

18 3)7441/000 4phlJwli 4/311t~Ul

19 3)7640/000 411hlJwli 4/211t~Ul

20 516284/000 ~wljnpJwli 11Il~Ul 5u

21 )16286/000 ~wljnpJwli 11It~ 9u

22 516288/000 ~wljnPJwli I W:jJUl 7u

23 ) 17799/000 ~wljllPJwli 7 W~Ul

24 517940/000 PW(lPJnpu 6511t:j>Ul

25 518137/000 PW(lpJnllu 63 W~Ul

26 5183)9/000 'l-lIluwlip 53 W~Ul

27 )18438/000 .ehnlll 58 W~Ul

Corporate

28 007090/000 UtI}C "UU,",b.,

29 260400/000 U"lC "f!Ull.'l-UUUP..

30 260400/000 U"lC"f!Ull.'l-UUUP..

Re!,ular

PWIJIl85

"lnulI\ ~wljnpJwli I

~w1j4 4nu1

"lnulI\ 4nupUlwu I

tl}IIUlI\ 'l-lIlu51 53.ehn58

"lnuUj Oppb1J1 18

tl}IIUlI\ O(lphllt 18

tl}nulI\ 4nupUlwu 8

"lnUlI\ PW(lPJIIlU 7 9

tl}nulI\ 'l-lIlu5 I 53 .ebn58

tl}nulI\ ~wljnpJwli 7 9 II

tl}nulI\ 'l-nuIwli 5 I

Q.JlIllPh4Jwli 40

Q.JlIllPh4Jwli 38 W

IuWlWUlPJwli 10

4phlJwli 2

4fiUPSUU I 223748

4t>btl8U,", 24

4t>btl8U,", 24

~W2t\W(l4PUfuWL

~W2t\W(l4P UfuWl

~w2t\w(lljp UfuWl

~w2t\w(l1j11 UfuWl

~W2t\w(lljp ufuwl

~wlt\wpljpu/Uwl

~W2t\W(lljp ufuWl

~w2t\W(lljp ufuwl

~w2t\w(lljpu/UwL

~w2t\W(l4P ufuWl

~w2t\W(l4P ufuWL

~w2t\W(l4P UfuWL

~w2qwJl4P U/UWl

~w2t\WJl4P U/UWL

~w2t\WJl4P u/Uwl

~Wlt\WJl4P u/UWL

~W2t\WJl4P ufuwl

~wlljwJlljjlU/UWl

~w2qWJlljp ufuWl

~w2qWJl4P u/UwL

~w2tlwJl4P u/UwL

~w2ljW(l4P ufuWL

~w2ljW(l4P ufuwL

~wlqwJllip UfuWl

~w2qw(llijl UfuWl

~w2tlWJl4P UfuWL

~w2ljwJllip ufuwL

~W2ljW(l4P ufuWL

~w2t\WJl4P ufuwL

~w2qWJl9P u/UwL

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08198

04108/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

04/08/98

02/08/98

850000

725000

2250000

4500000

300000

2250000

2250000

350000

7 17500

45000 00

425000

4500000

2250000

2250000

4500000

500000

500000

IS 000 00

IS 000 00

1250000

1250000

1250000

1500000

1250000

1250000

IS 000 00

IS 000 00

4375000

000

2000000

2375000

153 ISO 00

340

290

900

1800

120

900

900

140

287

1800

170

1800

900

900

1800

200

200

600

600

500

SOD

500

600

SOD

SOD

600

600

1750

o
800

950

• 6344

~

14

11

~

10

11

1{)

)1)

8

R

7

9

5

8

10

9

(l

9

10

10

9

15

17

16

I
I
I
I
I

31 060202/000 U(lWpWUl Pwlillllig 5

32 3)3136/000 ~wJ(lwlI\hlllJwli 4pbllJwli 5 f!li 34

33 ))32311000 'l-wt\J1\llJwli 4IJhllJwli 5 Pli 84

34 353665/000 Oqw wlilllfin 4IJhtIJwli 15 Pli 5

35 511937/000 Oqw wlilllfin UlJwltwlil'n 3 f!fi 37

36 512307/000 UW(lquJwli 'l-lIluwfip 9U

37 512915/000 4wuJwli 4nUjllllwu 81lli IS

38 512923/000 f!nplipwPJwli 4nUjllllwu 8 Pli 23

39 512924/000 UlIWlIInliJwli 4nuplllwu 8 Pli 24

40 513671/000 U1t(llllvwli Iuw(lljnllJwli 20

FO~]~~~~~S~liltt~)ij

~w2qWJl4PUfuWL

~w2ljw(l4P ufuwL

l,w2ljw(lljp ufuwL

l,w2ljW(lqlJ ufuWL

~w2t\w(l4P ufuwL

~w2t\wJl4P uluwL

~w2qW(l4P ufuwL

~w2tlW(lldt ufuwL

~wlqwJl\U1 ufuwl

~w2qwplijlUfuWl

01/08/98

04/08/98

04/08/98

04/08/98

01108/98

02/08198

01108/98

01108/98

01108198

04/08/98

75000

4485000

4750000

1750000

260000

750000

370000

270000

1105000

IS 000 00

67057500

50

1794

1900

700

150

300

200

ISO

500

600

27041

11

14

14

14

15

7

14

14

14

13



•

I
I
I
I
I
I
I

rUW~l r lUW WIUllil uIgdillzauoil

4hbt]wu
III 09/0811998 09/09/1998 0910911 q<l

DescnpllOn t ) ;: ,"" ~'I' s;:
Qverplaned Losses If , ' f

r.." Kwh IC!:J
4)lbl)WG 408893 373290 0 00 35601 ~ -

lJwGwUJlUG UUJ!wm 42038 41094 1682 40 73R I R

Direct Customers 40150 1092 0 00 5868 (.j(

llijlUpWJ!JlUO ~lUutbm 41720 29535 1579 3& 10606 2'

').wllWI1JwU Uupwm 36120 26610 1445 4() 8065 22

lJJIlJlWlIJwG ~pwJP 46332 38504 1853 40 5975 L:' '1

Uw:j>wPJwG U 65420 61400 2617 40 1403 2 I

<:mjhwGGpuJwG Uznm 55039 44 783 2202 40 8055 I~ (

...wpntllJlllOJW GUllpntp 46471 38769 1859 40 5R43 12 h

BEST AVAILABLE COpy



1810619%

65809412901218204I 325 303 4 824

J unctIons implementatIon Report
tIhbqwu

111 01/05/1998 06/06/1998

Total

r:: _~~"~ll'iWMMlNoMFm!to ah'EEi$."_MJMl,IlBi.E$$rnM~":ht=:lL=-QiitflO"
I (St 332)Sp 1 ~ 844798 01/05/98 06/06/98 30720 125 28,229 I 166 1 325

2 (St 3'7)Sp I ~ 163925 01/05198 06/06/98 65600 220 57497 1565 6538

3 (St 342)Sp 1 ~ 307722 01/05198 06/06/98 40000 220 45982 1696 7678

4 (St 342)Sp2 ~ 548344 01/05/98 06/06/98 34000 155 30260 1 192 2548

5 (St 381)Sp I ~ 263221 01/05198 06/06/98 13560 67 12089 471 1000

6 (St 381)Sp2 ~ 553111 01/05/98 06/06/98 17160 42 17464 325 -629

7 (St 135)Sp 1 ~ 339516 01/05/98 06/06/98 9200 56 23 137 647 14584

8 (St 135)Sp2 ~ 316161 01/05/98 06/06/98 27800 85 18515 771 8514

9 (St 252)Sp1 ~ 164231 01/05/98 06/06/98 15540 47 14022 312 1206

10 (St 252)Sp 2 0863853 01/05/98 06/06/98 18,000 64 15625 503 1 872

11 (St 272)Sp I 0 168615 01/05198 06/06/98 42600 152 40058 1518 1024

12 (St 272)Sp2 ~ 301710 01/05/98 06/06/98 19,680 105 19039 745 104

13 (St 318)Sp1 ~ 310016 01/05/98 06/06/98 16800 76 15857 589 355

14 (St 318)Sp2 ~ 694600 01/05/98 06/06/98 21840 80 14845 554 6442

15 (St 385)Sp I 0 170709 01/05/98 06/06/98 45920 167 42105 I 560 2255

16 (St-428)Sp I ~ 314493 01/05/98 06/06/98 39400 146 35788 1327 2285

17 (St-461)Spl 0227457 01/05/98 06/06/98 59000 192 56963 1732 305

18 (Q.t-467)Sp2 0 01/05/98 06/06/98 6030 2 6030 0 0

19 (St-477)Sp 1 0301218 01/05/98 06/06/98 48000 198 40301 1493 6206

20 (St 583)Sp 1 0315363 01/05/98 06/06/98 17520 56 23600 614 -6694

21 (St-656)Spl 0676582 01/05/98 06/06/98 53000 257 57024 2167 -6191

22 (St 711)Sp I =:J 01/05/98 06/06/98 16920 55 16920 0 0

23 (St 715)Sp 1 0 493134 0 I/05/98 06106/98 55 600 190 39 305 I 483 14 813

24 (St 717)Sp I =:J 01/05/98 06/06/98 9420 44 9083 203 134

25 (St 788)Sp 1 r7] 640348 01/05198 06/06/98 46800 207 47247 1 969 2416

26 (St 854)Sp 1 0 542426 01/05/98 06/06/98 22440 78 17942 705 3793

27 (St 862)SII 1 ;:J 01/05/98 06/06/98 4540 5 4540 0 0

28 (St 862)Sp 2 0 01/05/98 06/06/98 2 173 2 2,173 0 0

29 (St 945)Sp I 0009452 01/05/98 06/06/98 29,160 86 27322 900 938

30 (St 945)SII 2 0025699 01/05/98 06/06/98 20400 53 25 196 577 5373

31 (St 989)Spl ~ 301493 01/05/98 06/06/98 10880 42 9838 410 632
32 (St 989)Sp 2 I~ 347115 01/05198 06/06/98 10560 41 9048 377 1 135

33 (St 1030)Sp I ~ 554724 01/05/98 06/06/98 37200 93 37512 683 995

34 (St 1030)Sp 2 ~ 544673 01/05/98 06/06/98 33960 114 24 139 836 8985

35 (St 1132)Sp I ~ 173629 01/05/98 06/06/98 14220 55 17106 558 3444

36 (St 1I32)Sp 2 0 179905 01/05/98 06/06/98 26 400 87 26 144 879 -623

37 (St 1165)Sp 1 0 140827 01/05/98 06/06/98 36,360 138 32324 1218 2818

38 (St 1265)Sp 1 0293138 01/05/98 06/06/98 14240 79 15278 634 I 672

39 (St 1265)Sp 2 0454212 01/05/98 06/06/98 5680 41 11 998 351 6669

40 (St 1439)Sp I ~415325 01/05/98 06/06/98 27600 117 32860 1171 -6431

41 (St 1439)Sp 2 17] 176220 01/05/98 06/06/98 48480 81 29709 948 17823

42 (St 1605)Sp 2 0960239 01/05/98 06106/98 75200 233 59872 2083 13245

43 (St 1635)Sp 1 ~ 543301 01/05/98 06/06/98 14040 56 12869 43 I 740

44 (St313)Sp1 0341108 01/05/98 06106/98 24400 119 22761 917 722

45 (St 267)Sp 1 ~ 409791 01/05198 06/06/98 29880 113 25291 1054 3535
46 (St 267)Sp 2 0170706 01/05/98 06/06/98 9660 34 9199 371 90
47 (St 1666)Sp 1 ~ 544292 01/05/98 06/06/98 57720 149 38098 1587 18035

I
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Delmquency by 08/09/1998

I
I
I
I
I
I
I
I
I
I
I
I

I 105502/000 II}nullI 'l-ntuwli I

2 516989/000 'l-nllIwli~ I 1,2u lJ1~Ul

3 007132/000-U/:;.J «Upwq» U UqwUlJwli

Subtotal

4516914/000 lIIiwgw4wuJwU PbLw

5 516920/000 ~wpn~PJnpliJwli d-bliJw?

6 516921/000 ~4w wlintli[!

7 516933/000 Y..w[lllwliJwli UPUlwt!wqll

8 516936/000 ~4w wlintli[J

9 516943/000 Ul:iJ~pubPJwli LJnJIupw

10 516950/000 Iuw~wUlPJwli Qwtuwp

11 516955/000 Ut!wqjwli n.w~p4

12516964/000 Oqwlibqnt!w UnliJw

13 516982/000 ~4w wlintlin

14 516986/000 £2nhpwPJwli UbpqhJ

'l-muwli I

4pbtlJwli 11

'1-nuiwli 1 Pli 14

'1-muwli 1 Pli 20

'l-muwli 1 Pli 21

'l-muwli I Pli 33

'l-muwli I Pli 36

'l-muwli I Pli 43

'l-nlliwli I Pli 50

'l-muwli I Pli 55

'l-muwli I Pli 64

'l-nllIwli I Pli 82

'l-muwli I Pli 86

34545000 03/07/98 29

486,50000 04/08/98 13

831,95000

26,73100 04/08/98 4

26,73100

12,88450 04/08/98 7

78020 04/08/98 4

3,32000 04/08/98 36

37,14100 04/08/98 12

24700 04/08/98 36

1,21580 04/08/98 24

106536 04/08198 3

1,51500 04/08/98 21

732540 04/08/98 3

2,83500 04/08198 4

25,96750 04/08/98 12

94,29676

952 977 7~



I
I Account No

I 105502/000 'l-nuiwu 1

I 2 516989/000

3 007132/000 4IJbl\JWu 11

4 516914/000 'l-muwu 1 PU 14

I
5 516920/000 'l-muwu 1 PU 20

6 516921/000 'l-muwu 1 PU 21

7 516933/000 'l-muwu I PU 33

8 516936/000 'l-muwu I PU 36

I 9 516943/000 'l-muwu I PU43

10 516950/000 'l-muwu 1 PU 50

11 516955/000 'l-muwu 1 Pli 55

12 516964/000 'l-muwli I PU 64

I n 516982/000 'l-muwu I PU 82

14 516986/000 'l-muwli I Pli 86

I
I
I
I
I
I
I
I
I
I
I
I
I

DIsconnectIOn LIst by 08/09/1998

104446

865424

660022

P3891107

fl7653360

P0224482

P2791175

U6312937

0661513

0189851

4130703

1806463

Jl4507492

1270010



99 S(lwliu:pn(luwu1n(l

Deser'::: , '<f II~I Penod I
31 1

31 J-----
31 1

31 I-----
31 I

31 I-----
31 I

31 I-----
31 I

31 I-----
31 I

31 I-----
31 1

31 I-----
31 I

31 1-----
31 I

31 1-----
31 1

31 1-----
31 1

31 1-----
31 1

31 1-----
31 1

31 1-----
31 1

31 I

__3 511413

__651141 6

__551141 5

_5_' .(,wli(lwJ~li 1

__751141 7

2 .(,wliIIWJ~li 2

08/09/1998

ICodell
__151141 1

I
I

I
I
I
I
I
I
I
I
I
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Account 516946/000

Regular

04/0711997 08/09/1998

'l-nulwli 1 Illi 46

I 1997 07 000 0 000 000 0 000 000

2 1997 08 000 151 232000 232000 0 000 000

3 1997 09 000 152 237040 237000 0 000 040

4 1997 10 040 182 330400 3304 00 0 000 040

5 1997 II 040 197 363400 363400 0 000 040

6 1997 12 040 107 191300 191300 0 000 040

7 199~ 01 040 173 3 10600 3 10600 0 000 040- ~ 199~ 02 040 147 253400 2,53400 0 000 040

9 1998 03 040 116 185200 185200 0 000 040

I 10 1998 04 040 170 304000 304000 0 000 040

II 1998 05 040 158 277600 277600 0 000 040

12 1998 06 040 171 306200 306200 0 000 040

I
13 1998 07 040 192 352400 352400 0 000 040

14 1998 08 040 178 321600 000 0 000 321640

Current Balance As orDate 04/08/98 321640

I
I
I
I
I
I
I
I
I
I
I ~

I
I ql



- - - - - - - - - - - - - - - - -
Summan balance 08/09/1998

5120811000 PWJlPJDlU 19 752550 31 3142 3235 \ 930 \39500 00 000 000 892050

512083/000 IlwJlPJDlu 25 000 31 1468 1620 \ 1520 264400 00 000 000 264400

5121091000 PWJlPJn~u~ 17 050 3\ \4408 14607 1 1990 367800 00 000 000 367850

5121101000 PWJlPJn~up 17 -437 SO 31 450 596 1 1460 25\200 00 000 000 207450

512111/000 l!wJlPJn~u 19 090 31 3623 3768 I 1450 249000 00 000 000 249090

512112/000 Ilw[lpJn)tu 19/U 265050 31 134 413 \ 2790 552500 00 000 000 8175501

n""'te·I1l"18h07""it"''':l'~1:.-;rl'''>r.'''''''t''-'i::15?r ",J IYf.)"'!i.~'"ll_7""""";'I~··11-'" • { I" T' ', ....oa ,~""' ... 'P"'",yp_~,.v""Koue ....-, -f .... ;llll ...~\Jll~\~';;~J ... l \ ~ 1//

~>, ~:';-t"';r""l~tJllame "'H~ "'l~I c::J1artLlJay I '?;,·4ii R!;!/QJn$ I • I ,I' Kwh ConsumtlOn I Act -II LPC i Tolal IU"dI S,g~'= I
~ • _." c I ,BalaD~. . Inmeter. . due

+ IPrevIous II Last I~ I K.... h /I AmOUDl ,'--- '--- _

I 5101141000 PWIIJ'Jlllull21 o~o 31 11901 12094 I 1910 354600 00 000 000 3546501 I
2 5120161000 l!wJlpJmuJl36 000 31 704 915 1 2110 394200 00 000 000 3942001 I
3 512018/000 PW[lPJn~u~ 26 0 SO 31 5234 5506 1 272 0 535000 00 000 000 5350 SOl I
4 512032/000 PWJlPJn~u/t 30 0 SO 31 4935 5290 I 3550 7425 00 00 000 000 7425 501 I
5 512034/000 PWJlpJOlu38U 000 62 1797 1805 I 80 12000 00 000 000 120001 I
6 512035/000 PW[lPJD~u/t36 000 31 5366 5749 I 3830 812500 00 000 000 8125001 I
7 512069/000 PWJlpJD/tu23 050 31 3766 3923 I 1570 275400 00 000 000 275450' ,

8 5120701000 PWJlPJDlU 23 2992 30 31 2861 3067 I 2060 3832 00 0 0 0 00 0 00 6824 30

9 5120771000 IlWJlpJD/tup36 1252900 3\ 218 514 I 2960 595000 00 000 000 18479001 I
10 512078/000 Ilw[lpJn/tu 26 0 SO 3\ 15020 15416 \ 3960 845000 00 000 000 8450501 I
II

12

13

14

15

\6
I I

\7 5121761000 l!wJlPJn~u 19 22500 31 8401 8624 I 2230 420600 00 000 000 4431001 1 _

Subtotal 2548870 37140 7194400 00 000 000 974327

Total 2548870 37140 7194400 00 000 000 974327

1
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Armeman BIlhng And CollectIOn Software Shdes

shde I-
• BIllmg System mam screen
• Batch processmg wmdow

shde 2-

• Enter readmgs
• BIll pnnt selectIOn

shde 3 --
• Sample bIll prmt preVIew
• Enter payments

shde 4--
• TarIffmamtenance
• Cycle/route mamtenance

shde 5 --
• JunctIOn Mamtenance
• Sample of context sensItIve report at a Junction level

shde 6--
• Accounts ReceIvable report
• DemonstratIOn of context sensItIve report functIOn

shde 7 --
• Meter replacement/adjustment data entry
• DemonstratIOn ofcontext sensItive reportmg

shde 8 --

• Context sensItIve Customer reports
• Account summary

shde 9--
• Context sensItIve Meter reports
• Meter Change Out

shde 10--

• Help screen
• Payment correctIOn

slIde 11 --

• Tree buIld - group JunctIOn
shde 12-

• Search screen
• Sample results of search



The ABACUS bdlmg system mam screen
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Sample Pnnt BIU prevIew

AdO:; 378tt7/'rIIltJ' lS:J8

1 0.0 100.0 0.0 U.oo 0.00

Por 1 dayc 0.0 0.00
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Vol: 0.00
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'Ino D_ It. -- UC
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Introduction

There are several major groups of operations the user of ABACUS can
accomplish, like

How to use this book

This book descnbes the major operations the user of ABACUS can
accomplish

• Create a database of all energy dlstnbutlon substations and transformers,
and customers for a gIven terntonal energy supplier,

• Add new substations, transformers, and customers, modify the eXisting
data on substations, transformers and customers,

• Create a vanety of reports,
• Maintain and update data logs and make calculations

About the Program
ABACUS IS a many-featured program for entering and maintaining current
and hlstoncal data on energy transformation and dlstnbutlon networks,
making calculatIons of the balance of meters and bills for customers, as well
as for creating a large vanety of reports reqUired by administrative,
accounting and technical departments, and by the MInistry of Energy

3

Descnbes how to work with various types of menus,
dialog boxes and windows, which are created In the
format of the standard Microsoft Windows applications
For more detailed InformatIon on these applications see
"Microsoft Windows Users' GUide"

Entering and Modifying Data descnbes how to enter
new components and their specifics, how to modify the
eXisting data or to delete unnecessary mformatlon

Browsing Data describes how to view the company
Information, I e information on your company's various
components

Maintaining and Updating Data Logs descnbes how to
maintain data logs and calculate vanous results, like new
meter data, customer bills and payment balance, as well
as how to maintain data logs on payments made on the
current date

Creating and Printing Reports describes to create
various types of reports reqUired by administrative,
accounting and technical departments, as well as by the
Ministry of Energy, and how to print them

Part IV

Part II

Part I

Part III

Appendices

I
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Instructions for a User A Primer
A variety of operations described In this book can be carned out with a mouse
or from the keyboard The following symbols will help you find InstructIOns you
need at a glance

Getting Help

To help you qUickly resolve problems and to answer your questions,
ABACUS provides on-line help that you can use from within ABACUS Simply
use one of the follOWing technrques

The follOWing list describes the Help commands provided by the program

The program's main menu appears on your screen

Double-click on the program Icon In Microsoft Windows Program
Manager

4

Function
Opens a window showing the table with all terms and

Position the tiP of the mouse pOinter over the specified
element, and then press and release the left mouse button
one time (Selecting windows, or Items In a list, selecting
dialog box options)
Position the tiP of the mouse pOinter over the specified
element, and then press and release the left mouse button
tWice In qUick succession (Executing applicatIOns, choosing
It~mc:: frnm ~ i1."t \

Command
Help Index

• Choose a command from the Help menu on the menu bar
• Press F1 while working within the program
• Choose the Help button In a dialog box

Starting the Program

To start ABACUS do this

To click

To double­
click

In addition, mouse users should know how to perform the following actions
(Typical uses for these actions are noted In parentheses)

D Instructions for mouse users

9 Instructions for keyboard usersI
I
I
I
I
I
I
I
I
I
I
I
I
I
I



concepts used In the program and allows you to get
help on any of them

Help Topic Opens a window showmg the table of contents for
tOPiCS concerning the selected Item

Search for Help On Opens a dialog box that allows you to type a subject
name for which the program displays a list of related
help tOPiCS

To eXit ABACUS, do the followmg

EXIting the Program

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

About Opens a window showing copynght Information for the
program

Click on Close symbol (Iii) on the upper nght corner of the screen

1 Choose EXit from the program's File menu The EXit dialog box
appears confirming that you want to eXit

2 Choose OK
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Part I Browsmg Data

If you are usmg the system for the first time (I e the system does not contain
any data) you need to skip this part and start with Part II (Entering and
Modifying Data) If your system already contains data you can browse
Information on various parts of the system by follOWing the below described
steps

Browsing Your Company's Structure The Company Tree

You can browse various types of Information on your company and the
components of your company by follOWing the steps described m the next
several sections

To browse Information on your company do the follOWingIi 1 Click on DataEntry In the main menu,
2 Click on Tree option In the DataEntry menu

1 Press Alt+D,
2 Press Alt+T

r::iF When Tree IS selected the Items of the mam menu on the top of
your screen change (besides thiS, the title bar - top dark bar of
the screen shows Frame - (TreeVlew) which means you are m
the mode of view of the company tree More In details about the
tree see the next sections) The menu now contains the
follOWing Items Elle, t;dlt, DataEntry, Reports, System, Window
and Help

In this mode the screen IS diVided Into the left part (tree field) and the right
part (data field)

Browsmg Information on Branch Offices

Inrtlally, the list of names of your company's branch offices with a g symbol
(branch office symbol) on the left Side of each name appears on the left part
of the screen below the menu (tree field)

The left Side of the screen has a form
of a tree Each of the branches of

the tree corresponds to one of your
company's branch offices

To select one of branch offices do the follOWing

Ii Click on the ft1. symbol of the corresponding branch office
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Use UpArrow (1') or DownArrow (-J.-) to select the desired branch
office and press Enter (~ )

When a branch office IS selected the fZ symbol on the left side of the branch

office's name changes to the i8 symbol

The right side of the screen (data field) below the menu contains the following
Information on the energy distribution branch office
• code of the distribution company
• name of the distribution company
• code of the branch office
• name of the branch office

1

1 Name of a branch office IS umque for the given dlstnbutlon company

The data field can be extended to show additional Information on the branch
office

To extend the data field do the follOWing

D Double-click on the data field

The follOWing additional information will be shown In the data field

• contact data on the branch office (director's name, address and phone
number of the office, etc)

• other Information (for Instance, number of transformer substations,
number of transformers, etc)

(ifj= To return to the prevIous condition double-click on the data field again

Browsmg Information on Transformer Substations of a Branch office

Each branch office serves several transformer substations This section
describes how to browse the list of transformer substations

To view the list of transformer substations of your branch office do the
follOWing

Double-click on the HI symbol on the left Side of the selected branch
office symbol (ttl)

Use UpArrow (1') or DownArrow (-J.-) to select the deSired branch
office and press Enter (~ )

The list of transformer substations appears on the screen The Ii symbol on
the left Side of the branch offices symbol changes Into the e symbol
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Note for the user To do the reverse action, I e to close the open list
of transformer substations double-click on the €I symbol on the left
side of the branch office's symbol

The tree expands to show the
following the list of the branch

offices and the list of transformer
substations of the selected branch

office

Similar to the name of the branch office, each of the transformer substation
symbols has a il symbol on the left side This shows that this transformer
substation serves several transformers the list of which can be viewed on the
screen (to browse the list of transformers see section Browsmg Information
on Transformers below)

To select one of transformer substations do the following

Click on the l. symbol of the corresponding transformer substation

Use UpArrow (1') or DownArrow (w) to select the desired transformer
substation and press Enter (fJ )

When a transformer substation IS selected the ~ symbol on the left side of

the transformer substation's name changes to the It symbol

The rrght side of the screen (data field) below the menu changes the
contents In addition to the Information on the selected branch office, now It
also contains the follOWing Information on the selected transformer
substation

• code of the transformer substation
For transformer substations the standard (default) transformer
substation code IS "TS" A user can define other types of transformer
substations If necessary (to define other types of transformer
substations see Part II, section Entermg and Modlfymg System
Data)

• name of the transformer substation1

• name of the responsible person
• status of the responsible person
• contract number for the responsible person
• date of the contract

i Name of each transformer substatIon IS unique for the given branch office
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Browsmg Information on Transformers
Each of the transformer substations serves several transformers This section
describes how to browse the list of transformers

To view the list of transformers of any of the transformer substations of your
branch office do the following

Double-click on the i1 symbol on the left side of the selected

transformer substation symbol (-&.)

Use UpArrow (1') or DownArrow (..v) to select the desired transformer
substation and press Enter (~)

The list of transformers served by the selected transformer substation
appears on the screen The msymbol on the left side of the transformer
substation symbol changes Into the a symbol (As It was noted above, you
can do the reverse action, I e close the open list by double-clicking on the e
symbol)

The tree expands to show the
following the list of the branch

offices, the list of transformer
substations and the list of

transformers of the selected
transformer substation

Each transformer name has a :WJ symbol (transformer symbol) on ItS left side

Similar to the branch office's symbol and transformer substation's symbol,
each transformer symbol has a 51 symbol on the left side This shows that this
transformers serves one of the follOWing group ,unctions of customers (to
browse the list of group Junctions of customers see section Browsmg
Information on Group Junctions of Customers) or IndiVidual customers (to
browse the list of IndiVIdual customers see section Browsmg Information on
IndiVidual Customers)

To select one of transformers do the follOWing

Click on the as symbol of the corresponding transformer substation

Use UpArrow (1') or DownArrow (-J...) to select the deSired transformer
and press Enter (~ )

When a transformer IS selected the msymbol on the left SIde of the
transformer's name changes to the ttl! symbol

The right Side of the screen (data field) below the menu changes the
contents In addition to the Information on the branch office and distributIon
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substation now It also contains the following Information on the selected
transformer

• Junction code
For transformers the standard (default) Junction code IS "TR" A user
can defme other types of transformers If necessary (to define other
types of transformers see Part II, section Entermg and Modlfymg
System Data)

• data on the transformer meter which consists of the following fields
o "meter" field senal (factory) number of the meter,
o "type" field type of the meter,

The type of the meter can be selected or changed from the
meter type drop-down list (to define or change types of
meters see Part II, section Entermg and Modlfymg System
Data)

o "location" field location of the meter refers to the location where
the meter IS Installed Location field can be one of the follOWing ­

1 Substation - this means the meter IS Installed In the
substation,

2 Safe Box - the meter IS mstalled In a metallic box,
3 Customer - the meter IS Installed at the apartment or office of

a customer
o "EDC's" field this field shows to whom the meter belongs If there IS

a check mark d~h m this field, the meter belongs to the energy
dlstnbutlon company,

o "digitS" field number of digitS of the meter,
o "multiplier" field some meters are Intended to meter big quantities

of energy To avoid the necessity of providing too many digitS In the
meter the latter IS deSigned to apply coefficients when Indicating
the quantity of the consumed energy MultIplier field Indicates the
value of the coefficient applied,

o "phase" field number of phases,
o "volts" field number of volts,
o "amps" field range of amperes,
o "Installed" field date of Installation of the meter,
o "last tested" field date of last testmg of the meter,
o "last read" field shows the date when the meter Indicator was last

read,
o "reading" field shows the last Indicated value of the meter

In some cases the right part of the screen (data field) shows data on
transformer customers For Instance for factory-type transformers thIs part
shows data on the customer (factory) which IS served by this particular
transformer (For more details on customer data see section Browsmg
Information on IndiVidual Customers)
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Browsmg Information on Group Junctions of Customers
A group Junction of customers IS a group of customers (mostly groups of
residents) served by the same energy supply cable For Instance, a group
Junction might Include residents of an entrance of a bUilding, residents of
several entrances, residents of a building or several bUildings, as well as
residents of bUildings on a particular street

Each of the transformers serves several group Junctions of customers Each
transformer might also serve several Individual customers ThiS section
descnbes how to browse the list of group Junctions and/or Individual
customers served by a particular transformer

To vIew the list of group Junctions or individual customers served by any of
the transformers do the follOWing

Double-click on the II symbol on the left Side of the selected
transformer symbol ('fl)

Use UpArrow (1') or DownArrow (..J...) to select the desired transformer
and press Enter (~)

The list of group Junctions and/or Individual customers appears on the
screen The m symbol on the left Side of the transformer symbol changes Into
the e symbol (As It was noted above, you can do the reverse action, I e
close the open list by double-clicking on the S symbol)

The tree expands to show the
follOWing the list of branch offices,
the list of transformer substations,

the list of transformers and the list of
group Junctions (and/or Individual

customers) of the selected
transformer

Each group Junction name has a as symbol (group JunctIon symbol) on ItS left
Side

Similar to the branch office, transformer substation, and transformer symbols,
each group Junction symbol has a eI symbol on the left Side ThiS shows that
a group Junction contains several Individual customers (to browse the list of
indiVidual customers see section Browsmg Information on IndiVidual
Customers)

To select one of group Junctions do the follOWing

II Click on the msymbol of the corresponding group Junction
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Use UpArrow (1') or DownArrow (-.I.-) to select the desired group
Junction and press Enter (~ )

When a group Junction IS selected the as symbol on the left side of the group

Junction's name changes to the U: symbol

The nght side of the screen (data field) below the menu changes the
contents In addition to the Information on branch offices, transformer
substations, and transformers, now It also contams the following information
on the selected group Junction

• Junction code
For transformer substations the standard (default) Junction code IS

"GJ" A user can define other types of group Junctions If necessary (to
define other types of group Junctions see Part II, section Entermg and
Modlfymg System Data)

• cycle/route
The cycle/route pair descnbes the schedule of Inspections of this
particular group Junction

• address
---In order-ro-provlde precise addressing for all Items the system provides

a many-component addressing Five of the SIX components used for
addressing a group Junction can be selected from drop-down menus
(More In details about the addressing see Part II, sections Entermg
and Modlfymg Company Data and Entermg and Modlfymg System
Data) The SIX components used for addressing of a group Junction
are

1 Marz name,
2 Commumty name,
3 Neighborhood name,
4 Street name,
5 BUilding number,
6 Entrance number

• data on the meter'

, For detailed mformatlon on meter data see section Browsmg Information on
Transformers

The bottom segment of the nght part of the screen (data field) Will also
contain the follOWing Information on the person responSible for thiS group
Junction of customers
• name of the responSible person
• type of the responSible person (for Instance "agenf')
• number of contract between the energy dlstnbutlon company and the

responSible person
• date of the contract
• other Information on the contract'
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1 This field IS not always seen on the screen To activate this field double-click on the lower
part of the screen To do the reverse action I e to recover the prevIous view double-click on
the field agam

Browsmg Information on Individual Customers
Each of the transformers or group junctrons serves several Individual
customers This section describes how to browse the list of individual
customers

To view the list of Individual customers of any of the transformers do the
followmg

Double-click on the :e symbol on the left side of the selected
transformer symbol (a)

Use UpArrow (1') or DownArrow (-J...) to select the desired transformer
and press Enter (~)

The list of group Junctions and Individual customers appears on the screen
The HI symbol on the left side of the transformer symbol or group Junction
symbol changes Into the l!l symbol (As It was noted above, you can do the
reverse action, I e close the open list by double-clicking on the S symbol)

To view the list of Individual customers of any of the group junctrons do the
following

Double-click on the S symbol on the left side of the selected group
Junction symbol (Q)

Use UpArrow (1') or DownArrow (-J...) to select the desired group
Junction and press Enter (~ )

The list of Individual customers appear on the screen Each individual
customer has a ~ symbol (mdlvldual customer symbol) on ItS left side

Individual customer symbols have no II symbol on the left side This shows
that mdlvldual customers are the lowest level of the tree ("leaves of the tree")

The tree expands to show the
following the Irst of branch offices,
the list of transformer substations,

the list of transformers, and the list of
Individual customers of the selected

transformer (If the Individual
customers are served directly by this

transformer) or the list of Individual
customers of the selected group

Junction (If the Individual customers
are served by a group Junction)
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To select one of Individual customers do the following

Click on the it symbol of the corresponding group Junction

Use UpArrow (1') or DownArrow (-J...) to select the desired Individual
customer and press Enter (+J )

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

When an Individual customer IS selected the t symbol on the left side of the

mdlvldual customer's name changes to the t'i symbol

The screen below the menu changes ItS format It now consists of tree parts
left (tree field), right (data field) and bottom (customer data field) to show
detailed mformatlon on the selected customer

The right side of the screen (data field) below the menu changes the
contents In addition to the Information on branch offices, transformer
substations, and transformers, now It also contains the followmg Information
on the Individual customer

• Junction code
For Individual customers the standard (default) Junction code IS "CU"
A user can define other types of Individual customers If necessary (to
defme other types of IndIVIdual customers see Part II, section Entermg
and Modlfymg System Data)

• cycle/route
The cycle/route pair describes the schedule of mspectlons of this
particular customer

• address
In order to provide precise addressing for all Items the system provides
a many-component addressing Five of the seven components used
for addressing of an IndiVidual customer can be selected from drop­
down menus (More In details about the addressmg see sections
Entering and Modlfymg Customer Data and Entermg and
Modlfymg System Data) The seven components used for addressing
of an Individual customer are

1 Marz name,
2 CommunIty name,
3 Neighborhood name,
4 Street name,
5 BUilding number,
6 Entrance number,
7 Apartment number

• data on the customers' meter1

, For detailed information on meter data see section Browsmg Information on
Transformers
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The bottom part of the screen (customer data field) will show the following
InformatIOn on the selected Individual customer

• number of the customer's Individual card (Account No )
• date of opemng of the customer's card (Account Opened)
• current balance as of the date (Current Balance)
• type of the customer

Type of the customer should be one of the following
o Regular - for residents,
o Corporate - for enterprises and orgamzatlons,
o Common Area - for consumers of common areas, these are

* service prOViders,
* users groups, check'"

o Subcustomer - for subcustomers
• name of the customer

Based on the type of the customer the name can be either a name of a
person or a name of an enterprise or orgamzatlon

• telephone number of the customer
• billing address

Billing address IS the address to which the payment bills are being
sent Sometimes the address of the meter and the address of the
customer are different (for Instance, a customer paying for energy
supply of a studio space lives at a different address)

The customer data field can be extended to show additional Information on
the branch office

To extend the customer data field do the following

Ii Double-click on the customer data field

r:iF To return to the prevIous condition double-click on the customer data
field again

The following additional Information will be shown In the customer data field

• tarrff category
ThiS field shows to which tarrff category thiS particular customer
belongs

• discount category
ThiS field shows If the customer belongs to any of the SOCial groups
eligible for discounts

• late payment charge status
ThiS field shows If the customer IS subject to payment of fines for
delinquency
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• grace penod
This field shows the length of the penod dunng which a delinquent
customer will not be subject to payment of fines

• VAT exemption
This field shows If the customer has a Value Added Tax exempt status

• responsible for losses
This field shows If the customer will be responsible for Inevitable
losses

• status of the customer
Status of the customers can be active or disconnected (terminated) If

there IS a check mark d~f) In this field, the customer's status IS active

Browsing Your Company's Structure QUick View

The prevIous sections descnbed how to get Information on your company's
vanous components dlstnbutlon substations, transformer substations,
transformers, group Junctions, and Individual customers Getting Information
on each of these components requires to follow certain steps descnbed
above After each step the company tree expands to show the sub­
components (a lower level of the tree)

However, besides the above descnbed procedures, which provide for step­
by-step expansion of the company tree, the system also provides for qUick
View, Ie, complete expansion of the tree to show all ItS components

To qUickly expand the tree to show all sub-components do one of the
followmg actionsIi 1 Select DataEntry option from the main menu,

2 Select Tree option from the DataEntry menu,
3 Select Edit option from the Tree menu,
4 Click on Expand option of Edit menu,

or

Click on the l.:!:.I button on the lower left corner of the screen

The tree expands to show all elements of the system The 51 symbols on the
left side of branch offices, transformer substations, transformers and group
Junctions symbols change Into the a symbols

The ~ symbol on the left side of the selected branch office's name changes
to the d symbol

The nght side of the screen (data field) below the menu contains the followmg
mformatlon on the energy dlstnbutlon branch office
• code of the dlstnbutlon company
• name of the dlstnbutlon company
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• code of the branch office
• name of the branch office

To do the reverse action, I e to recover the prevIous condition of the tree do
the following

II Click on the 1-=.1 button on the lower left corner of the screen

Browsing Your Company's Components QUick Search

The system provides qUick search of any of the components of the company's
tree by uSing the option called qUick search based on certain cntena The
follOWing cntena can be used for qUick search customer, group Junction, and
so on

To start qUick search do the follOWing

II Click on the Jil button on the lower left corner of the screen

A text box Will appear on the screen asking you to enter the cntenon for
search Enter the cntenon Into the text box and press Enter

The system Will find the corresponding Item (component) check'"
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Part II Entermg and Modlfymg Data

There are two major categories of data you need to have In the system to be
able to use It These categones are

1 Company data, I e data on branch offices, transformer
substations, transformers, group Junctions, customers,
meters, losses, responsible persons of your company,

2 System data, I e rates, tariffs, discount categories,
value added tax data, and others (Values of these
parameters may be established or changed by special
government or municipal regulations)

Entermg and Modlfymg Company Data

Company data IS a major group of data which consists of the following
elements required for the system

• Data on the distribution company
code and name of the company

• Data on branch offices
codes and names of branch offices

• Data on transformer substations
codes and names of transformer substatIons, as well as names,
status, contract numbers and contract dates of agents,

• Data on transformers
codes and names of transformers, data on transformer meters

• Data on group Junctions
codes and names of group Junctions, cycles/routs of inspections,
addresses, data on meters

• Data on customers
data on indIVIdual and consolidated customers

• Data on meters
fields of the meters number, date of installatIon, type, and so on

• Data on losses
data on sIde losses of the company

• Data on responsible persons
name, contract number and other informatIon of the person
responsIble for energy dlstnbutlon

c:1i'= To enter or modify company data, I e any of the components of
data on your company you need to activate the corresponding
component For Instance, If there IS need to change or remove
one of the transformer codes this transformer should be
activated (selected) first More 111 details on this operations see
In the next sections

To start entering new company data or modifying the eXisting company data
do the followll1g
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1 Click on DataEntry In the main menu,
2 Click on Tree option In the DataEntry menu

1 Press Alt+D,
2 Press Alt+T

(iF When Tree IS selected the Items of the main menu on the top of
your screen change (besides thiS, the title bar - top dark bar of
the screen shows Frame - (TreeVlew) which means you are In
the mode of view of the company tree More In details about the
tree see the next sections) The menu now contains the
following Items Elle, Edit, DataEntry, Reports, futstem, Window
and Help

In this mode the screen IS divided Into the left part (tree field) and the nght
part (data field)

(iF More In details about the company tree see Part I, Browsmg Data

Entermg and Modlfymg Data on Branch offices
To enter a new branch office, to modify data on any of the eXisting branch
offices, or to remove an eXisting branch office, do the following

1 Click on the te symbol of any of branch offices When a branch
office IS selected the symbol on the left side of the branch office's

name changes to the It! symbol
2 Click on Edit of the Tree menu The Edit menu offers several

options
3 Click on Item option of the Edit menu

1 Use UpArrow (1') or DownArrow (.J,.) to select a branch office and
press Enter (f.l) When a branch office IS selected the It symbol

on the left side of the branch office's name changes to the d
symbol

2 Press Alt+E
3 Use UpArrow (1') or DownArrow (w) to select Item option and

press Enter (~ )

The Item submenu has a .. on Its nght side which means It offers several
options you can select from These options will be seen on the screen when
Item IS selected

The available actions are
New Item - adding a new branch office,

19
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Click on New Item option of the Item submenu

1 New Item To add a new branch office do the follOWing

adding a new transformer substation In the selected
branch office ("subltem" IS an Item of a lower level on the
tree, for Instance, for the selected branch office a new
transformer substation will be a subltem),
modifying the eXisting mformatlon on the selected branch
office, and
deletmg the selected branch office

Use UpArrow (1') or DownArrow (-.It) to select New Item option of the
Item submenu and press Enter (fJ )

Use Tab key to sWitch from one text box to another and type the
Information

New Subltem -

Modify -

Delete -

CiF The follOWing requirements eXist for the above mentioned data fields
* The name and the code of the branch office cannot be omitted
* The name of each branch office should umque for the given

dlstrrbutlon company

More In details these actions are descrrbed below m thiS section After you
have selected one of the actions you can enter or modify Information In text
boxes on the rrght side of the screen (data field)

Enter Information on your energy dlstrrbutlon branch office Into the follOWing
text boxes on the rrght Side of the screen (data field)

A new element - a branch office - with the name New and without the branch
office symbol appears on the tree The tree becomes Inactive and the rrght
Side of the screen (data field) enters Into edltmg mode

The data field can be extended to show additional Information on the branch
office

To expand the data field do the follOWing

II Double-click on the data field

CiF To return to the prevIous condition double-click on the data field again

• code of the dlstrrbutlon company
• name of the dlstrrbutlon company
• code of the branch office
• name of the branch office1.1 Click on the corresponding text box and type the Information

II

I
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The following additional text boxes will be shown In the data field

• contact data on the branch office (director's name, address and phone
number of the office, etc)

• other Information (number of transformer substations, number of
transformers, etc)

2 New Subltem To add a new transformer substation to the selected branch
office do the following

21

Use UpArrow (1') or DownArrow (~) to select New Subltem op!lon of
the Item submenu and press Enter (f-l)

Click on New Subltem option of the Item submenu

Click on Modify option of the Item submenu

Click on the corresponding text box and type the Information

Use UpArrow (1') or DownArrow (~) to select Delete of the Item
submenu and press Enter (f-l )

Click on Delete of the Item submenu

Use UpArrow (1') or DownArrow (~) to select Modify option of the
Item submenu and press Enter (f-l)

Use Tab key to sWitch from one text box to another and type the
Information

More In details on entenng Information on a new transformer substation see
next section - Entermg and Modlfymg Data on Transformer Substations
on page 23

3 Modify To start modifying data on the selected branch office do the
following

A new element - a transformer substation - with the name New and without
the transformer substation symbol appears on the tree The tree becomes
inactive and the nght side of the screen (data field) enters Into editing mode

4 Delete If necessary you can remove any of the eXisting branch offices To
remove (delete) the selected branch office do the follOWing

The tree becomes Inactive, the nght side of the screen (data field) enters Into
editing mode, and you can modify data In any of the text boxes

I
I
I
I
I
I
I
I
I
I
I
I
I
I



I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

To save the entered Information do the following

Ii Click on the Save button

fI Press Enter (fJ )

If the entered data format does not correspond to the reqUIrements of the
system a message will appear on the screen and the system Will not allow to
continue work until data IS corrected to satisfy the requirements

To cancel changes and to return to the prevIous screen Without save do the
follOWing

Ii Click on the Cancel button

n Press Esc

Entermg and Modlfymg Data on Transformer Substations

To enter a new transformer substation, to modify data on any of the eXisting
transformer substations, or to remove an eXisting transformer substation, do
the follOWing

1 Click on the A symbol of any of transformer substations When a
transformer substation IS selected the symbol on the left Side of

the transformer substation's name changes to the !l symbol
2 Click on Edit of the Tree menu The Edit menu offers several

options
3 Click on Item option of the Edit menu

1 Use UpArrow (1') or DownArrow (-.1.-) to select a transformer
substation and press Enter (fJ) When a transformer substation IS
selected the ~ symbol on the left Side of the transformer

substation's name changes to the lb. symbol
2 Press Alt+E
3 Use UpArrow (1') or DownArrow (-.1.-) to select Item option and

press Enter (fJ )

The Item submenu has a .. on ItS right Side which means It offers several
options you can select from These options Will be seen on the screen when
Item IS selected

The available actions are
New Item - adding a new transformer substation,
New Subltem - adding a new subltem ("subItem" IS an Item of a lower

level on the tree, for Instance, for the selected
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Click on New Item option of the Item submenu

1 New Item To add a new transformer substation do the following

Use UpArrow (1') or DownArrow (~) to select New Item option of the
Item submenu and press Enter (~ )

transformer substation a new transformer will be a
subltem),
modifying the eXisting Information on the selected
transformer substation, and
deleting the selected transformer substation

Modify -

Delete -

A new element - a transformer substation - With the name New and Without
the transformer substation symbol appears on the tree The tree becomes
Inactive and the nght side of the screen (data field) enters Into editing mode

• code of the transformer substation
For transformer substations the standard (default) transformer
substation code IS "TS" A user can define other types of transformer
substations If necessary
To define other types of the transformer substations do the followingD Click on the downward arrow on the nght ~,I,~e, of the

Transformer Substation drop-down list (irs f3)

More In details these actions are descnbed below In this section After you
have selected one of the actions you can enter or modify Information In text
boxes on the nght side of the screen (data field)

Enter information on the new transformer substation Into the following text
boxes on the nght side of the screen (data field)

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
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I

The drop-down list will expand to show more optIons for the
transformer substation code
If the list does not contain the desired code, you can define new codes
of transformer substations To define a new type of transformer
substations see section"Entering and Modlfymg System data"

• name of the transformer substation
• name of the responsible person
• status of the responsible person
• number of the contract of the responsible person
• date of the contract of the responsible person

Click on the corresponding text box and type the Information

Use Tab key to sWitch from one text box to another and type the
Information
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r::iF The following requirements eXist for the above mentioned data fields
* The name and the code of the transformer substation cannot be

omitted
* The name of each transformer substation should umque for the

given branch office

2 New Subltem To add a new transformer In the selected transformer
substation do the following

To save the entered Information do the following

3 Modify To start modifying data on the selected transformer substation do
the following

Click on New Subltem option of the Item submenu

Use UpArrow (1') or DownArrow (w) to select New Subltem option of
the Item submenu and press Enter (f-I )

Click on Modify option of the Item submenu

Use UpArrow (1') or DownArrow (w) to select Modify option of the
Item submenu and press Enter (f-I )

Click on Delete of the Item submenu

Use UpArrow (1') or DownArrow (.J..-) to select Delete of the Item
submenu and press Enter (~ )

A new element - a transformer - with the name New and without the
transformer symbol appears on the tree The tree becomes Inactive and the
rrght side of the screen (data field) enters Into editing mode

More In details on enterrng Information on a new transformer see next section
- Entermg and Modlfymg Data on Transformers

The tree becomes Inactive, the rrght side of the screen (data field) enters Into
editing mode, and you can modify any data In text boxes

4 Delete If necessary you can remove any of the eXisting transformer
substations To remove (delete) the selected transformer substation do the
following

Ii Click on the Save button

til Press Enter (~ )

I
I
I
I
I
I
I
I
I
I
I
I

•

I
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If the entered data format does not correspond to the requirements of the
system a message will appear on the screen and the system will not allow to
continue work until data IS corrected to satisfy the requirements

To cancel changes and to return to the prevIous screen without save do the
following

1m Click on the Cancel button

m Press Esc

Entering and Modlfymg Data on Transformers
To enter a new transformer, to modify data on any of the eXisting transformer,
or to remove an eXisting transformer, do the following

1 Click on the iii symbol of any of transformers When a transformer
IS selected the symbol on the left side of the transformer's name
changes to the 1m symbol

2 Click on Edit of the Tree menu The Edit menu offers several
options

3 Click on Item option of the Edit menu

Use UpArrow (1') or DownArrow--{W) to select a transformer and
press Enter (f-l) When a transformer substation IS selected the ~
symbol on the left side of the transformer substation's name
changes to the ft symbol

2 Press Alt+E
3 Use UpArrow (1') or DownArrow (w) to select Item option and

press Enter (f-l )

The Item submenu has a .. on Its right side which means It offers several
options you can select from These options will be seen on the screen when
Item IS selected

The available actions are
New Item - adding a new transformer substation,
New Subltem - adding a new subltem, ("subltem" IS an Item of a lower

level on the tree, for Instance, for the selected
transformer a new group Junction will be a subltem),

Modify - modlfymg the eXisting mformatlon on the selected
transformer, and

Delete - deleting the selected transformer

More In details these actions are described below In this section After you
have selected one of the actions you can enter or modify Information In text
boxes on the nght side of the screen (data field)
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1 New Item To add a new transformer do the following

Click on New Item option of the Item submenu

Use UpArrow (1') or DownArrow (w) to select New Item option of the
Item submenu and press Enter (fJ )

A new element - a transformer - with the name New and without the
transformer symbol appears on the tree The tree becomes Inactive and the
nght side of the screen (data field) enters Into editing mode

Enter Information on the new transformer Into the following text boxes on the
nght side of the screen (data field)

• Junction code
For transformers the standard (default) Junction code IS "TR" A user
can define other types of transformers If necessary
To define other types of the transformers do the following
I; Click on the downward arrow on the nght side of the

Transformers drop-down list (11RJ3)

The drop-down list will expand to show more options for the
transformer code
If the list does not contain the desired code, you can define new codes
of transformers To define a new type of transformers see section
Entermg and Modlfymg System data

• data on the transformer meter

* More In details on the meters see section Entermg and Modlfymg Data on Meters

@=' The follOWing requirements eXist for the above mentioned data fields
* The name and the code of a transformer cannot be omitted
* The name of each transformer should be unrque for the given

transformer substation

2 New Subltem To add a new group Junction In the selected transformer do
the follOWing

Click on New Subltem option of the Item submenu

Use UpArrow (1') or DownArrow (.J...) to select New Subltern option of
the Item submenu and press Enter (~ )

A new element - a group Junction - WIth the name New and Without the--9foup
Junction symbol appears on the tree The tree becomes inactive and the right
Side of the screen (data field) enters Into editing mode
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More In details on entering Information on a new group Junction see next
section - Entermg and Modlfymg Data on Group JunctIOns

3 Modify To start modifying data on the selected transformer do the
following

Click on Modify option of the Item submenu

Use UpArrow (1') or DownArrow (..v) to select Modify option of the
Item submenu and press Enter (f-l )

The tree becomes Inactive, the right side of the screen (data field) enters Into
editing mode, and you can modify any data In text boxes

4 Delete If necessary you can remove any of the eXisting transformers To
remove (delete) the selected transformer do the follOWing

Click on Delete of the Item submenu

Use UpArrow (1') or DownArrow (..v) to select Delete of the Item
submenu and press Enter (f-l )

I
I

I
I
I
I
I
I
I

To save the entered Information do the follOWing

Ii Click on the Save button

EtI Press Enter (f-l )

If the entered data format does not correspond to the reqUirements of the
system a message Will appear on the screen and the system Will not allow to
continue work until data IS corrected to satisfy the requirements

To cancel changes and to return to the prevIous screen without save do the
following

_ Click on the Cancel button

fj; Press Esc

Entermg and Modlfymg Data on Group JunctIons
To enter a new group Junction, to modify data on any of the eXisting group
Junction, or to remove an eXisting group Junction, do the follOWing

1 Click on the II symbol of any of group Junctions When a group
Junction IS selected the symbol on the left Side of the group

Junction's name changes to the ~ symbol
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2 Click on Edit of the Tree menu The Edit menu offers several
options

3 Click on Item option of the Edit menu

1 Use UpArrow (1') or DownArrow (-.It) to select a group Junction and
press Enter (fJ) When a group Junction IS selected the msymbol
on the left Side of the group Junction's name changes to the ~
symbol

2 Press AIt+E
3 Use UpArrow (1') or DownArrow (-.It) to select Item option and

press Enter (fJ )

The Item submenu has a ., on ItS right Side which means It offers several
options you can select from These options Will be seen on the screen when
Item IS selected

The available actions are
New Item - adding a new group Junction,
New Subltem - adding a new subltem, ("subltem" IS an Item of a lower

level on the tree, for Instance, for the selected group
Junction a new customer Will be a subltem),

Modify - modifying the eXisting Information on the selected group
JunctIOn, and

Delete - deleting the selected group Junction

More In details these actions are described below In this section After you
have selected one of the actions you can enter or modify mformatlon In text
boxes on the right Side of the screen (data field)

1 New Item To add a new group Junction do the follOWing

Click on New Item option of the Item submenu

Use UpArrow (1') or DownArrow (-.It) to select New Item option of the
Item submenu and press Enter (fJ )

The Select Junction Type option button box appears on the screen It offers
three options

o Customer
o Group Junction
o Vacant

The default option for thiS box 15 Customer
Select a) Group JunctIon or b) Vacant option from the option button box

a) Group Junction
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Use Tab key to move the darkened circle to the Group Junction
option Press Enter (~)

I
I
I
I
I
I
I
I
I
I
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To select Group Junction option button do the followingIi Click on the Group Junctron option Click OK

II
A new element - a group Junction - with the name New and without the group
Junction's symbol appears on the tree The tree becomes Inactrve and the
nght side of the screen (data field) enters Into edltrng mode

Enter Information on the new group Junction Into the following text boxes on
the right side of the screen (data field)

• Junction code
For group junctrons the standard (default) Junction code IS "GJ" A user
can define other types of group Junctions If necessary

To define other types of the group Junctions do the followingIi Click on the downward arrow on the right side of the Group

Junction drop-down list (Rii)

The drop-down list will expand to show more options for the group
Junction code
If the list does not contain the desired code, you can define new codes
of group Junctions To define a new type of group Junction see section
Entermg and Modlfymg System data

• cycle/route
The cyclelroute pair descnbes the schedule of Inspections of this
particular group Junction

• address
In order to provide precise addressing for all Items the system provides
a many-component addressing Five of the SIX components used for
addressing a group Junction can be selected from drop-down menus
(More In details about the addressing see section Entering and
Modlfymg System Data) The SIX components used for addressing of
a group Junction are

1 Marz name,
2 Community name,
3 Neighborhood name,
4 Street name,
5 BUilding number,
6 Entrance number

The first five Items of an address (Marz, community, neighborhood,
street and bUilding) can be selected from the drop-down lists

To select the Marz name from the drop-down list do the followingIi Click on the downward arrow on the right side of the Marz
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* More m details on the meters see section Entermg and Modlfymg Data on Meters

ThiS field IS not always seen on the screen To activate thiS field double-click on the lower
free part of the screen a new field for other (additional) mformatlon fill appear and you can
enter any necessary data To do the reverse action I e to recover the prevIous view double­
click on the field agam

(iF The following requirements eXist for the above mentioned data fields
* The name and the code of a group Junction cannot be omitted
* The name of each group Junction should be umque for the given

transformer

"'''/*'*81)drop-down list ({~

The drop-down list will expand to show the names of Marz's In
Armema
If the list does not contain all the names of Armema's Marz's, you can
define new names To define a new Marz name see section Entermg
and Modlfymg Data on Location

Similarly, you can either select the community name, the neighborhood
name, the street name and the bUilding number from the "Community",
"Neighborhood", "Street" and "BUlldmg" drop-down lists uSing the same
procedure as descnbed for the Marz names, or to add new names for
these Items uSing the procedure descnbed In section Entermg and
Moddymg Data on Location

• data on the meter

b) Vacant
ThiS option IS used for creating a list customers who have many similar
characteristics, for Instance they are the residents of the same bUilding and
most of the addreSSing components are the same (Marz, commumty, street,
bUilding number) When uSing thiS option the common characteristics Will be
filled Into the corresponding fields automatically

The bottom segment of the nght part of the screen (data field) will also
contain the following Information on the person responsible for thiS group
Junction of customers
• name of the responsible person
• type of the responsible person (for Instance "agenf')
• number of contract between the energy dlstnbutlon company and the

responsible person
• date of the contract
• other Information on the contract

To select Vacant option button do the followmg1.1 1 Click on the Vacant option
2 Click on the small text box on the nght Side of the Vacant option

and enter the number of vacant Items you want to add

I
I
I
I
I
I
I
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I
I
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3 Click OK

1 Use Tab key or arrow keys to move the darkened circle to the
Vacant option

2 Use Tab key to move the cursor to the small text box on the right
side of the Vacant option and enter the number of vacant Items
you want to add

3 Press Enter (~)

A new element or elements (depending on the number you entered Into the
number text box) with the name Vacant and with the (check"') symbol
appears on the tree The tree becomes Inactive and the right side of the
screen (data field) enters Into editing mode

The vacant element(s) contains the same text boxes and the same data on
the right side of the screen (data field) as the transformer to which this
element(s) belongs

2 New Subltem To add a new Individual customer to the selected group
Junction do the following
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More In details on entering Information on a new customer see next section ­
Entermg and Modlfymg Data on Customers

3 Modify To start modifying data on the selected group Junction do the
follOWing

Click on New Subltem option of the Item submenu

Use UpArrow (1') or DownArrow (.J...) to select New Subltem option of
the Item submenu and press Enter (~ )

Click on Modify option of the Item submenu

Use UpArrow (1') or DownArrow (.J...) to select Modify option of the
Item submenu and press Enter (~ )

The Select Junction Type option button box appears on the screen Select
Customer option from the button box

A new element - an Individual customer - with the name New and without the
Individual customer symbol appears on the tree The tree becomes inactive
and the right side of the screen (data field) enters Into editing mode

To select Customer option do the following
I'] Click OK

M Press Enter (~)

I
I
I
I
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The tree becomes inactive, the nght side of the screen (data field) enters Into
editing mode, and you can modify any data In text boxes

4 Delete If necessary you can remove any of the eXisting group Junctions
To remove (delete) the selected group Junction do the follOWing

Click on Delete of the Item submenu

Use UpArrow (1') or DownArrow (~) to select Delete of the Item
submenu and press Enter (fJ)

To save the entered Information do the follOWing

IiJ Click on the Save button

n Press Enter (fJ )

If the entered data format does not correspond to the requirements of the
system a message Will appear on the screen and the system Will not allow to
continue work until data IS corrected to satisfy the reqUirements

To cancel changes and to return to the prevIous screen without save do the
follOWing

D Click on the Cancel button

n Press Esc

Entermg and Modlfymg Data on IndIVIdual Customers

To enter a new customer, to modify data on any of the eXisting customer, or
to remove an eXisting customer, do the follOWing

1 Click on the it symbol of any of Individual customers When a
customer IS selected the symbol on the left Side of the customer's
name changes to the t\ symbol

2 Click on Edit of the Tree menu The Edit menu offers several
options

3 Click on Item option of the Edit menu

1 Use UpArrow (1') or DownArrow (~) to select an Individual
customer and press Enter (fJ) When a customer IS selected the
.. symbol on the left Side of the customers name changes to the
(l symbol

2 Press AIt+E
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3 Use UpArrow (1') or DownArrow (..v) to select Item option and
press Enter (f-I )

The Item submenu has a .. on Its right side which means It offers several
options you can select from These options will be seen on the screen when
Item IS selected

The available actions are
New Item - adding a new customer,
New Subltem - adding a new subltem, ("subltem" IS an Item of a lower

level on the tree, for Instance, for the selected customer
either a users group or a service provlder* Will be a
subltem),

Modify - modifying the eXisting Information on the selected
customer, and

Delete - deleting the selected customer

* More In details on service providers see section Entermg and Modlfymg Data on SerVice
PrOViders

More In details these actions are described below In this section After you
have selected one of the actions you can enter or modify Information In text
boxes on the right Side of the screen (data field)

1 New Item To add a new customer do the follOWing

Click on New Item option of the Item submenu

Use UpArrow (1') or DownArrow (..v) to select New Item option of the
Item submenu and press Enter (f-I )

A new element - a customer - with the name New and without the customer's
symbol appears on the tree The tree becomes Inactive, and the screen IS
now diVided Into tree parts upper left (the tree), upper right and bottom The
upper right part and the bottom part of the screen (customer data fields) enter
Into editing mode

Enter Information on the new customer Into the following text boxes on the
upper right part

• Junction code
For customer the standard (default) Junction code IS "CU" A user can
define other types of customers If necessary
To define other types of customers do the follOWingD Click on the downward arrow on the right Side of the Junction

drop-down list (11!13)
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The drop-down list will expand to show more options for the customers
code
If the list does not contain the desired code, you can define new codes
of customers To define a new type of customers see section Entermg
and Modlfymg System data

• cycle/route
The cycle/route pair descnbes the schedule of Inspections for this
particular customer For a new customer default cycle/route IS

~ 1000 I
To define the cycle/route for the new customer do the following
~ Click on the Cycle/Route text box and type the Information

More In details on cycles/routes see section Entering and Modlfymg
System data

• address
In order to provide precise addressing for all Items the system provides
a many-component addressing Five of the seven components used
for addressing of an Individual customer can be selected from drop­
down menus (More In details about the addressing see section
Entermg and Modlfymg System Data) The seven components used
for addressing of an Individual customer are

1 Marz name,
To define the Marz name do the followingIi Click on the downward arrow on the nght side of the

Marz drop-down list (the first drop-down list In the
first row) The drop-down list will expand to show the
available names of Marzes
Click on the desired name of the Marz

If the desired name IS not available In the list you can add
the name as described In section Entermg and Modlfymg
System Data

2 Commumty name
To define the commumty name do the followingII Click on the downward arrow on the right side of the

Commumty drop-down list (the second drop-down
list In the first row) The drop-down list will expand to
show the available names of commumtles
Click on the desired name of the commumty

If the desIred name IS not available In the list you can add
the name as described In sectIon Entermg and Modlfymg
System Data

3 Neighborhood name
To define the neighborhood name do the follOWinga Click on the downward arrow on the right Side of the

Neighborhood drop-down list (the third drop-down
list In the first row) The drop-down list Will expand to
show the available names of neighborhoods
Click on the desired name of the commumty
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If the desired name IS not available In the list you can add
the name as descnbed In section Entermg and Modlfymg
System Data

4 Street name
To define the street name do the following
m Click on the downward arrow on the nght sIde of the
• Street drop-down list (the first drop-down list In the

second row) The drop-down list will expand to show
the available names of streets
Click on the desired name of the street

If the desired name IS not available In the list you can add
the name as descnbed In section Entermg and Modifymg
System Data

5 BUilding number
To define the bUilding number do the following1M Click on the downward arrow on the nght sIde of the

BUilding drop-down list (the second drop-down list In
the second row) The drop-down list will expand to
show the available numbers of bUildings
Click on the desired number of the bUilding

If the desired number IS not available In the list you can add
the number as descnbed In section Entermg and Modlfymg
System Data

6 Entrance number
To define the entrance number do the following1M Click on the Entr text box and type the number

7 Apartment number
To define the apartment number do the followingII Click on the Apt text box and type the number

The bottom part of the screen will show the following Information on the
selected Individual customer

• number of the customer's Individual card (Account No )
The default card number IS 000000
To define the card number for the new customer do the following1M Click on the Account No text box and type the number

• date of opening of the customer's individual card (Account Opened)
The default date of opening for the new customer IS 00/00/000
To define the date of openmg for the new customer do the
followmga Click on the Account Opened text box and type the date

• current balance as of the date
The default current balance of ayment for the new customer IS
roool as 00/00/0000
~of
To define the date for the new customer do the following
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D Click on the Current Balance text box and type the
Information

• type of the customer
To define the type for the new customer do the followingII Click on the downward arrow on the nght side of the Type

drop-down list The drop-down list will expand to show the
available types of customers

Type of the customer can be one of the following
o Regular - for residents,
o Corporate - for enterpnses and organizations,
o Common Area - for consumers of common areas (users

group)
o Subcustomer - for subcustomers

D Click on the desired type of the customer

@=' If the type of the customer IS Corporate or Subcustomer two
new text boxes appear on the left bottom part of the screen
Contact Person and Bank Account

• name of the customer
Based on the type of the customer the name can be either a name
of a person or a name of an enterpnse or organization
To enter the name of the customer do the follOWingIi Click on the Name text box and type the name

• telephone number of the customer
To enter the telephone number of the customer do the follOWingIi Click on the Telephone text box and type the number

• billing address
Billing address IS the address to which the payment bills are being
sent Sometimes the address of the meter and the address of the
customer are dIfferent (for Instance, a customer paying for energy
supply of a studio space lives at a different address)
To enter the billing address of the customer do the follOWing1.1 Click on the Billing Address text box and type the address

The customer data field can be extended to show additional Information on
the branch office

To extend the customer data field do the follOWing

Ii Double-click on the customer data field

@=' To return to the prevIous condition double-click on the customer data
field agaIn
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The following additional Information will be shown In the customer data field

• tariff category
This field shows to which tariff category this particular customer
belongs
To define the tariff category for the new customer do the followingIiJ Click on the downward arrow on the right Side of the Tariff

Category drop-down list The drop-down list Will expand to
show the available categories
Click on the desired category

If the desired tariff category IS not available In the list you can add
the category as described In section Entermg and Modlfymg
System Data

• discount category
This field shows If the customer belongs to any of the social
groups eligible for discounts The default discount category for a
new customer IS None
To define a new discount category for the new customer do the
follOWing
II] Click on the downward arrow on the right Side of the

Discount Category drop-down list The drop-down list Will
expand to show the available categories
Click on the deSired category

If the deSired discount category IS not avaIlable In the list you can
add the category as described In section Entermg and Modlfymg
System Data

• late payment charge status
This field shows If the customer IS SUbject to payment of fines for
delinquency
To define the late payment charge amount for the new customer do
the follOWingD Click on the Late Payment Charge text box and type the

Information
• grace period

This field shows the length of the period dunng which a delinquent
customer Will not be subject to payment of fines
To define the grace period for the new customer do the follOWingIiJ Click on the Grace Period text box and type the

Information
• VAT exemption

This field shows If the customer has a Value Added Tax exempt
status
To define a VAT exempt status for the new customer do the
follOWing
Ii] Click on the VAT Exemption check box A check mark

d~b Will appear In the box
• responSible for losses
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This field shows If the customer will be responsible for inevitable
losses
To define a responsible for losses status for the new customer do
the following
Ii] Click on the Responsible for losses (line-side) check

box A check mark (~) will appear In the box

• status of the customer
Status of the customers can be active or disconnected

(terminated) If there IS a check mark d~1) In this field, the
customer's status IS active
The default status for a new customer IS Active
To define a disconnected (terminated) status for the new customer
do the following
Ii] Click on the Status check box The check mark will

disappear

2 New Subltem To add a new subcustomer to the selected customer do the
following

Click on New Subltem option of the Item submenu

Use UpArrow (1') or DownArrow (..v) to select New Subltem option of
the Item submenu and press Enter (f-l)

I
I
I
I
I

A new element - a subcustomer - with the name New and without the
customer symbol appears on the tree The tree becomes Inactive and the
right side of the screen (data field) enters Into editing mode

(ifF Availability of a subcustomer for an individual customer
means that this customer pays for common area energy
consumption Checklll

Enter Information on the following text boxes on the bottom part of the screen

• number of the customer's Individual card (Account No )
The default card number IS 000000
To define the card number for the new customer do the followingB Click on the Account No text box and type the number

• date of opening of the customer's IndiVidual card (Account Opened)
The default date of opening for the new customer IS 00/00/000
To define the date of opening for the new customer do the
followingIi Click on the Account Opened text box and type the date

• current balance as of the date
The default current balance of ,8yment for the new customer IS
Ia 00 Ias I00/00/0000
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I lof I I
To define the date for the new customer do the followingIi Click on the Current Balance text box and type the

Information
• type of the customer

Type of the customer can be only Users Group
To enter the type of the customer do the followingII Click on the Type text box and type "Users Group"

• name of the customer
To enter the name of the customer do the followingII Click on the Name text box and type the name

• telephone number of the customer
To enter the telephone number of the customer do the followingII Click on the Telephone text box and type the number

• billing address
Billing address IS the address to which the payment bills are being
sent Sometimes the address of the meter and the address of the
customer are different (for Instance, a customer paying for energy
supply of a studio space lives at a different address)
To enter the billing address of the customer do the following1M Click on the Blllmg Address text box and type the address

• number of users of the common area
To define the number of users of the common area do the
followingIi Click on the Number of Users text box and type the

number
• status of the customer

Status of the customers can be active or disconnected

(terminated) If there IS a check mark (I~h In this field, the
customer's status IS active
The default status for a new customer IS Active
To define a disconnected (discontinued) status for the new
customer see next section - Workmg wIth Data on Customers

3 Modify To start modifying data on the selected group junction do the
followmg

Click on Modify option of the Item submenu

Use UpArrow (1') or DownArrow (...v) to select Modify option of the
Item submenu and press Enter (~)

The tree becomes Inactive, the right Side of the screen (data field) enters Into
editing mode, and you can modify any data In text boxes
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4 Delete If necessary you can remove any of the eXisting group Junctions
To remove (delete) the selected group Junction do the following

Click on Delete of the Item submenu

Use UpArrow (1') or DownArrow (-J...) to select Delete of the Item
submenu and press Enter (~)

To save the entered Information do the following

II Click on the Save button

n Press Enter (~ )

If the entered data format does not correspond to the requirements of the
system a message will appear on the screen and the system will not allow to
continue work until data IS corrected to satisfy the reqUirements

To cancel changes and to return to the prevIous screen without save do the
following

II Click on the Cancel button

ft Press Esc

Workmg with Data on Customers
There are several actIons you can perform with the data on Individual
customers To start working with customer data do the follOWing

1 Click on the it symbol of any of Individual customers When a
customer IS selected the symbol on the left Side of the customer's

name changes to the ~ symbol
2 Click on Edit of the Tree menu The Edit menu offers several

options
3 Click on Customer option of the Edit menu

1 Use UpArrow (1') or DownArrow (-J...) to select an Individual
customer and press Enter (~) When a customer IS selected the
tt symbol on the left Side of the customers name changes to the
(\ symbol

2 Press Alt+E
3 Use UpArrow (1') or DownArrow (""') to select Customer option

and press Enter (~ )
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Correction -

Disconnect -

Adjustment -

Click on Sill option of the Customer submenu

Click on Disconnect option of the Customer submenu

Use UpArrow (1') or DownArrow (w) to select Disconnect option of
the Customer submenu and press Enter (~)
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The Customer submenu has a " on Its right side which means It offers
several options you can select from These options will be seen on the screen
when Customer IS selected

Discontinue ­
Status ­
Sills/Payments -

The available actions are
Sill - prepanng the bill for the selected customer without

opening the corresponding data log (more In details
about the data logs see Part IV Maintaining and
Updating Data Logs)
disconnectIng the selected customer This action cannot
be accomplished with the Modify option In the Edit
menu
discontinUing the selected customer
getting a report on the selected customer's status
getting a report on the bills sent to the customer and
payments made by the customer
making corrections If errors have occurred In calculations
made In the Tree mode
making adjustments to the amounts not reflected In
calculated data checkll!

More In details these actions are descnbed below In this section

Use UpArrow (1') or DownArrow (w) to select Sill option of the
Customer submenu and press Enter (~ )

check'"

1 Sill To prepare the bill for the selected customer do the following

2 Disconnect To disconnect the selected customer from the system do the
following

When thiS option IS selected the Confirm Disconnect window appears on
the screen To confirm disconnection do the following

1.1 Click on the OK button

To cancel disconnection and to return to the prevIous screen do the following

1.1 Click on the Cancel button

I
I
I
I
I
I
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(jj= For the disconnected customer the Disconnect option In the submenu
becomes Connect You can connect the disconnected customer by
usmg the Connect option In this case Instead of the Confirm
Disconnect window the Confirm Connect window appears on the
screen

3 Discontinue To discontinue the selected customer do the following

Click on Discontinue option of the Customer submenu

Use UpArrow (1') or DownArrow (~) to select Discontinue option of
the Customer submenu and press Enter (f.l )

checklll

4 Status To get Information on the status of selected customer do the
following

Click on Status option of the Customer submenu

Use UpArrow (1') or DownArrow (~) to select Status option of the
Customer submenu and press Enter (f.l )

•
I

•

I
I
I
I
I

A status report on the selected customer will appear on the screen, showing
the name, type, address, phone number, current balance, tanff category,
discount category, late payment charge status, and other Information

To return to the prevIous screen do the following

Click on the OK button,
Click on the Close button

Press Enter (f.l )

5 Bills/Payments to get a report on the bills sent to the selected customer
and payments made by the customer do the follOWingB Click on BillS/Payments option of the Customer submenu

Use UpArrow (1') or DownArrow (-.1-) to select Bills/Payments option
of the Customer submenu and press Enter (~ )

The Bills and Payments window Will appear on the screen showing the bills
sent and payments made

To return to the prevIous screen do the follOWing
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Press Enter (f-l )

Press Enter (f-l )

Click on the Post button on the bottom of the screen,
Click on the Close button

Use UpArrow (1') or DownArrow (..J.-) to select Corrections option of
the Customer submenu and press Enter (f-l)

6 Corrections To make corrections In the calculations make In the Tree
mode do the followingIIJ Click on Corrections option of the Customer submenu

fJ

After the necessary data IS entered the Post button on the bottom of the
screen Will be activated and you can save the Information by dOing the
follOWing

The Payment Correction window will appear on the screen showing data for
the selected customer, the balance of payment, bills sent and prevIous
payments made

Click on the OK button, or
Click on the Close button

To make corrections click on the corresponding text boxes and make
corrections The follOWing Information should be entered Into the text boxes
on the lower part of the screen
• date of the document
• name of the document
• amount paid

7 Adjustments to make adjustments to the amounts not reflected In
calculated data do the follOWing

The procedure of entenng and saving the Information IS the same as for the
prevIous option - Corrections

The same Payment Correction window Will appear on the screen allowing to
make all necessary adjustments

To cancel changes and to return to the prevIous screen do the follOWing

Ii Click on the Cancel button

n Press Esc

I
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Entermg and Modlfymg Data on Service Providers
Service providers are enterpnses which provide services (for Instance,
communal) to a group of customers

To start entering data on new service providers or modifying the eXisting data
on service providers do the follOWing

1 Click on DataEntry In the main menu,
2 Click on Service Providers option In the DataEntry menu

1 Press Alt+D,???
2 Press Alt+C ???

Ci'=" When Service Providers IS selected the Items of the main
menu on the top of your screen change The menu now
contains the follOWing Items Elle, Edit, DataEntry, Reports,
.§ystem, Window and Help

In this mode the screen IS divided Into four sections
1 Responsible Consolidated Customers (Service Providers) - (upper left

section),
This section contams account numbers and names of responsible
consoltdated customers, and the number of subcustomers for each
responsible consoltdated customer

2 Responsible Consolidated Customer Information (upper right section),
This section shows detailed mformatlon on the selected responsible
consoltdated customer

4 Unbound Customers (lower right section)
These are subcustomers which are not assigned to any of the eXlstmg
responsible consolJdated customers

To enter a new service provider (responsible consolidated customer), to
modify data on any of the eXisting service provider, or to remove an eXisting
service provider, do the follOWing

3 Subcustomers of the selected Service Provider (lower left section),
This sectIon contams the account numbers and names of subcustomers of
the selected responsible consoltdated customer, as well as the number of
kwh's of energy consumed by the subcustomer for whIch the ServIce
Provider Will pay

I
I
I
I
I
I

I Click on Edit of the Service Providers menu

Press Alt+E
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The Edit submenu offers several actions you can select from These actions
are

Enter New­
Modify -

Delete -

adding a new service provider,
modifying the eXlstmg Information on the selected service
provider, and
deleting the selected service provider

I

I
I
I
I
I
I
I

r::iF To do any of these actions you need to select a service provider first

To select a service provider (responsible consolidated customer) do the
followmgIi Click on the desired responsible consolidated customer name

Ell Use UpArrow (1') or DownArrow (w) to select the desired
responsible consolidated customer

A little dark tnangle on the left side of this section shows the selected
consolidated subcustomer

More In details these actions are described below In this section

1 Enter New To add a new consolidated customer do the follOWing

Click on Enter New option of the Edit submenu

Use UpArrow (1') or DownArrow (w) to select Enter New option of
the Edit submenu and press Enter (~ )

An empty Ime appears over the selected responsible consolidated customer
line on the upper left Side of the screen, and the screen enters mto the editing
mode

Enter mformatlon on the new responsible consolidated customer mto the
following fields

a) Responsible Consolidated Customers (upper left Side of the screen)
o "Account number" by default the account number IS equal to 0,
o "Name",
o "Subcustomer" this field contains the number of subcustomers of

the selected responsible consolidated customer, by default It IS
equal to 0

b) Responsible Consolidated Customer Information (upper nght Side of
the screen)
o "Account number" by default It IS equal to 0,
o "Account opened" by default this date IS 0010010000,
o "Current balance" by default the balance IS 0,
o "as of' the date as of the balance was last specified, by default this

field IS 0010010000,
o "Type" of the customer
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2 Modify To start modifying data on the selected responsible consolidated
customer do the follOWing

Click on Modify option of the Edit submenu

Click on Delete of the Edit submenu

Use UpArrow (1') or DownArrow (.J...) to select Modify option of the
Edit submenu and press Enter (fJ )

Use UpArrow (1') or DownArrow (.J...) to select Delete of the Edit
submenu and press Enter (+J )

r:ifF The type of the consolidated customer IS Service
Provider and It cannot be modified

o "Name" of the consolidated customer,
o "Phone" number of the consolidated customer,
o "Address",

c) Subcustomers of the selected Service Provider (lower left side of the
screen)
o "Account" account number for a subcustomer of the newly entered

consolidated subcustomer
o "Subcustomers" names of subcustomers of the newly entered

consolidated subcustomer
o "Kwh" amount of energy consumed by the subcustomers for which

the new responsible consolidated customer will pay

d) Unbound Customers (lower left side of the screen)
To bound one or more of the unbound customers (I e customers which
are not attached to any of the responsIble consolidated customers) to
the newly entered responsible consolidated customer do the following
Ii] 1 Click on the desired unbound customer name to select It (If

you want to select several unbound customers press and
hold Shift key and click on the desired names
sequentlalIy)

2 Drag and drop the selected name(s) Into the Responsible
Customer window (upper left section of the screen)

A WIndow Will appear on the screen asking to confirm deleteIi Click on Yes button to confirm delete

3 Delete If necessary you can remove any of the eXisting responsible
consolidated customers To remove (delete) the selected consolidated
customer do the follOWing

Modify Information on the selected responsible consolidated customer In the
fields descrrbed In the section above (Enter New)

I
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Click on No button to reject delete
Press Y to confirm delete
Press N to reject delete

To save the entered Information do the following

Ii Click on the Save button

n Press Enter (~ )

If the entered data format does not correspond to the requirements of the
system a message will appear on the screen and the system will not allow to
continue work until data IS corrected to satisfy the requirements

To cancel changes and to return to the prevIous screen without save do the
fottowlng

Ii Click on the Cancel button

n Press Esc

Entermg and Modlfymg Consolidated Customer Data

Consolidated Customers are enterpnses which pay for energy consumed by
other organizations (For Instance, a central service provider organization
might pay for several subordinate service provider organizations)

To start entenng new consolidate customer data or modifying the eXisting
consolidate customer data do the following

1 Click on DataEntry In the main menu,
2 Click on Consolidated option In the DataEntry menu

1 Press Alt+D,
2 Press Alt+C

r::ifF' When Consolidated IS selected the Items of the main menu on
the top of your screen change The menu now contains the
following Items Elle EdIt, DataEntry, Reports, System Wmdow
and Help

In this mode the screen IS diVided Into four sections
1 Responsible Customers for Consolidated Billing (upper left section),

This section contams account numbers and names of consolidated
customers, and the number of subcustomers for each consolidated
customer

2 Customer Information (upper nght section),
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More In details these actions are descnbed below In this section
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1 Enter New To add a new consolidated customer do the following

addmg a new consolidated customer,
modlfymg the eXisting Information on the selected
consolidated customer, and
deleting the selected consolidated customer

Click on Edit of the Consolidated menu The Edit menu offers several
options
Press AIHE

To select a consolidated customer do the followingII Click on the desired consolidated customer name

II Use UpArrow (1') or DownArrow (...t.-) to select the desired
consolidated customer

(iF To do any of these actions you need to select a consolidated
customer first
To select a consolidated customer do the following

II Click on the desired consolidated customer name

~ Use UpArrow ("t) or DownArrow (...t.-) to select the desired
consolidated customer

A httle dark tnangle on the left side of this section shows the selected
consolidated subcustomer

ThIS sectIon shows detaIled mformatlon on the selected consoltdated
customer
A little dark tnangle on the left side of this section shows the selected
consolidated subcustomer

4 Unbound Customers (lower nght section)
These are subcustomers whIch are not assIgned to any of the eXlStmg
consoltdated customers

3 Consolidated Customers (lower left section),
ThIs sectIon contams the account numbers and names of subcustomers
for the selected consoltdated customer

To enter a new consolidated customer, to modify data on any of the eXlstmg
consolidated customer, or to remove an eXisting consolidated customer, do
the following

The Edit submenu offers several actions you can select from These actions
are

Enter New­
Modify -

Delete -
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Click on Enter New option of the Edit submenu

Use UpArrow (1') or DownArrow (..J...) to select Enter New option of
the Edit submenu and press Enter (fJ )

•
I

I
I
I
I
I
I
I

An empty line appears over the selected consolidated customer line on the
upper left side of the screen, and the upper left and nght sides of the screen
enter Into editing mode

Enter Information on the new consolidated customer Into the following fields
a) Responsible Customers for Consolidated billing (upper left side of

the screen)
o "Account number" by default the account number IS equal to a,
o "Name",
o "Subcustomer" this field contains the number of subcustomers of

the selected consolidated customer, by default It IS equal to a
b) Customer Information (upper nght side of the screen)

o "Account number" by default It IS equal to 0,
o "Account opened" by default this date IS 0010010000,
o "Current balance" by default the balance IS 0,
o "as of' the date as of the balance was last specified, by default this

field IS 00/00/0000,
o "Type" of the customer by default the type IS "Consolidated",

To define other types do the followingII Click on the downward arrow on the nght side of the type
drop-down list The drop-down list will expand to show the
list of the types of customers Click on the desired type

o "Name" of the consolidated customer,
o "Phone" number of the consolidated customer,
o "Billing address",
o "Contact person",
o "Bank account contains the name of the bank and the account

number
c) Consolidated Customers (lower left side of the screen)

o "Account" account number for a subcustomer of the newly entered
consolidated subcustomer

o "Subcustomers" names of subcustomers of the newly entered
consolidated subcustomer

checkl"

d) Unbound Customers (lower left side of the screen)
To bound one or more of the unbound customers (I e customers which
are not attached to any of the consolidated customers) to the newly
entered consolidated customer do the followingD 1 Click on the desired unbound customer name to select It (If

you want to select several unbound customers press and
hold Shift key and click on the desired names
sequentially)
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2 Drag and drop the selected name(s) Into the Responsible
Customer window (upper left section of the screen)

2 Modify To start modifying data on the selected consolidated customer do
the follOWing

Click on Modify option of the Edit submenu

Use UpArrow (1') or DownArrow (-J...) to select Modify option of the
Edit submenu and press Enter (f-l)

Modify Information on the selected consolidated customer In the fields
descrrbed In the section above (Enter New)

3 Delete If necessary you can remove any of the eXisting consolidated
customers To remove (delete) the selected consolidated customer do the
follOWing

Click on Delete of the Edit submenu

Use UpArrow (1') or DownArrow (-J...) to select Delete of the Edit
submenu and press Enter (f-l )

I

-
I
I
I
I
I
I

A window Will appear on the screen asking to confirm deleteIi Click on yes button to confirm delete
Click on No button to reject delete

1m'! Press Y to confirm delete
Press N to reject delete

To save the entered Information do the follOWing

Ii Click on the Save button

1m'! Press Enter (f-l )

If the entered data format does not correspond to the reqUirements of the
system a message Will appear on the screen and the system Will not allow to
continue work until data IS corrected to satIsfy the reqUirements

To cancel changes and to return to the prevIous screen without save do the
follOWing

Ii Click on the Cancel button

m Press Esc
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Entermg and Modlfymg Data on Meters
To change data on meters, to modify meter data, or to read meter data do the
following

1 Click on any of the elements of the system (starting with the
transformer level) for which you want to enter or modify data on
the meter

2 Click on Edit of the Tree menu The Edit menu offers several
options

3 Click on Meter option of the Edit menu

m 1 Use UpArrow (1') or DownArrow (w) to select any of the elements
of the system (starting with the transformer level1) for which you
want to enter or modify data on the meter and press Enter (f-')

2 Press Alt+E
3 Use UpArrow (1') or DownArrow (w) to select Meter option and

press Enter (f-' )
Data on meters IS available starting with transformers level for the higher levels the Meter

option IS not active

The Meter submenu has a ~ on Its nght side which means It offers several
options you can select from These options will be seen on the screen when
Meter IS selected

actions are
changing the meter
modifying data on the current meter
readings of the current meter

Use UpArrow (1') or DownArrow (w) to select Change option of the
Meter submenu and press Enter (f-')

Click on Change option of the Meter submenu
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The available
Change ­
Modify -
Meter Reading -

More In details these actions are descnbed below In this section After you
have selected one of the actions you can enter or modify Information In text
boxes on the nght side of the screen (data field)

The right Side of the screen (data field) enters Into editing mode

The data field Will contain the follOWing
1 Data on the old meter,
2 Date of changing the old meter
3 Reading of the old meter before the change

1 Change To change the meter do the follOWing

I
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4 Fields for the new meter (below the data on the old meter) Some of these
fields contain default data The user can change data In any of the fields
These fields are

o "meter number" field serial (factory) number of the meter,
o "type" field type of the meter,

To define other types of meters do the following
I.SJ Click on the downward arrow on the right side of the

meter type drop-down list The drop-down list will
expand to show more options for the types of meters
Click on the desired type

o "location" field location of the meter refers to the location where
the meter IS Installed Location field can be one of the following ­

1 Substation - this means the meter IS Installed In the
substation,

2 Safe Box - the meter IS Installed In a metallic box,
3 Customer - the meter IS Installed at the apartment or office of

a customer
o "EDC's" field this field shows to whom the meter belongs If there IS

a check mark d~h In this field, the meter belongs to the energy
dlstnbutlon company,

To put a check mark In this field do the followingIi Click on the field

o "digitS" field number of digitS of the meter,
o "multiplier" field some meters are Intended to meter big quantities

of energy To avoid the necessity of providing too many digitS In the
meter the latter IS designed to apply coefficients when Indicating
the quantity of the consumed energy Multiplier field indicates the
value of the coefficient applied,

o "phase" field number of phases,
o "volts" fIeld number of volts,
o "amps" field range of amperes,
o "Installed" field date of Installation of the meter,
o "last tested" field date of last testing of the meter,
o "last read" field shows the date when the meter Indicator was last

read,
o "reading" field shows the last Indicated value of the meter

To save the entered Information do the follOWing

6 Click on the Save button

III Press Enter (f-l )
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3 Meter Reading To read Information of the current meter do the following

To save the entered Information do the following

Click on Meter Reading option of the Meter submenu

Use UpArrow (1') or DownArrow (..J.-) to select ModIfy option of the
Meter submenu and press Enter (f-l)

Click on ModIfy option of the Meter submenu

Use UpArrow (1') or DownArrow (..J.-) to select Meter Reading option
of the Meter submenu and press Enter (f-l )

If the entered data format does not correspond to the requirements of the
system a message will appear on the screen and the system will not allow to
continue work until data IS corrected to satisfy the requirements

The right side of the screen (data field) enters Into editing mode and you can
modify the data on the meters

2 ModIfy To modify data on the current meter do the following

If the entered data format does not correspond to the requirements of the
system a message will appear on the screen and the system will not allow to
continue work until data IS corrected to satisfy the requirements

The Meter Readmgs window appears on the screen The window contains
the follOWing fields

To cancel changes and to return to the prevIous screen without save do the
following

II Click on the Cancel button

eTI'I Press Esc

To cancel changes and to return to the prevIous screen without save do the
following

Ii Click on the Cancel button

IJI Press Esc

Ii Click on the Save button

II Press Enter (f-l)
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o "Factory number" of the meter
o "Date" of reading,
o "Reading" of the meter
o "KW/H" - number of kilowatt/hours
o "Actual number"
o "Number of account"

To close the Meter Readings window do the following

III Click on the Close button

m Press Esc

Entermg and Modlfymg Data on Losses
Two types of losses may occur In a energy dlstnbutlon company
fixed amount of losses does not depend on the amount of the

consumed energy, and
vanable amount of losses IS proportionate to the amount of the

consumed energy
Dlstnbutlon companies currently use average values of losses defined by the
MInistry of Energy Part of the losses occur on the line side, and the other
part occurs on the load side
To enter data on losses for the dlstnbutlon company do the following
Ii] 1 Click on Edit of the Tree menu The Edit menu offers several

options
2 Click on Losses option of the Edit menu

1 Press Alt+E
2 Use UpArrow (1') or DownArrow (w) to select Losses option and

press Enter (fJ )

The nght side of the screen (data field) enters Into editing mode The data
field will contain the following fields on the energy dlstnbutlon losses
• Line-Side Losses Fixed and Vanable
• Load-Side Losses Fixed and Vanable

To save the entered Information do the following

IiJ Click on the Save button

it Press Enter (fJ )

To cancel changes and to return to the prevIous screen Without save do the
follOWing

Click on the Cancel button
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n Press Esc

Entermg and Modlfymg Data on Responsible Persons
Responsible persons of the dlstnbutlon company are responsible for
checking data of meters Installed on transformer substations, as well as
meters of customers

To enter Information or to modify the eXisting Information on a responsible
person do the followmgiii 1 Click on the A symbol of any of transformer substations When a

transformer substation IS selected the symbol on the left side of

the transformer substation's name changes to the A symbol
2 Clrck on Edit of the Tree menu The Edit menu offers several

options
3 Click on Responsible Person option of the Edit menu

1 Use UpArrow (1') or DownArrow (.J.-) to select a transformer
substation and press Enter (f-l) When a transformer substation IS
selected the ;l symbol on the left side of the transformer

substation's name changes to theA symbol
2 Press Alt+E
3 Use UpArrow (1') or DownArrow (.J.-) to select Responsible

Person option and press Enter (f-l )

The nght side of the screen (data field) enters Into editing mode The data
field Will contain the follOWing fields on the responsible person(s) of the
selected transformer substation

o "name" field name of the current responsible person,
To assign a different responsible person do the follOWingiii Click on the downward arrow on the nght Side of the

name drop-down list The drop-down list Will expand to
show the Irst of the responsible persons of the selected
transformer substation Click on the desired name

o "type" field by default this field contains the Responsible type,
o "contract" field" the number of the contract of the responsible

person,
o "expiration date" field eXpiration date of the contract of the

responsible person,
o "other mformatlon" field allows to keep additional Information on

the responsible person

To save the entered Information do the follOWing

iii Click on the Save button
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f7:1 Press Entei(~

If the entered data format does not correspond to the reqUirements of the
system a message will appear on the screen and the system will not allow to
continue work until data IS corrected to satisfy the reqUirements

To cancel changes and to return to the prevIous screen without save do the
following

Ij Click on the Cancel button

fjt! Press Esc

Entering and Modifying System data
System data IS a major group of data which consists of the following elements
reqUired by the system

• Data on rates
tanff category, dIscount category and value added tax data

• Data on Junction types
customers, group JunctIons and auto-generate customers

• Data on location
Marz's, commumtles, settlements, streets, bUlldmgs

• Name of the dlstnbutlon company
name of the dlstnbutlon company usmg the system

• Deviations
allowed deVIations from the ???

• Calendar
weekends and holidays

• Cycle/Route
cycles/routs ofmspectlons
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To start entenng new system data or modifying the eXisting system data do
the follOWing

Data that you can enter or modify uSing the System option IS required for the
normal operation of the system ThiS Information IS used for many purposes
For Instance, Information on location of customers IS used to enter complete

I
I
I
I
I
I

II Click on System In the main menu,

Press Alt+S,

r:J!I= When System IS selected the Items of the main menu on the
top of your screen change The menu now contains the
follOWing Items Elle, Edit, DataEntry, Reports, .§ystem, Window
and Help
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addresses of customers of the system As It was mentioned above, for
precise addressing of customers a seven-component addressing IS used In

the system Five of the seven components (Marz, community, neighborhood,
street and bUilding) are drop-down lists which offer a number of options to
select from These components can be entered or modified uSing one of the
options of the System menu

Entermg and Modlfymg Data on Rates
The Rates option of the System submenu allows to create or modify data
required for the fee calculation system, I e tariffs, discount rates and value
added tax status for any of the customers of the system

To select the Rates option do the followingII Click on Rates In the System submenu

m Press Alt+R

(iF When Rates IS selected the Items of the main menu on the top
of your screen change The menu now contains the following
Items Elle, Category, Tariff, Breakdown, DataEntry, Reports,
System, Window and Help

The Maintain Rates window appears on the screen The window contains
tree option buttons on the top
1 Tariff
2 Discount
3 Value Added Tax

To select an option button do the followingII Click on the desired option

1 Tanff when this option IS selected the window contains the following
fields
• Category drop-down list allows to select an eXisting category

or do add a new category

To select one of the eXisting categories do the following
~ 1 Click on the dark trrangle on the rrght side of the drop­

down list The list will expand to show the eXisting
categorres
2 Click on the deSired category to select It

To add a new tariff category do the followingII Click the mouse right button on the Category field A
submenu with option Create New and Rename will
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appear on the screen
Click on Create New option

The Category drop-down list will become a text box, a cursor
will appear In the text box and allow for entering data

After the category IS selected or new category entered, the following
data should be entered
• Effective date for the given category

Cltck on the Effective Date button and enter the date
• Expiration date for the given category

Cltck on the Expiration Date button and enter the date
• VAT Included

If VAT IS mcluded cltck on the VAT Included check box a check
mark will appear m the box

• Discountable
If thiS category IS discountable cltck on the Discountable check
box a check mark will appear m the box

• Late payment charges
Cltck on the Late Payment Charges button to enter the percent
of charges for late payments and enter the percent (0% If no
charges reqUired)

• Grace penod
Cltck on the Grace Penod button and enter the penod ofgrace
for late payments (for mstance, 15 days)

The lower part of the window will contain numbered ranges and
corresponding tanffs for thiS category

To add a new tariff to the given category do the following

1 Select Tanff from the top menu
2 Select Enter New from the pop-up menu

The Effective Date field should be filled In The Expiration date of the
old tanff will be automatically filled In Enter the new tariff Into the Tanff
field

To add a new range to the given category do the following

1 Select Breakdown from the top menu
2 Select Insert from the pop-up menu

A new row will be added (numbering of rows IS fulfilled automatically)
to the eXisting ranges Enter the new range Into the range field
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2 Discount when this option IS selected the window contains the following
fields

• Category drop-down list allows to select an eXisting category
or do add a new category

To select one of the eXisting categorres do the followingII 1 Click on the dark trrangle on the rrght side of the drop­
down list The list will expand to show the eXisting
categorres
2 Click on the deSired category to select It

To add a new tarrff category do the followIngII Click the mouse rrght button on the Category field A
submenu with option Create New and Rename will
appear on the screen
Click on Create New option

The Category drop-down list will become a text box, a cursor
will appear In the text box and allow for enterrng data

After the category IS selected or new category entered, the following
data should be entered
• Effective date for the given category

Cltck on the EffectIve Date button and enter the date
• Expiration date for the given category

Cltck on the ExpIratIon Date button and enter the date
• Discount percent for the given category

Cltck on the DIscount button and enter the percent of dIscount

3 Value Added Tax when thiS option IS selected the window contains the
following fields

• Hfectlve date for the given category
Cltck on the EffectIve Date button and enter the date

• Expiration date for the given category
Cltck on the ExpIration Date button and enter the date

• Value Added Tax percent for the given category

To add a new value added tax to the given category do the follOWing6 Click the mouse rrght button on the Value Added Tax button A
pop-up menu Will appear on the screen Select Enter New
from the pop-up menu
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A new row will appear below the eXisting value added tax data Enter
the Effective Date, Expiration Date and the Value Added Tax for the
given category

To save the entered information do the following

I; Click on the Save button

n Press Enter (fJ )

If the entered data format does not correspond to the reqUirements of the
system a message will appear on the screen and the system will not allow to
continue work until data IS corrected to satisfy the reqUirements

To cancel changes and to return to the prevIous screen without save do the
following

Ii1 Click on the Cancel button

a Press Esc

Entermg and Modlfymg Data on Junction Types

The Junction Type option of the System submenu allows to create or modify
data on Junction types - dlstrrbutlon substations, transformer substations,
transformers, group Junctions, etc

To select the Junction Type option do the following
I; Click on Junction Type In the System submenu

SFi1 Press Alt+J

@=' When Junction Type IS selected the Items of the main menu on
the top of your screen change The menu now contains the
following Items Elle, Edit, DataEntry, Reports, fu'stem, Window
and Help

The Mamtam Junction Types window appears on the screen The window
contains a table of categones of vanous Junctions, the shortcuts for each
Junction category and corresponding descnptlons

There are standard (for Instance, TS, TR) and user defined types of Junctions
The shortcuts of standard types are underlined

To add a new Junction type do the following
I; Click the mouse rrght button on the Mamtam Junction Types

window A pop-up menu will appear on the screen Select Enter
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New from the pop-up menu

A new empty row with a cursor will appear on the bottom of the table Below
the new empty line there will be a Irst of the eXisting types of Junctions The
list has a scroll bar on the nght side which will allow to navigate through the
eXisting list The user can enter a new Junction type Into the empty row, or
select from the Irst of the eXisting types

To save the entered mformatlon do the following

Ii Click on the Save button

res Press Enter (f..l )

To cancel changes and to return to the prevIous screen without save do the
following

Ii Click on the Cancel button

res Press Esc

Entermg and Modlfymg Data on Location

The Location option of the System submenu allows to create an addressing
system which will provide precise addressing of all customers of the system
Five of the components of the address (Marz, Commumty, Settlement, Street,
BUilding) of any of the customers can be entered uSing this option

To select the Location option do the followingIi Click on Location In the System submenu

res Press AIt+L

r:ifF When Location IS selected the Items of the main menu on the
top of your screen change The menu now contains the
followmg Items Elle, Location, DataEntry, Reports, System,
Window and Help

The Maintain Location window appears on the screen The Window
contains check boxes and drop-down lists of the five components of an
address Marzes, communities, settlements, streets and bUildings

Adding a new address to the system consists of several steps

Step 1 Adding a name of a Marz
To add a new Marz to the system do the follOWing
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1 Click the mouse nght button on the Marz drop-down list
Initially, If the list IS empty the drop-down lists Intended for
Community, Settlement, Street and BUildings are
Inactive (shaded) and do not allow for access

2 A pop-up menu will appear on the screen Select Enter
New from the pop-up menu Enter New option contains a t­

on ItS nght side which means It offers several options you
can select from

3 Click on the • A second pop-up menu will appear on the
nght side of the first pop-up menu Select Marz from the
second pop-up menu (Initially, the other components are
Inactive and do not allow for access)

The Marz drop-down list becomes a text box with a cursor and allows
for editing

Enter the name of a Marz Into the text box

To save the entered mformatlon do the following

Ii Click on the Save button

It'! Press Enter (~)

To cancel changes and to return to the prevIous screen without save
do the following

Ii Click on the Cancel button

lei Press Esc

The Marz text box again becomes a drop-down list A check mark
appears m the Marz check box on the left side of the Marz drop-down
list
You can browse the list of Marzes by clicking on the downward tnangle
on the nght side of the drop-down list

Step 2 Addmg a name of a Community
When the Marz drop-down list IS not empty I e It contains names of
Marzes you can add names of commUnities of the selected Marz to the
system

To add a new Community to the system do the follOWingIiJ 1 Select the deSired Marz name from the Marz drop-down
list

2 Click the mouse nght button on the Community drop-down
list Initially, If the list only contains the name of the Marz
without ItS correspondmg components, the drop-down lists
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Intended for Settlement, Street and BUildings are
Inactive (shaded) and do not allow for access

3 A pop-up menu will appear on the screen Select Enter
New from the pop-up menu Enter New option contains a ~

on Its nght side which means It offers several options you
can select from

4 Click on the" A second pop-up menu will appear on the
nght side of the first pop-up menu Select Community
from the second pop-up menu (the remaining components
are Inactive and do not allow for access)

(iF For the selected Marz, you can only add names of
communities of this Marz

The Community drop-down list becomes a text box with a cursor and
allows for editing

Enter the name of a Commumty Into the text box

To save the entered Information do the follOWing

II Click on the Save button

n Press Enter (fJ )

To cancel changes and to return to the prevIous screen without save
do the following

Ii Click on the Cancel button

n Press Esc

The Commumty text box again becomes a drop-down list A check
mark appears In the Commumty check box on the left Side of the
Community drop-down list
You can browse the list of Communities by clicking on the downward
tnangle on the nght Side of the drop-down list

Step 3 Adding a name of a Settlement
When the Community drop-down list IS not empty, I e It contains
names of communrtles you can add names of settlements of the
selected communrty to the system

(iF Settlement drop-down list might be empty If the selected
commumty does not have any settlements In this case, skip Step
3 and go to Step 4

To add a new Settlement to the system do the follOWing
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II 1 Select the desired Marz name from the Marz drop-down
list

2 Select the desired Communrty name from the Community
drop-down list

3 Click the mouse right button on the Settlement drop-down
list The Street and BUlldmg elements are Inactive
(shaded) and do not allow for access

4 A pop-up menu will appear on the screen Select Enter
New from the pop-up menu Enter New option contains a ..
on ItS right side which means It offers several options you
can select from

5 Click on the ~ A second pop-up menu will appear on the
rrght side of the first pop-up menu Select Settlement from
the second pop-up menu (the remaining components are
Inactive and do not allow for access)

(iJ= For the selected Community, you can only add names of
settlements of this Community

The Settlement drop-down list becomes a text box with a cursor and
allows for editing

Enter the name of a Settlement Into the text box

To save the entered information do the following

IiJ Click on the Save button

a Press Enter (fJ)

To cancel changes and to return to the prevIous screen without save
do the following

IiJ Click on the Cancel button

a Press Esc

The Settlement text box again becomes a drop-down list A check
mark appears In the Settlement check box on the left Side of the
Settlement drop-down list
You can browse the list of Settlements by clicking on the downward
trrangle on the nght Side of the drop-down 'lIst

Step 4 Addmg a name of a Street
When the Community or the Settlement drop-down list IS not empty,
I e It contains names of communrtles you can add names of streets of
the selected communrty or settlement to the system

To add a new Street to the system do the follOWing
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1 Select the desired Marz name from the Marz drop-down
list

2 Select the desired Community name from the Commumty
drop-down list

3 If there are any settlements In the selected community
select the desired Settlement name from the Settlement
drop-down list

4 Click the mouse nght button on the Street drop-down list
The BUlldmg element IS Inactive (shaded) and does not
allow for access

4 A pop-up menu will appear on the screen Select Enter
New from the pop-up menu Enter New option contains a ..
on Its nght side which means It offers several options you
can select from

5 Click on the'" A second pop-up menu will appear on the
nght side of the first pop-up menu Select Street from the
second pop-up menu (the last component IS Inactive and
does not allow for access)

(iF For the selected Commumty, you can onlv add names of
settlements of this Commumty

The Settlement drop-down list becomes a text box with a cursor and
allows for editing

Enter the name of a Settlement Into the text box

To save the entered Information do the following

Ii Click on the Save button

1m! Press Enter (f-l )

To cancel changes and to return to the prevIous screen without save
do the following

II Click on the Cancel button

n Press Esc

The Settlement text box again becomes a drop-down list A check
mark appears In the Settlement check box on the left side of the
Settlement drop-down list
You can browse the list of Settlements by clicking on the downward
tnangle on the nght side of the drop-down list
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Entermg and Modlfymg Distribution Company's Name
The Dlstnbutlon Company option of the System submenu allows to create
or modify data on Junction types - distribution substations, transformer
substations, transformers, group Junctions, etc

To select the Dlstnbutlon Company option do the followingIIJ Click on Dlstnbutlon Company In the System submenu

ret Press Alt+C

r::Ji'=' When Distribution Company IS selected the Items of the main
menu on the top of your screen change The menu now contains the
follOWing Items Elle, Edit, DataEntry, Reports, .§ystem, Window and
Help

The EDC (energy distribution company) window appears on the screen The
window contains a table of codes and names of energy distribution
companies uSing the system

To add a new distribution company do the follOWingIIJ Click the mouse right button on the EDC window A pop-up menu
Will appear on the screen Select Enter New from the pop-up menu

A new empty row with a cursor Will appear on the bottom of the table Add the
code and the name of the distribution company

To save the entered Information do the follOWing

IIJ Click on the Save button

IBI Press Enter (f-l)

To cancel changes and to return to the prevIous screen without save do the
follOWing

IIJ Click on the Cancel button

IBI Press Esc

Entermg and Modlfymg Data on DeViatIOns
The DeViations option of the System submenu allows to define permitted
deViations from the established norms, such as numbers of days, amounts of
debts, and so on

To select the DeViations option do the follOWingIIJ Click on DeViations In the System submenu
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n Press Alt+D

The For Reading window appears on the screen The window contains the
following text boxes
• number of permitted deviation from the defined number of days (Permitted

Deviation of Days)
To enter the number of days or to modify the eXlstmg number do the
followingIiJ Click on the small upward or downward tnangles on the nght side

of the Permitted Deviation of Days window to mcrease or to
decrease the number

fit Type the number of the permitted deviation of days

• permitted deviation from the debt amount
o for residents
o for state organizations

To enter or modify the amount of permitted deViation from the debt
amount do the followinge Type the amount of the permitted deviation of the debt for

reSidents (Resident window) and for state organizations
(State window)

To save the entered Information do the following

Click on the Save button
Click on the Close button

To cancel changes and to return to the prevIous screen without save do the
following

I; Click on the Cancel button

N Press Esc

Workmg with the Calendar
The Calendar option of the System submenu allows to specify weekends
and holidays of each year It IS used for workIng with cycles/routes

To select the Calendar option do the followingD Click on Calendar In the System submenu

n Press Alt+???
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f search you can use also the buttonsIf tho slmpilfy e process 0

«Week Week»
«Month Month»
«Year Year»

T

• Bottom left part allows search for any of the days, weeks, months or
years
To find a desired date do the follOWingIiJ Click on «Day or Day» button

The text box with the Find button shows the desired date Default value of
this text box IS 00/00/000
To show the today's date do the follOWingIII Click on Today button

The text box on the nght Side of the button Will show today's date
The calendar In the upper left Side Will show the month and year of the
selected date, and the selected date In shading

• Right part shows the list of weekends and holidays
To add any date to the list of weekends and holidays do the follOWingD Double click on the desired date The date Will appear In the list

of weekends and holidays

The Calendar window appears on the screen The window consists of the
following parts
• Upper left part shows the current month of the year and the calendar for

this month
You can view the calendar of any of the months and years by dOIng the
followinga Click on nghtward or leftward tnangles on the nght and left sides

of the current month's name

Entermg and Modlfymg Data on Cycles/Routes
The Cycle/Route option of the System submenu allows to specify
cycles/routes of Inspections of any of the parts of the system

To save the information do the follOWinga Click on the OK button
Click on the Close button

To select the Cycle/Route option do the follOWingD Click on Cycle/Route In the System submenu

n Press Alt+???
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r::iF' When Cycle/Route IS selected the Items of the main menu on the
top of your screen change The menu now contains the following
Items file, Cycle, Route, DataEntry, Reports, System, Window and
Help

The Cycle/Route window appears on the screen The window contains two
option buttons on the top
1 Main
2 Move

1 Main this option allows to work with cycles and routes (to add new cycles
and routes, to modify or delete the eXisting cycles and routes)

When this option IS selected the window contains the following fields
• list of the eXisting cycles (upper left part)
• list of routes of the selected cycle (bottom left part)
• list of the eXisting routes (upper right part)
• list of routes not Included Into any of the eXisting cycles (bottom

right part)
r::iF' The dark little triangle on the left side of the any of these lists shows the selected Item

The right part of the screen also contains instructions on cyclestroutes to be
accomplished on specified dates check'"

a) Working with cycles

* To add a new cycle do the following1.1 1 Select Cycle from the top menu
2 Select New from the pop-up menu

A new empty line will add to the list below the eXisting cycles Add the code,
name and the date for the new cycle

* To modify data on any of the eXisting cycles do the following
11.1 1 Select Cycle from the top menu

2 Select Modify from the pop-up menu

The selected cycle will enter Into editing mode and will allow for changes

* To delete any of the eXisting cycles do the following1.\1 1 Select Cycle from the top menu
2 Select Delete from the pop-up menu

A window will appear on the screen asking to confirm delete
1.\1 Click on Yes button to confirm delete
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To save the entered Information do the following

The selected route will enter Into editing mode and will allow for changes

b) Working with routes

Select a route (or routes) from the list of routes not Included Into
any of the eXisting cycles by clicking on the corresponding route
(To select more than one route press and hold Shift key and click
on as many routes as you need)

2 Drag and drop the selected route (routes) Into the list of routes of
the selected cycle

Click on the Save button
Click on the Close button

Click on No button to reject delete
Press Y to confirm delete
Press N to reject delete

* To add a new route do the following1.1 1 Select Route from the top menu
2 Select New from the pop-up menu

* To delete any of the eXisting cycles do the following1.1 1 Select Route from the top menu
2 Select Delete from the pop-up menu

* To modify data on any of the eXisting routes do the followingII 1 Select Route from the top menu
2 Select Modify from the pop-up menu

If the route being deleted belongs to any of the cycles, a window will appear
on the screen with the message "This Route Belongs to a Cycle" and
deleting will not be allowed

D Click on OK button

A new empty line will add to the list below the eXisting routes Add the code,
name and the date for the new route

* To Include any of the not Included routes Into one of the cycles do the
following

D1
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To cancel changes and to return to the prevIous screen without save do the
following

IIJ Click on the Cancel button

rei Press Esc

2 Move this option allows to move a route (routes) from one cycle to
another

When this option IS selected the window contains the following fields
• 2 Identical lists of the eXisting cycles (first two lists on the first row)
• list of the routes of the selected cycle on the first list of cycles
• list of the routes of the selected cycle on the second list of cycles

@= each list of routes IS located below the cOffespondmg Itst of cycles

• list of all eXisting routes
• list of routes not Included Into any of the eXisting cycles

@= the dark little triangle on the left side of the any of these lists shows the selected Item

To move a route (routes) from one cycle to another do the following

1 On one of the lists of cycles select the cycle from which a route
(routes) will be moved

2 On the other list of cycles select the cycle to which the selected
route (routes) will be moved

3 Select the routes to be moved on the corresponding list of routes
of the first selected cycle

4 Drag and drop the selected route (routes) to the list of routes of
the second cycle

A window with the message "X routes have been found Are you sure?"
(where X IS the number of routes found) will appear on the screen asking to
confirm move
IIJ Click on OK to confirm move

Click on Cancel to reject move
II Press Enter to confirm move

Press Esc to reject move
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Maintaining Data Logs

1 Press Alt+D,
2 Press Alt+L ???

Creatmg New Data Logs
You can create new data logs by followmg the below deSCribed steps

After you select the type of the data log to browse, the Maintain Batch
window Will display the eXisting data logs of the selected type and the number
of the logs of thiS type (bottom part of the window)

Select the method of creatIon of the new data log
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Select the type of the data log to be created (as descnbed In the
prevIous sectIon Browsmg the EXlstmg Data Logs)

Step 2

Step 1

The Maintain Batch Window Will appear on the screen ThiS window allows to
do the following actions
• to browse the lists of the eXisting data logs based on the follOWing cntena

o type of the data log
o readings of meters
o bills to customers
o payments made by customers

• to select the type of a new data log to be created,
• to select the method of creation of a new data log,
• to open an eXisting data log and make calculations

Part III Maintaining and Updating Data Logs
Data logs allow to maintain data on meter readings, bills, payments, to
update data on pre-specified Intervals, and to make necessary calculations
There are several types of data logs you can create with the help of the
program these types are called General, Readmgs, BII/S, and Payments
General type data log Includes the three other types of logs

To start working with data logs do the followingU Click on DataEntry In the main menu,
Click on DataLog option In the DataEntry menu

Browsmg the EXlstmg Data Logs

To browse an eXisting data log It IS necessary to select the type of the log To
select the type of a data log do the follOWingII Click on the corresponding Type option button on the upper left Side

of the Maintain Batch window
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r::ifF For any of the above descnbed types of the data logs only some of the
methods of creation can be used The follOWing relationship eXists
between the type of the data log being created and the method of
creation

Another option IS to create a data log based on all above mentioned cntena
at once For thiS do the follOWingIi Click on the All check box on the upper middle Side of the Maintain

Batch Window

o by a Group or a Junction
To create a data log for a Group or a Junction do the follOWingIi 1 Click on the Group or Junction option button on the upper

middle Side of the Maintain Batch window The TreeVlew
window Will appear on the screen

2 Select the desired group or Junction on the tree

o by a Common Object
To create a data log for a Common Object do the follOWing
It] 1 Click on the Common Object option button on the upper

middle Side of the Maintain Batch window The ???

window Will appear on the screen
2 Select the desIred common Object
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Data Log can be created
by the method of

Cycle/Rout
Group
Junction

For the type of

o by a Consolidated Customer
To create a data log for a Consolidated Customer do the follOWingII 1 Click on the Consolidated Customer option button on the

upper middle Side of the Maintain Batch window The
Consolidated window Will appear on the screen

2 Select the desired consolidated customer

General and Readings

The following methods of creation are available
o by a Cycle/Route

To create a data log for a cycle/route do the followingIi 1 Click on the Cycle/Route option button on the upper
middle side of the Maintain Batch window

2 Click on the cycle text box (next to the option button) and
type the number of cycle

3 Click on the route text box (next to the route text box) and
type the number of route
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Bills Cycle/Rout
Group
Customer*
Consolidate

I
I
I

I
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Payments Cycle/Rout
Group
Customer*
Consolidate
Common Object

* In these cases Instead of the Junction option the Customer option will be shown In
the window

Step 3 SpecIfy the name of the document (data log) and the date of
creatIon

For this do the followingIi Click on the Document text box on the upper nght side of the
Maintain Batch window and type the name
Click on the Date text box below the Document text box and type the
date

Cit'" The date of creation IS filled In automatically with the current date and
venflcatlon IS accomplished to prevent creation of a data log by an old date

Step 4 Create the data log based on the cntena specIfied m the
prevIous steps

For creation of the data log do the followingIi Click on the Create button on the bottom part of the Maintain Batch
window

Cit'" When a General data log IS created a data log IS
automatically added to the list of each type of data logs
(Readmgs, BIlls, and Payments)

Another method of creation of a data log IS to use 3D-Day Control button It
allows to browse objects which within a 3D-day penod have not made any
payments, have not received any bills, and for which no meter reading has
been accomplished
For creation of the data log by this method do the followingB Click on the 3D-Day Control button on the upper part of the Maintain

Batch window

A 30-Day Control window with the message "Are you sure" appears on the
screen asking to confirm creation

Click on Yes button to confirm creation
Click on No button to reject creation
Press Y to confirm creation
Press N to reject creation
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In the case creation IS confirmed a new window appears on the screen It
allows to specify the number of days wlthm which no bills have been created,
no readings or payments made

To specify the number of days do the following
_ Click on the upward little tnangle on the nght side of the 30+00

window to Increase the number of days, or on the downward tnangle
to decrease It

The following options are available
o No Billing for customers for which no bills have been received by

the corresponding customer
o No Reading for customers for which no reading of meters has

been accomplished
o No Payment for the customers which have made no payments

To create a new document (data log) by this method do the followingIIJ 1 Select an option by clicking on the corresponding option button
2 Click on the Update button to update the lists
3 Click on the Document text box and type the name
4 Click on the Date text box and type the date
5 Click on the Create button to create the document

A new General data log Will be created

r:;ifj= A data log created by 30-Day Control method Will be
shown In the list only In the case If the All check box IS
active (a check mark IS available In the box) on the
Maintain Batch window

Working with Data Logs

Openmg Data Logs

To work with any of the data logs you should open It first To open a data log
do the followmgIIJ 1 Click on one of the Type option button to select the type of the

data log
2 Click on the Method of Creation option button to select the method

of creation of the data log
3 Click on the desired data log to select It
4 Click on the Open button to activate the selected data log (Open

button IS activated only If a data log IS selected)

When a General data log IS selected an Open for window Will appear on the
screen to define the action (Readmgs - for updating the meter readings, a,lls­
for calculatmg the bills, and Payments - for calculating the payment balance)
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you want to accomplish with the data log being open Click on the desired
option
In other cases the corresponding data log will open automatically

Updatmg Meter Data
To update the meter data do the followingIi 1 Click on the Readmgs option on the Type option button on the

Mamtam Batch window
2 Click on the Method of CreatIon option button to select the

method
3 Click on the desired data log to select It
4 Click on the Open button to activate the selected data log (Open

button IS activated only If a data log IS selected)

When the Readmgs option IS selected a new window will appear on the
screen allowing to enter new meter data

r::ifF When Readmgs IS selected the Items of the main menu on the
top of your screen change The menu now contains the
following Items Elle, Post, DataEntry, Reports, .Qystem, Window
and Help

To select a customer on the list click on the deSired name The little dark
trrangle on the left Side of the list Will show the selected Item on the list The
New Readmg text box for the selected customer Will enter Into the editing
mode and allow for typing the new meter reading

The bottom part of the Window Will show detailed information on the customer
name, type, tarrff category, data on the meter, old meter reading, and so on

r::ifF The difference between the old and the new readings Will be
calculated and the meter data Will be updated automatically

To save the entered data do the follOWing

II Click on the Save button

n Press Enter (~ )

To assign the entered data to the corresponding customers do the follOWing
Ii] Click on Post option In the menu

m Press Alt+P

The Post window Will appear on the screen asking to confirm assignmentIi Click on Ves button to confirm post
Click on No button to reject postn Press V to confirm post
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Press N to reject post

In the case of confirmation the system will accomplish update of the data on
customers, and the program will return to the prevIous screen

When opening the same data log for the second time (after updatmg) the
customer whose data have been posted will be marked With a + sign Data
market With this sign cannot be modified

Preparmg Bills

To prepare the bills do the followmgII 1 Click on the Bills option on the Type option button on the Mamtam
Batch Window

2 Click on the Method of Creation option button to select the
method

3 Click on the desired data log to select It
4 Click on the Open button to activate the selected data log (Open

button IS activated only If a data log IS selected)

When the Bills option IS selected a new Window will appear on the screen
showing the list of customers Check marks m check boxes on the left side of
each name show that there have been changes In data of the corresponding
customer

r:ifF Check boxes allow for editing, I e the user IS free to put or take
off the check marks m the boxes

To prepare the bills for the list do the followmgIi Click on the Bill button

EI Press Enter (~ )

A new wmdow will appear on the screen showing the list of customers,
amount of used energy as of the specIfied date, the amount to be paid, and
other data

r:ifF When this Window appears the Items of the main menu on the
top of your screen change The menu now contams the
followIng Items Elle, Show, DataEntry, Reports, fu'stem,
Window and Help

r$j= All calculations will be made by the system automatically

There are two command button on the top of the wmdow
o Bnef, and
o Detailed

- -- ----When-BnefoptIOii IS selected the screen wlii show me liSt of preparectbills
The Detailed option allows to show the bills the way as they Will be sent to
each customer The drop-down list on the top of the screen (Immediately
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below the command buttons) contains the list of customers and allows to
select a customer and view the bill for this customer on the screen

To print the brief or detailed lists of bills do the follOWing

IiJ Click on the Print button ( :f1mt') on the upper right Side of the screen
check'"

To assign the updated data to the corresponding customers do the follOWing

It] Click on Print Icon ('.fih on the toolbar
check'"f1 Press Alt+P

The Post window (check"') Will appear on the screen asking to confirm
assignmentIi Click on Ves button to confirm post

Click on No button to reject post
fI Press V to confirm post

Press N to reject post

In the case of confirmation the system Will not only accomplish update of the
data on customers, but also print all bills and reports

To view the reports on the prepared bills use the Show option of the menu It
allows to view any selected page of the reports, and to zoom It to the desired
percent This option IS standard for all reports (For more details on this
option see Part IV section Prmtmg Reports)

Ca/culatmg the New Payment Balance

To calculate the new payment balance do the followmgIi 1 Click on the Payments option on the Type option button on the
Maintain Batch window

2 Click on the Method of Creation option button to select the
method

3 Click on the desired data log to select It
4 Click on the Open button to activate the selected data log (Open

button IS activated only If a data log IS selected)

CifI= When Payments IS selected the Items of the main menu on the
top of your screen change The menu now contains the
follOWing Items Elle, Post, DataEntry, Reports, System, Window
and Help

When the Payments option IS selected a new window Will appear on the
screen allowing to enter data on payments for a selected customer The
window Will show the list of customers, current balances as of dates of the
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1 Press Alt+D,
2 Press Alt+E ???

Imtlally, the data log on payments made dunng the current date Will be empty
To make an entry Into the data log of everyday payments do the follOWing

prevIous payments, text boxes for the last payments made and corresponding
text boxes for the new balances

r::iF After the last payment data IS entered the new balance will be
calculated automatically
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Click on Edit of the Payment Data Entry for Today menu

Press Alt+E

2 PrevIous payments (upper right section),
This section shows mformatlon on prevIous payments of the selected
customer

4 Presented InVOices on payments made (lower nght section)
This section shows mformatlon on inVOices of payments made by the
selected customer on the current date

3 Details on the Customer (lower left section),
This section contams details (name, type, tanff category, balance, account
number, Matus, etc) on the selected customer

Maintaining Data on Everyday Payments
The system provides for an option to a maintain data log on everyday
payments

r::iF When Everyday Payments IS selected the Items of the main
menu on the top of your screen change (besides thiS, the title
bar - top dark bar of the screen shows Frame - (Payment Data
Entry for Today) The menu now contains the following Items
Elle, Post, Edit, DataEntry, Reports, fu'stem, Window and Help

To start working With data logs on everyday payments do the followingIi Click on DataEntry In the main menu,
Click on Everyday Payments option In the DataEntry menu

I

In this mode the screen IS divided Into four sections
1 Payment log of the current date (upper left section),

- --- --------- - Thrs-sectu::m-contalns account numbe~addresses, current balances
(amount due for the energy consumed), payments made on the current
date and the new balances after the payments are made by customers
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The Edit submenu offers several actions you can select from These actions
are

Click on Enter New option of the Edit submenu
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More In details these actions are descnbed below In this section

adding a new record on payment,
deleting the eXisting record
pnntlng a report on the payments made on the current
date

Use UpArrow (1') or DownArrow (-.1.-) to select Enter New option of
the Edit submenu and press Enter (~ )

If the entered account number already eXists In the data log of
everyday payments a window will appear on the screen with the
message "xxxxxxx account number already eXists" The
system, however, will allow to continue working, since a customer
can make more than payments per day When a correct account
number IS entered the lower left part of the screen (Details on the
customer) will show data on the customer havmg the specified
account number

o "Address", this field IS filled In automatically, checkll!
o "Current balance", this field IS filled In automatically,
o "Paid amount", this field should be filled In based on the produced

Invoices Click on the field and enter the amount,
o "New balance" new payment balance IS calculated automatically

Enter New­
Delete ­
Prmt -

1 Enter New To add a new record on a payment made do the following

Enter Information on the new payment made Into the following fields
o "Account number" by default the account number IS equal to 0,

If the account number entered Into this field does not correspond to
_ _____ the accounlnumber_of an)' oUbe-customers of the system a

window will appear on the screen with the message "xxxxxxx
account number does not eXlsf' The system will require to enter
a correct account number, otherwise the work with the system
cannot be continuedIJJ Click on OK

n Press Enter (~ )

Type the correct account number

An empty line appears on the bottom of the upper left side of the screen, and
the upper left and nght sides of the screen enter Into editing mode
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2 Delete If necessary you can remove any of the eXisting records on
payments made To remove (delete) the selected entry do the following

Click on the desired entry to select It
Click on Delete of the Edit submenu

A window will appear on the screen asking to confirm deleteII Click on yes button to confirm delete
Click on No button to reject deleteB Press Y to confirm delete
Press N to reject delete

3 Prmt If necessary you can print the data log on everyday payments To
print the data log do the following

_ Click on Print of the Edit submenu

To save the entered Information do the following
D Click on the Save button

To assign the newly entered data to the customers of the system do the
follOWingD Click on Post of the Payment Data Entry for Today menu

To finish working with the data log on everyday payments do the follOWingD Click on the Close button
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You can create new data logs by follOWing the below descrrbed steps
- Creating New Data Logs

Mamtammg Data Logs

1 Press Alt+D,
2 Press Alt+L ???

Select the method of creation of the new data log

Select the type of the data log to be created (as descnbed In the
prevIous section Browsmg the EXlstmg Data Logs)
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Step 2

Step 1

After you select the type of the data log to browse, the Mamtam Batch
wmdow Will display the eXisting data logs of the selected type and the number
of the logs of this type (bottom part of the window)

Part III Maintaining and Updating Data Logs
Data logs allow to maintain data on meter readmgs, bills, payments, to
update data on pre-specified Intervals, and to make necessary calculations
There are several types of data logs you can create with the help of the
program these types are called General, Readmgs, Bills, and Payments
General type data log Includes the three other types of logs

The Mamtam Batch wmdow Will appear on the screen This window allows to
do the follOWing actions
• to browse the lists of the eXisting data logs based on the follOWing cntena

o type of the data log
o readmgs of meters
o bills to customers
o payments made by customers

• to select the type of a new data log to be created,
• to select the method of creation of a new data log,
• to open an eXisting data log and make calculations

Browsmg the EJastmg Data Logs

To browse an eXisting data log It IS necessary to select the type of the log To
select the type of a data log do the follOWingIi Click on the corresponding Type option button on the upper left Side

of the Mamtam Batch window

To start workmg with data logs do the followingIi Click on DataEntry In the main menu,
Click on DataLog option In the DataEntry menu
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c:iF' For any of the above descnbed types of the data logs only some of the
methods of creation can be used The follOWing relationship eXists
between the type of the data log being created and the method of
creation

Another option IS to create a data log based on all above mentioned cnterra
at once For this do the follOWing11 Click on the All check box on the upper middle Side of the Maintain

Batch window

o by a Consolidated Customer
To create a data log for a Consolidated Customer do the followingIi 1 Click on the Consolidated Customer option button on the

upper middle side of the Maintain Batch window The
Consolidated window will appear on the screen

2 Select the desired consolidated customer

o by a Common Object
To create a data log for a Common Object do the followingII 1 Click on the Common Object option button on the upper

middle side of the Maintain Batch window The ???

window Will appear on the screen
2 Select the desired common object
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Data Log can be created
b the method of

Cycle/Rout
Group
Junction

For the type of

o by a Group or a Junction
To create a data log for a Group or a Junction do the followingIi 1 Click on the Group or Junctron option button on the upper

middle side of the Maintain Batch window The TreeVlew
window will appear on the screen

2 Select the desired group or Junction on the tree

General and Readings

The following methods of creation are available
o by a Cycle/Route

To create a data log for a cycle/route do the followingIi 1 Click on the Cycle/Route option button on the upper
middle side of the Maintain Batch window

2 Click on the cycle text box (next to the option button) and
type the number of cycle

3 Click on the route text box (next to the route text box) and
type the number of route
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A 30-Day Control window with the message "Are you sure" appears on the
screen asking to confirm creation

@=' When a General data log IS created a data log IS

automatically added to the list of each type of data logs
(Readings, Bills, and Payments)

Cycle/Rout
Group
Customer*
Consolidate

Click on Ves button to confIrm creation
Click on No button to reject creation
Press V to confIrm creation
Press N to reject creation

Bills

Payments Cycle/Rout
Group
Customer*
Consolidate
Common Object

* In these cases Instead of the JunctIon option the Customer option will be shown In
the window

Step 3 Specify the name of the document (data log) and the date of
creation

For this do the followingII Click on the Document text box on the upper right side of the
Mamtam Batch window and type the name
Click on the Date text box below the Document text box and type the
date

@=' The date of creation IS filled In automatically with the current date and
VerificatIon IS accomplished to prevent creation of a data log by an old date

Step 4 Create the data log based on the cntena specified In the
prevIous steps

For creation of the data log do the follOWingII Click on the Create button on the bottom part of the Mamtam Batch
window

Another method of creation of a data log IS to use 30-Day Control button It
allows to browse objects which within a 3D-day period have not made any
payments, have not received any bills, and for which no meter reading has
been accomplished
For creation of the data log by this method do the follOWingIi Click on the 30-Day Control button on the upper part of the Mamtam

Batch window
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In the case creation IS confirmed a new window appears on the screen It
allows to specify the number of days within which no bills have been created,
no readmgs or payments made

To specify the number of days do the following1.1 Click on the upward little tnangle on the nght side of the 30+00
window to mcrease the number of days, or on the downward tnangle
to decrease It

The following options are available
o No Billing for customers for which no bills have been received by

the correspondmg customer
o No Reading for customers for which no reading of meters has

been accomplished
o No Payment for the customers which have made no payments

To create a new document (data log) by this method do the followmgIi 1 Select an option by cllckmg on the corresponding option button
2 Click on the Update button to update the lists
3 Click on the Document text box and type the name
4 Click on the Date text box and type the date
5 Click on the Create button to create the document

A new General data log Will be created

CiF' A data log created by 3D-Day Control method Will be
shown In the list only m the case If the All check box IS
active (a check mark IS available In the box) on the
Maintain Batch window

Working with Data Logs

Openmg Data Logs

To work with any of the data logs you should open It first To open a data log
do the follOWing1.1 1 Click on one of the Type option button to select the type of the

data log
2 Click on the Method of Creation option button to select the method

of creation of the data log
3 Click on the desired data log to select It
4 Click on the Open button to activate the selected data log (Open

button IS activated only If a data log IS selected)

When a General data log IS selected an Open for wmdow Will appear on the
screen to defme the action (Readmgs - for updating the meter readings, Bills­
for calculating the bills, and Payments - for calculatmg the payment balance)
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you want to accomplish with the data log being open Click on the desired
option
In other cases the corresponding data log will open automatically

Updatmg Meter Data
To update the meter data do the followingIi 1 Click on the Readmgs option on the Type option button on the

Mamtam Batch window
2 Click on the Method of Creation option button to select the

method
3 Click on the desired data log to select It
4 Click on the Open button to activate the selected data log (Open

button IS activated only If a data log IS selected)

When the Readmgs option IS selected a new window will appear on the
screen allowing to enter new meter data

CifI= When Readmgs IS selected the Items of the main menu on the
top of your screen change The menu now contains the
following Items Elle, Post, DataEntry, Reports, System, Window
and Help

To select a customer on the list click on the desired name The little dark
triangle on the left side of the list will show the selected Item on the list The
New Readmg text box for the selected customer will enter Into the editing
mode and allow for typing the new meter reading

The bottom part of the window will show detailed Information on the customer
name, type, tanff category, data on the meter, old meter reading, and so on

CifI= The difference between the old and the new readings Will be
calculated and the meter data Will be updated automatically

To save the entered data do the follOWing

Ii Click on the Save button

re; Press Enter (f..I )

To assign the entered data to the corresponding customers do the following
Ii] Click on Post option In the menu

n Press Alt+P

The Post window Will appear on the screen asking to confirm assignmentIi Click on Ves button to confirm post
Click on No button to reject postEiI Press V to confirm post
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Press N to reject post

In the case of confirmation the system will accomplish update of the data on
customers, and the program will return to the prevIous screen

When opening the same data log for the second time (after updating) the
customer whose data have been posted will be marked with a + sign Data
market with this sign cannot be modified

Preparmg Sills
To prepare the bills do the followingIi 1 -CliCK on me BillS option on1he Type option button on the Mamtam

Batch window
2 Click on the Method of CreatIOn option button to select the

method
3 Click on the desired data log to select It
4 Click on the Open button to activate the selected data log (Open

button IS activated only If a data log IS selected)

When the Bills option IS selected a new window Will appear on the screen
showing the list of customers Check marks In check boxes on the left Side of
each name show that there have been changes In data of the corresponding
customer

@=' Check boxes allow for editing, I e the user IS free to put or take
off the check marks In the boxes

To prepare the bills for the list do the follOWingII Click on the B.II button

n Press Enter (f-l)

A new window Will appear on the screen showing the list of customers,
amount of used energy as of the specified date, the amount to be paid, and
other data

@=' When this window appears the Items of the main menu on the
top of your screen change The menu now contains the
follOWing Items Elle, Show, DataEntry, Reports, System,
Window and Help

@= All calculations Will be made by the system automatically

There are two command button on the top of the window
o Brref, and
o Detailed

When Bnef option IS selected the screen Will show the list of prepared bills
The Detailed option allows to show the bills the way as they Will be sent to
each customer The drop-down list on the top of the screen (Immediately
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below the command buttons) contains the list of customers and allows to
select a customer and view the bill for this customer on the screen

To print the brief or detailed lists of bills do the follOWing

(; Click on the Print button ( -Pmltl) on the upper right Side of the screen
check'"

To assign the updated data to the corresponding customers do the following

II Click on Prmt Icon (ISlI) on the toolbar
check'"WI Press Alt+P

The Post window (check"') Will appear on the screen asking to confirm
assignment1.1 Click on Yes button to confirm post

Click on No button to reject postn Press Y to confirm post
Press N to reject post

In the case of confirmation the system Will not only accomplish update of the
data on customers, but also prrnt all bills and reports

To view the reports on the prepared bills use the Show option of the menu It
allows to view any selected page of the reports, and to zoom It to the deSired
percent ThiS option IS standard for all reports (For more details on thiS
option see Part IV section Prmtmg Reports)

Ca/culatmg the New Payment Balance

To calculate the new payment balance do the follOWing1.1 1 Click on the Payments option on the Type option button on the
Mamtam Batch window

2 Click on the Method of Creation option button to select the
method

3 Click on the deSired data log to select It
4 Click on the Open button to activate the selected data log (Open

button IS activated only If a data log IS selected)

r::1fF When Payments IS selected the Items of the main menu on the
top of your screen change The menu now contains the
follOWing Items Elle, Post, DataEntry, Reports, futstem, Window
and Help

When the Payments option IS selected a new window Will appear on the
screen allOWing to enter data on payments for a selected customer The
window Will show the list of customers, current balances as of dates of the
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1 Press Alt+D,
2 Press Alt+E ???

Initially, the data log on payments made dunng the current date will be empty
To make an entry Into the data log of everyday payments do the follOWing

prevIous payments, text boxes for the last payments made and corresponding
text boxes for the new balances

(jjf= After the last payment data IS entered the new balance will be
calculated automatically
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Click on Edit of the Payment Data Entry for Today menu

Press Alt+E

Maintaining Data on Everyday Payments

The system provides for an option to a maintain data log on everyday
payments

(jjf= When Everyday Payments IS selected the Items of the main
menu on the top of your screen change (besides thiS, the title
bar - top dark bar of the screen shows Frame - (Payment Data
Entry for Today) The menu now contains the following Items
Elle, Post, Edit, DataEntry, Reports, fu'stem, Window and Help

3 Details on the Customer (lower left section),
This section contains detaIls (name, type, tanff category, balance, account
number, status, etc) on the selected customer

4 Presented InVOices on payments made (lower nght section)
ThIS section shows mformatlon on inVOices ofpayments made by the
selected customer on the current date

In this mode the screen IS divided Into four sections
1 Payment log of the current date (upper left sectIon),

This sectIon contains account numbers, addresses, current balances
(amount due for the energy consumed), payments made on the current
date and the new balances after the payments are made by customers

2 PrevIous payments (upper nght section),
This section shows information on prevIous payments of the selected
customer

To start working With data logs on everyday payments do the follOWing1.1 Click on DataEntry In the main menu,
Click on Everyday Payments option In the DataEntry menu

I
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Click on Enter New option of the Edit submenu
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More In details these actions are described below In this section

adding a new record on payment,
deleting the eXisting record
pnntlng a report on the payments made on the current
date

Use UpArrow (1') or DownArrow (~) to select Enter New option of
the Edit submenu and press Enter (f.l )

If the entered account number already eXists In the data log of
everyday payments a window Will appear on the screen with the
message "xxxxxxx account number already eXists" The
system, however, Will allow to continue working, since a customer
can make more than payments per day When a correct account
number IS entered the lower left part of the screen (Details on the
customer) Will show data on the customer having the specified
account number

o "Address", this field IS filled ,n automatically, checklll
o "Current balance", this field IS filled In automatically,
o "Paid amount", this field should be filled In based on the produced

InVOices Click on the field and enter the amount,
o "New balance" new payment balance IS calculated automatically

An empty line appears on the bottom of the upper left Side of the screen, and
the upper left and right Sides of the screen enter Into editing mode

Enter information on the new payment made Into the follOWing fields
o "Account number" by default the account number IS equal to 0,

If the account number entered Into this field does not correspond to
the account number of any of the customers of the system, a
window Will appear on the screen with the message "xxxxxxx
account number does not eXist" The system Will reqUire to enter
a correct account number, otherwise the work with the system
cannot be continuedIi Click on OK

EtII Press Enter (f.l )

Type the correct account number

Enter New­
Delete ­
Prmt -

The Edit submenu offers several actions you can select from These actions
are

1 Enter New To add a new record on a payment made do the following

I
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2 Delete If necessary you can remove any of the eXistIng records on
payments made To remove (delete) the selected entry do the following

Click on the desired entry to select It
ClIck on Delete of the Edit submenu

A window will appear on the screen asking to confirm deleteIi ClIck on yes button to confirm delete
Click on No button to reject deleteM Press Y to confirm delete
Press N to reject delete

3 Prmt If necessary you can pnnt the data log on everyday payments To
pnnt the data log do the follOWing

Ii Click on Print of the Edit submenu

To save the entered Information do the follOWingIi Click on the Save button

To assign the newly entered data to the customers of the system do the
follOWingIi Click on Post of the Payment Data Entry for Today menu

To finIsh working with the data log on everyday payments do the follOWingII Click on the Close button
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The Reports menu offers several types of reports you can select from
These are

Group Junction
Reports for
Responsible Persons - creatrng and prrntlng reports on the responsible

persons of each group Junction

To start working with reports do the following1.1 Click on Reports option In the main menu

a Press Alt+R

creating and pnntlng reports on the meters which have
not been tested (no meter reading) dunng a speCified
perrod
check'"
creating and prrntlng reports on the customers who
have received no bills, made no payments and for
which no meter reading has been accomplished durrng
a speCified perrod

creating and pnntlng reports on the current rates,
discount categorres and VAT percent
creating and prrntlng reports on varrous address
components (more In details on addressing
components see Part 2 Entermg and Modlfymg
Data)

creating and pnntlng reports on (1) contracts and
consumption, and (2) summary reports by tanffs for the
agents of each group Junction

creating and pnntlng reports on (1) actiVities related to
each cycle, (2) calculations acts and consumption, (3)
list of debts and disconnections, and (4) summary
reports by tarrffs for each group Junction

Rates Reports -

Location Report -

Part IV Creatmg and Prmtmg Reports
This part descrrbes how to create varrous types of reports on the components of
the system, which are required by varrous departments of your company (section
Creatmg Reports) and how to print these reports (section Prmtmg Reports)

Meter Testmg
Report -

ClasSifiers Report ­
Checkmg Reports -

Group Junction
Reports -

Group Junction
Reports for Agents -

I
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b) To create a report on the eXisting discount categories do the follOWing

Use UpArrow (1') or DownArrow (..v) to select Rates option and press
Enter (~)
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More In details these actions are descnbed below In this section Once you have
selected one of the options you can create and pnnt the corresponding report
(some of the reports are created automatically, as soon as you select the option,
and no additional action IS required to be taken by the user of the system)

Creating Reports
This section descnbes to how to create vanous types of reports

Rates Report
To create a rates report do the followingII Click on Rates option In the Reports submenu

~

The Rates Report window appears on the screen It has three buttons on the
left upper part of the screen Rates, DIscount and VAT These options allow to
create and pnnt reports on the current rates, on the eXisting discount categones
and the current VAT percent

a) To create a report on the current energy rates do the followingII Click on Rates button on the left upper side of the screen

Initially, the screen will show no data on the rates To get the data do the
followingII Click on Update button on the nght upper side of the screen

The screen will show data on the eXisting rate categones, penods dunng which
each category will be valid, etc

To get data on the rates for a speCifiC penod to the followingII Click on All check box below the Rates button to make It Inactive (I e
no check mark In the box) and fill In the beglnnrng and ending dates
for the deSired penod Into the text boxes on nght Side of the check
box

The screen Will show data on the eXisting rate categones dunng the determined
penod
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D Click on Discount button on the left upper side of the screen

Initially, the screen will show no data on the discount categones To get the data
do the followingIi Click on Update button on the nght upper side of the screen

To get data on the discounts for a specific penod to the followingD Click on All check box below the Discount button to make It inactive
(I e no check mark In the box) and fill In the beginning and ending
dates for the desired penod Into the text boxes on nght side of the
check box

The screen will show data on the eXisting discount categones dunng the
determined penod

c) To create a report on the eXisting VAT percent do the followingIIJ Click on VAT button on the left upper side of the screen

Initially, the screen will show no data on the VAT percent To get the data do the
followingIi Click on Update button on the nght upper side of the screen

To get data on the VAT percent for a specific penod to the followingII Click on All check box below the VAT button to make It Inactive (I e
no check mark In the box) and fill In the beginning and ending dates
for the desired penod Into the text boxes on nght side of the check
box

The screen will show data on the current VAT percent dunng the determined
penod

LocatIon Report
To create a report on a specific location (for Instance, the list of commUnities In a
Marz or the list of streets In a specific community) do the following
~ Click on Location option In the Reports submenu

Use UpArrow (1') or DownArrow (-.I.-) to select Location option and
press Enter (f-l )
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The Location Report window appears on the screen It has five drop-down lists
on the upper part of the screen (corresponding to the five addressing
components of the system described In details In Part 2 Entermg and
Modlfymg Data)

To create a report on a location do the followingD 1 Click on the corresponding drop-down lists on the upper part of
the screen to select the desired location

2 Click on Update button on the right upper side of the screen
r:lF To create a location report at least one of the drop-down lists should be

filled In

To bnng the drop-down lists to the initial condition (I e to empty them) do the
followingII Click with the mouse right button on Location drop-down lists

Meter Testmg Report

To create a report on the meters which have not been tested dunng a specified
penod (number of months) do the following

Click on Meter Testmg option In the Reports submenu

Use UpArrow (1') or DownArrow (.J...) to select Meter Testing option
and press Enter (~ )

The Meter Testmg Report window appears on the screen

To get the data on meters that have not been tested dunng a specified penod do
the followingII 1 Specify the penod by clicking on the upward triangle (to Increase

the number of months) or the downward tnangle (to decrease the
number of months) on the nght side of the small text box near the
Update button on the upper right side of the screen

2 Get data by clicking on Update button

r:lF More In details on updating meter testing data see Part 2 Entermg and
Modlfymg Data

Classifiers Report
checklll
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Use UpArrow (1') or DownArrow (..v) to select Checking option and
press Enter (f.l )
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Checkmg Reports
To create a report on the customers who have not received bill, whose meters
have not been tested or who have not made any payments dunng a specified
penod do the followingIi Click on Checking option In the Reports submenu

it
The Checking Report window appears on the screen It has three buttons on
the left upper part of the screen No Bill, No Readmg and No Payment

a) To create a report on the customers who have not received bills dunng a
specified penod do the followingIi 1 Specify the penod by clicking on the upward tnangle (to Increase

the number of months) or the downward tnangle (to decrease the
number of months) on the nght side of the small text box on the
upper left part of the screen

2 Click on No aln button

b) To create a report on the customers whose meters have not tested dunng a
specified penod do the followIngIi 1 Specify the penod by clicking on the upward tnangle (to Increase

the number of months) or the downward tnangle (to decrease the
number of months) on the nght side of the small text box on the
upper left part of the screen

2 Click on No Reading button

c) To create a report on the customers who have not made any payment dunng
a specIfied penod do the followingII 1 Specify the penod by clicking on the upward tnangle (to Increase

the number of months) or the downward tnangle (to decrease the
number of months) on the nght side of the small text box on the
upper left part of the screen

2 Click on No Payment button

Group JunctIon Reports
To create reports on group JunctIons do the following6 Click on Group Junctions option In the Reports submenu

Use UpArrow (1') or DownArrow (..v) to select Group Junctions
option and press Enter (~ )
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The Group Junctions submenu has a to on Its nght side which means It offers
several actions you can select from These are

o List
o Calculations AcUConsumptlon
o DebtslDlsconnectlons
o Summary Report by Tanffs

a) List To create a report on the activities of group Junctions for a specified date
do the followingIi 1 Click on the .. of the Group Junction submenu

2 Click on List option
3 Specify the date In the text box In the upper nght part of the

screen
4 Click on the Update button

On this report, activities for the current day will be shown on the diagonal (In red
color), activities that should have been accomplished dUring the prevIous days
will be shown above the diagonal (In blue color) and activities for the next days
will be shown below diagonal (In black color)

b) Calculations Act/Consumption To create a calculations act or a report on
consumption do the followingIi 1 Click on the .. of the Group Junction submenu

2 Click on Calculations Act/Consumption option

The Calculations Act/Consumption Report window appears on the screen It
has two buttons on the left upper part of the screen Calculations Act, and
Consumption

To create a calculations act do the followingII 1 Click on the Calculations Act button on the left upper part of the
screen

2 Click on the drop-down list on the upper nght part of the screen to
specify the cycle for which the calculations act will be created

The system will try to find groups which belong to this cycle If there are not
groups for this cycle a message will appear on the screen "There are no
groups to select" Click on OK button

If there are groups belonging to thiS cycle, drop-down list will appear on the
screen and you can select the deSired group
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@=' Once you select the group, the report will be created automatically If you

want to pnnt a report on all groups of the cycle use Pnnt All Icon ( tal)
More In details on prmtlng options see next sectron Prmtmg Reports

To create a consumption report do the followingIII 1 Click on the Consumption button on the left upper part of the
screen

2 Click on the drop-down list on the upper nght part of the screen to
select a customer for which the consumption report Will be
created

c) Debts/Disconnections To create a report on the debts and disconnections
of the specified group Junctions do the followmgIII 1 Click on the" of the Group Junction submenu

2 Click on Debts/Disconnections option

The Debts/Disconnections Report window appears on the screen It has two
buttons on the left upper part of the screen Debts of the Cycle, and Debts of the
Group

To create a report on the debts of the cycle do the followmgIII Click on the drop-down list on the upper nght part of the screen to
specify the cycle for which the calculations act Will created

@=' The list of debts of customers of the cycle Will be created automatrcally

If there are not groups for this cycle a the "Debts of the Group" button Will remain
Inactive
If there are groups In the cycle, you can get the list of Individual customers of
any of the group To do this select the desired group The Debts of the Group
card Will become active

@=' The report on customers who are subject to disconnection Will be created
automatically If you want to pnnt a report on all customers subject to

disconnection use Pnnt All Icon ( q, I) More In details on pnntlng options
see next section Prmtmg Reports

The list of customers subject to disconnection Will be created based on pre­
specified deviations (More In details on deviations see Part 2 Entermg and
Modlfymg Data)

d) Summary Report by Tanffs To create a summary report on the customers,
expected payments, tanff categones, and so on, do the follOWingIII 1 Click on the ,. of the Group Junction submenu
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2 Click on Summary Report by Tanffs option

Use UpArrow (1') or DownArrow (-.1--) to select Agent option and press
Enter (fJ )

A window appears on the screen having two buttons on the left upper part of the
screen Contracts, and Consumption

Click on the drop-down list on the upper rrght part of the screen to
select the agent

2 Click on the Consumption button
3 Click on the dates text boxes and fill In the dates (beginning and

end of the desired period)
4 Click on the Update button

The Agent submenu has a .. on Its rrght side which means It offers two options
you can select from These are

o Consumption
o Summary Report by Tarrffs

a) Consumption To create a report on consumption do the following
(; 1 Click on the " of the Agent submenu

2 Click on Consumption option

b) Summary Report by Tanffs To create a summary report on the customers,
expected payments, tarrff categorres, and so on, for the specified agent do the
follOWing

Group Junction Reports for Agents
To create reports on agents do the following
(; Click on Agent option In the Reports submenu

iI

To create a report on the contracts of the specified agent do the followingIIiJ 1 Click on the drop-down list on the upper rrght part of the screen to
select the agent

2 Click on the Contracts button

The Summary Report by Tanffs Report window appears on the screen
To create a summary report on a specified customer do the followingII 1 Click on the drop-down list on the upper rrght part of the screen to

select a customer
2 Click on the By Tanffs button

To create a report on the consumption of energy of the specified agent do the
following

11 1
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1 Click on the" of the Agent submenu
2 Click on Summary Report by Tariffs option

The Summary Report by Tariffs Report window appears on the screen
To create a summary report on customers of a specified agent do the following1.1 1 Click on the drop-down list on the upper nght part of the screen to

select an agent
2 Click on the By Tariffs button

Group Junction Reports for Responsible Persons

check'"

Prlntmg Reports
Once you have created a report you can prrnt It by uSing the menu options or
special Icons which you can see every time you work with reports, I e pnntlng
options are standard for all types of reports

To prrnt a report do the follOWIng1.1 1 Click on File option In the main menu
2 Click on the Print option In the FIle submenu

1 Press AIt+F
2 Use UpArrow (1') or DownArrow (~) to select Prmt option and

press Enter (fJ )

You can pnnt a report also by clicking on the Prrnter Icon (lsi) on the left
Side of the screen

To select the type of the pnnter do the follOWingIIJ 1 Click on File option In the main menu
2 Click on the Printer option In the File submenu

1 Press Alt+F
2 Use UpArrow (1') or DownArrow (~) to select Prmter option and

press Enter (f-l )

The Printer Setup window Will appear on the screen and Will allow not only to
select the type of the prrnter but also to select the size of the paper, to change
the fonts and other setup options by clicking on the .§etup button on the bottom
part of the Printer Setup window
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Print Preview option allows to preview the created report on the screen before
pnntlng It To preview the report do the following

Example you can view the picture on the screen In 20% or 80% of ItS natural
size By default the picture will be shown 100% Size, I e ItS natural size

1 Use UpArrow (1') or DownArrow (..v) to select View option In the
Preview submenu and press Enter (~ )

2 Use UpArrow (1') or DownArrow (..v) to select View option In the
Preview submenu and press Enter (~)

II Click on Preview option In the main menu

a Press Alt+???

The Preview submenu allows to preview the first and last pages, prevIous and
next pages, as well as to zoom down and up the picture, to show and hide the
ruler

101

Click on View option In the Preview submenu
Click on the J- of the View option to select the percent to Increase
or decrease the picture on the screen

Use UpArrow (1') or DownArrow (..v) to select First (PrevIous, Next,
Last) Page option and press Enter (~)

Use UpArrow (1') or DownArrow (..v) to select Zoom Down or Zoom
Up optIon In the Preview submenu and press Enter (~ )

To select the page to preview do the followingm1 Click on First (PrevIous, Next, Last) Page option In the main menu

mt
(ifF You can select the page to preview also by clicking on the following Icons

on the left side of the screen

First Page i1
PrevIous Page rn
Next Page W
Last Page ~

To vIew the picture on the screen In a certain percent of ItS natural size do the
following

II~

To zoom down or zoom up the picture do the followmgIi Click on Zoom Down or Zoom Up option In the Preview submenu

mt
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Click on the menu name
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When you open a menu, a list of commands appears, as shown In Figure 1

Use UpArrow (1') or DownArrow (.J.-) to select Ruler option In the
Preview submenu and press Enter (f-l )

Press Alt+X, where X IS the key that represents the desired menu
Item (Each menu Item has an underlined character that represents
the menu For Instance, press Alt+H to get on-line help)

r:IfF You can zoom down or zoom up the picture also by clicking on the Zoom

Down (..E) or Zoom Up ( AI) Icons on the left side of the screen

r:IfF You can eXit from the prrnt window also by clicking on the EXit Icon (.mJ)
on the left side of the screen

Appendices

Working with Menus

Immediately below program window's title bar IS a menu bar The menu bar lists
the names of one or more menus (lists of related commands) For example the
TreeVlew menu bar contains the follOWing Items Elle, Edit, DataEntry Reports,
~ystem, Window and Help

Openmg a Menu
To open a menu, do the follOWing

To show and hide the ruler do the followingIWl Click on Ruler option In the Preview submenu

E!
To eXit from the prrnt window do the following

II Click on Ruler option In the Preview submenu

I
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Click on the deSired field
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Press X, where X IS the letter underlined In the command If the
command has no underlined letter, use the arrow keys to highlight the
command, and then press Enter

Press Alt+X, where X IS the letter underlined In the field name Use
the Tab key to advance from one dialog box field to the next Use
Shlft+Tab to return to the prevIous field

Save I Came! f

Figure 1

For Instance as shown In Figure 2, to save the changes click on the Save button,
to reject changes click on the Cancel button

Closmg a Menu
To close a menu wIthout selecting a command, click on a location outside of the
menu, or press Esc key

Command buttons - A command button directs a dIalog box to perform a
specific action

Working with Dialog Boxes

A dialog box IS a window that frequently provides Information and always
requests a user response Dialog boxes can contain several fields of
Information, as descrrbed In the following paragraphs To select a field within a
dialog box, do the following

Se/ectmg a Command
To select a command from a command menu, fellow these steps1.1 Click on the command

EI
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Figure 2

Text box - A text box lets you type In a text stnng as shown In Figure 3
Sometimes a text box contains default text To enter different text, simply type In
the new text, which replaces the old text automatically To make minor changes
to the default text, press the left arrow key, and edit the text uSing the
Backspace, Delete, and arrow keys

Figure 3

If there are more than one text boxes on the screen you can sWitch from one text
box to another by dOing the follOWing

Ii Click on the deSired text box

a Use Tab key to sWitch from one text box to another

List box - A list box provides you with a list of options If the list contains more
options than the box can display, the box contains a scroll bar To choose an
option, do the follOWing

Ii Double click on the option

fFI Use the arrow keys to select the option, and then press Enter

Drop-down list - Dialog boxes use drop-down lists when there's not enough
room for a list box (Figure 4) To drop down the liSt, do the follOWing

Ii Double click on the downward pOinting arrow at the nght of the list

fI Select the drop-down list, and then press Alt+Down arrow

af.1lldJng#~E::: ::: 33
Figure 4

Option button - When the options you can select from are mutually exclusive ­
that IS, when you are allowed to select only one of them at a time - they are
grouped together as option buttons Option buttons appear as circles with text
next to them (see Figure 5) One option In each group (the currently selected
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optIon) has a darkened circle Gray or dimmed options are Inappropnate for the
current situation and cannot be selected

To select an option button, do the following

Click on the option button

Press Alt+X, where X IS the letter underlined In the option name If
the option name doesn't have an underlmed letter, press the Tab
key until one of the option names IS encircled by a dotted line Use
the arrow keys to move the darkened circle to the desired option

r.-ltQSlOOi~

r 6~roocllOl'l
:r AUlO1lftUateC~

Figure 5

Check box - Options chat can be Individually turned on or off are displayed as

check boxes (see Figure 6) When a check box IS empty, the option IS off A 0
In the check box Indicates that the option IS selected Gray or dimmed options
are Inappropnate for the current situation and cannot be selected

To select or deselect a check box

Click on the check box

Press Alt+X, where X IS the letter underlined In the check box name
If the check box name doesn't have an underlined letter, press the
Tab key until the option IS encircled by a dotted line and then press
the Spacebar

Figure 6

Scrolling for Information
When a window contains more Information that can fit In a window, vertical and
hOrizontal scroll bars appear along the window's right and bottom edges, as
shown In Figure 7 Within the scroll bas, a scroll box moves to reflect your
relative position within the document
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To use scroll bars, do the followmg
II · To move a short distance, click on the up and down or left and

right arrows at each end of the scroll bar

• To move up by approximately one screen, click on the vertical
scroll bar above the scroll box To move down by approximately
one screen, click on the vertical scroll bar below the scroll box
To move to the left by approximately one screen, click on the
hOrizontal scroll bar to the left of the scroll box To move to the
right by approximately one screen, click on the honzontal scroll
bar to the nght of the scroll box

• To move to a specific location, drag the scroll box along the
scroll bar to qUickly scan through the window's contents

Use the arrow keys or the PgUp and PgDn keys to scroll through the
window's contents

Figure 7

Working with Windows

The program provides you with several ways to Increase and decrease the sIze
of a window

MInimizing a Window
To minimize a window - that IS, to reduce It to an Icon - do the follOWing

Click on the Minimize button (I:;J) In the upper rrght corner of the
window
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For an application window, press Alt+Spacebar, N
For a document or group window, press Alt+Hyphen, N

Restoring a MInimized Window
To restore a window - that IS, to expand an Icon to a window - do the following

Double-click on the Icon

For an Icon on the desktop, press Alt+Spacebar, R
For a document or group Icon, press Alt+Hyphen, R

I
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Maximizing a Window
To maXimize a window - that IS, to enlarge It to the fullest possible size - do the
following

Click on the Maximize button (Iii) In the upper right corner of the
window

For an application window, press AIt+Spacebar, X???

For a document or group window, press Alt+Hyphen, X

Closing a Window
When you close an application window, the corresponding application stops If
you have made changes and have not yet saved the changes on a diSk, a dialog
box appears asking whether you want to save the changes

To close a window, do the following
I1J Click on the Close button (lib In the upper right corner of the

window

For an application window, press Alt+Spacebar, C
For a document or group window, press Alt+Hyphen, C

TIling or Cascading Windows
The Window option of the main menu has several commands that help you view
several windows on the screen

The Tile command changes the size and position of each window so that each IS
fully vIsible The Tile command has two versions Tile Vertical which arranges
the windows one on top of another and Tile HOrizontal, which arranges the
windows Side by Side

The Layer command

checklll
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The Cascade command arranges windows one on top of another, leaving the
title bar of each window uncovered

Arrangmg Icons
As you work with the program, Icons sometimes become disorganized on the
screen To tidy up the arrangement of Icons use Arrange Icons options In the
Window submenu

As you work with the program, Icons sometimes become disorganized on the
screen To tidy up the arrangement of Icons use Arrange Icons options In the
Window submenu
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